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Introducción

Harmony es un software de animación completo que permite crear todo tipo de proyectos de animación 

creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guía de introducción, aprenderá los conceptos básicos del uso de las principales funciones de 

Harmony Advanced, que le permitirán ponerse al día rápidamente. Consulte la documentación completa de 

Toon Boom Harmony Advanced disponible en línea en docs.toonboom.com para aprender acerca de todas las 

herramientas y opciones, así como sobre las técnicas avanzadas.
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Capítulo 1: Creación de una escena

Capítulo 1: Creación de una escena

Al iniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:

 l Crear escenas

 l Seleccionar la resolución de la nueva escena

 l Administrar los valores predeterminados de la resolución de la escena

 l Abrir rápidamente escenas recién abiertas

 l Examinar y abrir una escena creada

 l Ver tutoriales en vídeo de Harmony en la web

 l Acceder a la página web de soporte

NOTA 

Si está usando Harmony Server, debe util izar la aplicación   Control Center para crear escenas 

antes de que pueda abrirlas en Harmony. Las escenas de Harmony Server no se pueden crear 

directamente en Harmony.
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Creación de una escena desde la pantalla de bienvenida

 1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA 

El nombre de la escena no debe superar los 23 caracteres y no puede contener 

caracteres especiales, como *&^%!.

 2. Para decidir en qué directorio se va a crear la escena, haga clic en el botón Browse (Examinar) junto 

al campo Location (Ubicación).

 3. En el menú Camera Size (Tamaño de cámara), seleccione la resolución de la escena.

 4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicación principal aparecerá con la nueva escena 

abierta.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

Capítulo 2: Introducción a la interfaz de usuario de Harmony

El uso de Toon Boom Harmony Advanced será mucho más fácil si primero se familiariza con su interfaz de 

usuario. En el siguiente capítulo se proporciona una introducción básica a los elementos más importantes de la 

interfaz de usuario. A medida que avance por los capítulos, conocerá más detalles sobre cada uno de estos 

elementos.

Al iniciar Toon Boom Harmony Advanced por primera vez, se presenta el espacio de trabajo predeterminado. 

La zona de trabajo se divide en interfaces de usuario rectangulares denominadas vistas, cada una de ellas con 

su propio fin específico. Los laterales superior e izquierdo de la interfaz de usuario, así como algunas vistas, 

también contienen barras de herramientas, cada una con funciones específicas.

Vistas

Las vistas son pequeñas interfaces de usuario con fines específicos. Se pueden agregar a la ventana principal 

de la aplicación, en cuyo caso están "ancladas" o se pueden abrir como ventanas separadas.

Cada vista tiene una pestaña con su nombre en la parte superior. Las pestañas no solo se pueden util izar para 

identificar las vistas con las que está trabajando, sino que también le permiten apilar varias vistas en la misma 

área de la interfaz de usuario. Por ejemplo, en la zona de trabajo predeterminada, la vista de cámara ocupa la 

mayor parte del área. En la parte superior de la vista de cámara hay dos pestañas: Camera (Cámara) y 

Drawing (Dibujo). Esto se debe a que la vista de dibujo está apilada con la vista de cámara y puede cambiar 

rápidamente entre ambas haciendo clic en cualquiera de las pestañas.
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A la derecha de las pestañas de cada división de la zona de trabajo se encuentran los botones  Add View 

(Agregar vista) y  Close View (Cerrar vista), que le permiten apilar más vistas o eliminar la vista 

seleccionada de esta área de la zona de trabajo.

Adición de una vista

Puede agregar, eliminar, mover y apilar vistas en toda la zona de trabajo para optimizar el flujo de trabajo.

Adición de una vista al espacio de trabajo como una pestaña

 1. En la esquina superior derecha de una vista existente, haga clic en el botón  Add View (Agregar 

vista).
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

 2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestaña en la sección del espacio de trabajo donde la agregó.

NOTA 

Algunas vistas, como las de cámara, perspectiva, librería y modelo, se pueden abrir en varias 

instancias. Por ejemplo, puede resultar útil si desea tener dos instancias de las vistas de 

cámara abiertas, cada una centrada en distintas áreas de la escena, para cambiar rápidamente 

entre los trabajos de estas dos áreas.

Adición de una vista a la zona de trabajo  como una ventana 

 1. Abra el menú W indows (Ventanas).

 2. En el menú W indows (Ventanas), seleccione la vista que desee agregar.

La vista aparecerá como una nueva ventana sobre la ventana de la aplicación principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

 1. Haga clic y arrastre la vista flotante por la pestaña y realice una de las siguientes acciones:

 l Coloque la ventana sobre otra pestaña para agregarla a ese conjunto de pestañas.

 l Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse 

al borde de una vista, aparece un rectángulo cian que indica dónde se anclará la vista.
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Aquí se proporciona una breve introducción a cada una de las vistas más util izadas en Harmony.

Vista de cámara

La vista de cámara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar, 

configurar la escena, manipular objetos, abrir símbolos y previsualizar la animación.

La vista de cámara también tiene una barra de herramientas superior e inferior que puede util izar para navegar 

en la vista, cambiar el modo de visualización o subir la jerarquía de símbolos.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cámara. Aunque las dos vistas son 

similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede util izar funciones 

como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores 

descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo 

seleccionada actualmente.

 

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones más comunes relacionadas con 

la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de 

herramientas, se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrará 

las opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), 

Apply to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).
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Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista 

de color también es necesaria para dibujar, pintar y crear estilos de color.

Vista de línea de tiempo

Para establecer el tiempo de la animación, trabajará principalmente con las vistas de línea de tiempo y de carta 

de rodaje. Es muy útil familiarizarse con la vista de línea de tiempo, su funcionamiento y su interfaz.

La vista de línea de tiempo es la vista principal util izada al ajustar el tiempo de los dibujos, agregar fotogramas 

clave y ordenar capas. La vista de línea de tiempo muestra capas, efectos, sonidos, valores de fotogramas 

clave, duración de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

La vista de línea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la 

escena en su forma más simple. También puede ver las capas y sus nombres, así como la exposición del 

dibujo. El nombre del dibujo se muestra al colocar el puntero sobre la exposición del dibujo.

Vista de sustituciones de dibujo

La vista de sustituciones de dibujo le permite ver todos los dibujos de la capa seleccionada en una lista de 

imágenes en miniatura, así como seleccionar rápidamente qué dibujo se debe exponer en el fotograma actual.
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Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostrándolo en una cuadrícula, con cada capa 

de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo 

expuesto mostrado por su nombre en las celdas. Se pretende que funcione como una carta de exposición de 

animación tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento 

de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de línea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquía de 

capas. Por lo tanto, se optimiza para una animación tradicional y sin papel, mientras que la vista de línea de 

tiempo se optimiza para una animación digital o cut-out.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

Vista de librería

La vista de librería se util iza para almacenar elementos como animaciones, dibujos, fondos y modelos de 

personajes para volver a util izarlos en distintas escenas y proyectos. También puede util izar la vista de librería 

para crear y almacenar símbolos, así como para almacenar e importar imágenes y archivos de sonido.

Para reutil izar elementos de una escena en otras escenas, debe crear una plantil la para poder importarla en 

distintas escenas. Las plantil las pueden contener cualquier elemento, desde un solo dibujo hasta una 

estructura de escena completa. Puede crear una plantil la en una escena y copiar los elementos que desee de 

la plantil la en una librería. La plantil la resultante se estructura como una miniescena que solo contiene los 

elementos que copió en ella. Una plantil la no tiene ninguna dependencia en la escena en la que se creó 

originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Además, el panel Drawing Substitutions (Sustituciones de dibujo) de la vista de librería permite cambiar 

rápidamente la exposición del fotograma actual a uno de los dibujos existentes en una capa. Esto es 

especialmente útil para la animación de las bocas, manos, párpados y otras partes del cuerpo de un personaje 

cut-out, que suelen contener varios dibujos donde elegir.
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Barras de herramientas

La interfaz de Harmony contiene barras de herramientas que proporcionan acceso rápido a muchas 

herramientas útiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas se dividen en dos categorías principales:

 l Las barras de herramientas de la zona de trabajo son barras de herramientas con un propósito general. 

Por ejemplo, las barras de herramientas de archivo, edición, zona de trabajo, animación avanzada y 

deformación de la parte superior, así como la barra de herramientas de herramientas de la izquierda son 

barras de herramientas de la zona de trabajo. Esas barras de herramientas se pueden colocar en el 

borde superior, inferior, izquierdo o derecho de la ventana de la aplicación. Si se prefiere, también se 

pueden colocar en el borde de vistas específicas.

 l Las barras de herramientas de vista son barras de herramientas útiles para una vista específica. Por 

ejemplo, la vista de cámara tiene una barra de herramientas de cámara en la parte superior. Las barras 

de herramientas de vista solo se pueden mostrar dentro de su vista respectiva. Se pueden colocar en el 

borde superior, inferior, izquierdo o derecho de su vista.

Adición de barras de herramientas

Adición o eliminación de la barra de herramientas de una zona de trabajo a la zona de 
trabajo general

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione W indows > Toolbars (Ventanas > Barras de herramientas) 

y, en el submenú, seleccione la barra de herramientas que desee agregar. 
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

 l Haga clic con el botón derecho en cualquier barra de herramientas situada en la parte 

superior o lateral de la zona de trabajo o en la zona vacía junto a estas barras de 

herramientas, y seleccione la barra de herramientas que desee agregar en el menú 

contextual.

Adición de una barra de herramientas de vista a una vista

 1. Realice una de las siguientes acciones:

 l Haga clic en la pestaña de la vista para la que desea agregar una barra de herramientas para 

centrarse en ella. A continuación, en el menú superior, seleccione W indows > Toolbars 

(Ventanas > Barras de herramientas) y seleccione la barra de herramientas que desee 

agregar.
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NOTA 

En la lista de barras de herramientas del menú superior y el menú contextual de 

la zona de trabajo, las barras de herramientas enumeradas por encima del 

separador son barras de herramientas de la zona de trabajo y las que están 

debajo del separador son barras de herramientas de vista.

 l En el área superior de la vista a la que desee agregar una barra de herramientas, a la 

izquierda de la pestaña, haga clic con el botón derecho y seleccione la barra de herramientas 

que desee agregar en el menú contextual.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

NOTAS 

 l En la lista de barras de herramientas del menú contextual de una vista, las 

barras de herramientas enumeradas por encima del separador son barras de 

herramientas de la zona de trabajo y las que están debajo del separador son 

barras de herramientas de vista.

 l Si selecciona una barra de herramientas de la zona de trabajo en el menú 

contextual de una vista, esta barra de herramientas de la zona de trabajo se 

agregará a la vista. Si ya estaba presente en la zona de trabajo, se eliminará 

de su ubicación anterior.

 l Cuando se agrega una barra de herramientas de la zona de trabajo a una 

vista que tenga apiladas otras vistas, dicha barra de herramientas será visible 

en todas las vistas apiladas en la misma zona. Por ejemplo, si agrega la barra 

de herramientas de animación avanzada a la vista de cámara, también será 

visible en la vista de dibujo. 

Desplazamiento de una barra de herramientas

 1. Haga clic y mantenga pulsado el controlador situado a la izquierda de la barra de herramientas que 

desee mover.
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 2. Realice una de las siguientes acciones:

 l Si la barra de herramientas es horizontal, muévala hacia arriba o hacia abajo para sacarla de 

su fila.

 l Si la barra de herramientas es vertical, muévala hacia la izquierda o hacia la derecha para 

sacarla de su columna.

 3. Realice una de las siguientes acciones:

 l Para reorganizar las barras de herramientas, arrastre la barra de herramientas hasta donde 

desee y colóquela.

La barra de herramientas se moverá a su nueva posición. Las barras de herramientas 

situadas a la derecha (o en la parte inferior, si la barra de herramientas es vertical) se 

desplazarán para dejar espacio.

 l Para mover la barra de herramientas a una nueva fila o columna, simplemente mueva la 

barra de herramientas donde se deba crear la nueva fila o columna. Por ejemplo, para crear 

una nueva fila de barras de herramientas en la parte superior de la interfaz de usuario, 

muévala justo debajo de las barras de herramientas existentes en la parte superior de la 

interfaz de usuario. Aparecerá una nueva fila o columna resaltada en cian.

Al colocar la barra de herramientas, se creará la nueva fila y la barra de herramientas se 

colocará en el extremo izquierdo de esta.

21

Guía de introducción de Harmony 22 Advanced                          



Capítulo 2: Introducción a la interfaz de usuario de Harmony

Del mismo modo, para crear una nueva columna a la izquierda de la interfaz de usuario, 

muévala justo a la derecha de las barras de herramientas existentes a la izquierda de la 

interfaz de usuario.

 l Para mover la barra de herramientas a otro extremo de la interfaz de usuario, arrástrela 

hasta dicho extremo.

Desplazamiento de una barra de herramientas sobre otra barra de herramientas

 1. Asegúrese de que ambas barras de herramientas se encuentren en la misma fila o columna. Si no lo 

están, mueva ambas barras de herramientas a la misma fila o columna siguiendo el método 

descrito anteriormente. 

 l Si las barras de herramientas son horizontales, haga clic y mantenga pulsado el controlador 

de la izquierda de la barra de herramientas situada más a la derecha. A continuación, sin salir 

de la fila de la barra de herramientas, deslice la barra de herramientas hacia la izquierda.
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 l Si las barras de herramientas son verticales, haga clic y mantenga pulsado el controlador de 

la parte superior de la barra de herramientas inferior. A continuación, sin salir de la columna 

de la barra de herramientas, deslice la barra de herramientas hacia arriba. 

A medida que desliza la barra de herramientas sobre la otra barra de herramientas, los botones de 

la otra barra de herramientas se ocultan y aparece un botón de menú emergente.

 2. Para separar de nuevo las barras de herramientas, simplemente deslice la misma barra de 

herramientas en la dirección opuesta.

 3. Para expandir una barra de herramientas que tenga superpuesta otra barra de herramientas, haga 

clic en el botón de expansión situado a la derecha de la barra de herramientas superpuesta.

Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en 

Harmony. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde 

izquierdo de la ventana de la aplicación.

Algunos de los botones de la barra de herramientas de herramientas disponen de un triángulo en la esquina 

inferior derecha. Es para indicar que hay varias herramientas apiladas en este botón. Para acceder a estas 

herramientas, haga clic y mantenga pulsado el botón de herramienta, o seleccione la herramienta y haga clic 

de nuevo.
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Capítulo 2: Introducción a la interfaz de usuario de Harmony

CONSEJO 

Muchos botones de la barra de herramientas disponen de un atajo de teclado asociado. Puede 

comprobar qué atajo de teclado está asociado a un botón dejando el cursor del ratón sobre el 

botón durante un segundo. Si el botón tiene un atajo de teclado, se indicará en la información 

sobre herramientas que aparece.

Barra de herramientas de archivo

La barra de herramientas de archivo contiene botones para operaciones de archivo comunes, como New 

(Nuevo), Save (Guardar) y Open (Abrir). Estos comandos también se encuentran en el menú superior File 

(Archivo).
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NOTA 

Los botones  New (Nuevo) y  Save As (Guardar como) solo están disponibles en Harmony 

Stand Alone. Con Harmony Server, se debe util izar   Control Center para crear escenas.

Barra de herramientas de edición

La barra de herramientas de edición contiene operaciones comunes como Undo (Deshacer), Redo (Rehacer), 

Cut (Cortar), Copy (Copiar) y Paste (Pegar). Estos comandos también se encuentran en el menú superior Edit 

(Editar).

Barra de herramientas de reproducción

La barra de herramientas de reproducción le permite reproducir la animación, así como configurar algunas 

opciones de reproducción, como bucle, reproducción de audio, rango de reproducción y velocidad de 

reproducción.

Navegación por la interfaz

Con la ayuda de comandos de menú y atajos de teclado, algunas vistas permiten navegar por su contenido al 

acercarlo, alejarlo, panearlo y rotarlo. También puede restablecer el nivel de zoom, el paneo y el ángulo de 

rotación de estas vistas según sea necesario.

Los comandos de navegación de la tabla que se muestra a continuación se pueden util izar en las siguientes 

vistas, con algunas excepciones:

 l Cámara

 l Dibujo
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 l Perspectiva

 l Línea de tiempo

 l Carta de rodaje

 l Función

 l Lateral y superior

 l Modelo

CONSEJO 

Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para 

Harmony en el cuadro de diálogo Keyboard Shortcuts (Atajos de teclado). Para acceder al cuadro 

de diálogo Keyboard Shortcuts (Atajos de teclado):

 l W indows   o  GNU/Linux  : en el menú superior, seleccione Edit > Keyboard Shortcuts (Editar 

> Atajos de teclado).

 l macOS : en el menú superior, seleccione Harmony Advanced > Keyboard Shortcuts (Harmony 

Advanced > Atajos de teclado).

Comando Acción Métodos de acceso

Zoom In (Acercar) Acerca la vista. 

View > Zoom In (Ver > Acercar)

Pulse 2.

Gire la rueda del ratón hacia arriba (excepto en las vistas de 

línea de tiempo y de carta de rodaje)

Zoom Out (Alejar) Aleja la vista.

View > Zoom Out (Ver > Alejar)

Pulse 1.

Gire la rueda del ratón hacia abajo (excepto en las vistas de 

línea de tiempo y de carta de rodaje)

Zoom In o Zoom 

Out (Acercar o 

Alejar)

Acerca o aleja la vista.

Gire la rueda central del ratón hacia arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y la rueda central del 

ratón mientras arrastra el ratón hacia arriba o hacia abajo.

Pan (Panear)
Mueve la vista horizontal 

o verticalmente.

Mantenga pulsada la barra espaciadora y arrastre en la 

dirección que desee panear la vista.

Reset Pan Restablece el paneo de View > Reset Pan (Ver > Restablecer paneo)
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Comando Acción Métodos de acceso

vista a su posición 

predeterminada.
Pulse Mayús + N.

Reset View 

(Restablecer vista)

Restablece la vista a su 

posición predeterminada.

View > Reset View (Ver > Restablecer vista)

Pulse Mayús + M.

El botón  Reset View (Restablecer vista) en la parte 

inferior de la vista de cámara.

Reset Rotation 

(Restablecer 

rotación)

Restablece la rotación de 

vista a su posición 

predeterminada.

View > Reset Rotation (Ver > Restablecer rotación)

Pulse Mayús + X.

Reset Zoom 

(Restablecer 

zoom)

Restablece el zoom de 

vista a su posición 

predeterminada.

View > Reset Zoom (Ver > Restablecer zoom)

Rotate View 

(Rotar vista)

Rota la vista  a la 

izquierda o a la derecha.

Mientras mantiene pulsadas las teclas Ctrl + Alt 

(W indows/Linux) o Ctrl + ⌘  (macOS), haga clic y arrastre el 

disco de rotación para rotarlo a la derecha o a la izquierda.

3D Rotate View 

(Rotar vista 3D)

Rota la vista en cualquier 

dirección. Esto solo está 

disponible en la vista de 

perspectiva.

Mientras mantiene pulsada la tecla Ctrl + Mayús 

(W indows/Linux) o ⌘  + mayúsculas (macOS), haga clic y 

arrastre la escena para rotarla en cualquier dirección.

Rotate 30 CW  

(Rotar 30 der.)

Rota la vista de cámara 

30 grados a la derecha, 

como una mesa de 

animación.

View > Rotate View CW  (Ver > Rotar vista der.)

Rotate 30 CCW  

(Rotar 30 izq.)

Rota la vista de cámara 

30 grados a la izquierda, 

como una mesa de 

animación.

View > Rotate View CCW  (Ver > Rotar vista izq.)

Mirror View (Vista 

de espejo)

Cambia temporalmente 

la vista de cámara o de 

dibujo en horizontal, lo 

que permite ver y editar 

la ilustración como si se 

View > Mirror View (Ver > Espejo)

En la barra de herramientas de cámara o de dibujo, haga clic 

en el botón Mirror View (Espejo) .

27

Guía de introducción de Harmony 22 Advanced                          



Capítulo 2: Introducción a la interfaz de usuario de Harmony

Comando Acción Métodos de acceso

estuviera reflejando.

Toggle Quick 

Close-up (Alternar 

primer plano 

rápido)

Multiplica 

inmediatamente el factor 

de zoom de la vista por 4. 

Por ejemplo, si el factor 

de zoom de la vista de 

cámara se encuentra al 

100 %, esto hará que 

alterne entre 400 % y 

100 %.

Mayús + Z

Toggle Full Screen 

(Alternar pantalla 

completa)

Pasa por los siguientes 

modos de visualización:

 l Normal Full-

Screen (Pantalla 

completa normal): 

la ventana 

principal de la 

aplicación se 

convierte en 

pantalla 

completa.

 l View Full-Screen 

(Ver pantalla 

completa): la vista 

seleccionada se 

convierte en 

pantalla completa 

y todas las demás 

vistas se 

contraen.

 l Normal: la 

ventana principal 

de la aplicación se 

restaura a su 

tamaño original y 

las vistas 

contraídas se 

expanden.

View > Toggle Full Screen (Ver > Alternar pantalla 

completa)

Pulse Ctrl + F (W indows/Linux) o ⌘  + F (macOS).
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Interfaz táctil

Si está trabajando con una pantalla táctil, un trackpad o una tableta que admita función táctil, también puede 

util izar los gestos de dos dedos estándar para el zoom, la rotación y el paneo en las vistas de cámara y dibujo. 

Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitación del soporte de gestos

 1. En el menú superior, vaya a Edit > Preferences (Editar > Preferencias) (W indows/Linux) o 

Harmony > Preferences (Harmony > Preferencias) (Mac OS X).

 2. Abra la pestaña General.

 3. En la sección Touch Interface (Interfaz táctil), marque la casilla de verificación Support Gestures 

(Soporte de gestos).

 4. Haga clic en OK (Aceptar).

 5. Reinicie Harmony.

Ahora puede manipular las vistas de cámara y de dibujo arrastrando dos dedos sobre la interfaz 

táctil.

Uso de gestos

 1. En la vista de cámara o de dibujo, presione con dos dedos situados a una distancia corta entre sí.

 2. Realice una de las siguientes acciones:

 l Para panear la vista, arrastre los dos dedos en cualquier dirección, manteniéndolos a la 

misma distancia uno del otro.

 l Para acercar el zoom, arrastre los dos dedos separando uno del otro.
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 l Para alejar el zoom, arrastre los dos dedos acercando uno al otro.

 l Para rotar, arrastre los dos dedos haciendo una curva para que giren en la misma dirección.
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Capítulo 3: Adición de capas

Al igual que con la animación tradicional, Harmony util iza capas para mantener los elementos, como 

personajes, fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendrá una capa predeterminada denominada Drawing (Dibujo) en la 

que se puede comenzar a dibujar de inmediato.

Las capas se pueden seleccionar y gestionar en la vista de línea de tiempo. Una escena puede tener tantas 

capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre 

las capas inferiores.

Tipos de capas de dibujo

Harmony admite dos tipos de capas de dibujo, cada una con sus propias ventajas y limitaciones:

 l Vector Layers (Capas de vectores): los dibujos de vectores están formados por puntos y curvas que 

componen los contornos de las formas de la ilustración, junto con el color o las texturas de relleno. Por 

lo tanto, la ilustración en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos 

que contenga una textura.
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Al dibujar en una capa de vector, cada trazo de dibujo y cada línea de lápiz es un objeto independiente 

que se puede manipular por separado. Puede seleccionar trazos y, a continuación, moverlos y 

transformarlos, incluso si se aplicaron trazos de dibujo sobre ellos. Además, debido a que los trazos de 

dibujo están formados por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y 

los cambios en la ilustración.

 l Bitmap Layers (Capas de mapa de bits): los dibujos de mapa de bits se componen de una cuadrícula de 

píxeles, que son puntos pequeños que tienen un solo color sólido. Las herramientas de dibujo de mapa 

de bits permiten colocar trazos de pincel en un único lienzo plano y ajustar la ilustración píxel a píxel si 

es necesario.

Al dibujar en una capa de mapa de bits, cada trazo se compone en el l ienzo, por lo que continúa siendo 

un dibujo único que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad 

de píxeles sin perder calidad de imagen. De forma predeterminada, la ilustración de mapa de bits tiene 

una densidad de píxeles del 100 %, que solo es suficiente para mostrar la ilustración sin ampliarla o 

escalarla; de lo contrario, Harmony debe generar nuevos píxeles en la ilustración, lo que puede hacer 

que se vea borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de píxeles requerida para la ilustración de 

mapa de bits, en función de si tendrá que ampliarla o escalarla, antes de comenzar a dibujar en una 

capa de mapa de bits.

NOTA 

Como las capas de vectores se pueden editar y escalar, se recomienda comenzar util izando capas 

de vectores mientras se familiariza con Harmony. La capa de dibujo predeterminada de una nueva 

escena es una capa de vectores.

Capas de dibujo

De forma predeterminada, cada capa de un dibujo tiene dos capas de dibujo: la capa de líneas y la capa de 

color. Puede util izar estas capas para mantener separadas la capa de líneas y los colores de los dibujos.
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A la derecha de la vista de cámara y de dibujo, puede controlar en qué capa de dibujo está trabajando y si solo 

se muestran la capa de dibujo actual o ambas capas de dibujo.

De forma predeterminada, está seleccionada la capa de línea. Por lo tanto, si comienza a dibujar de inmediato, 

dibujará en la capa de línea de la capa de dibujo, a menos que seleccione primero la capa de color.

El uso de distintas capas de dibujo para la capa de líneas y la capa de color es completamente opcional. Si lo 

desea, puede util izar la capa de líneas tanto para la capa de líneas como para la capa de color.

NOTA 

También puede habilitar capas de dibujo adicionales: las capas superior y de fondo. La capa de 

dibujo superior se suele util izar para anotaciones y la capa de fondo se suele util izar para esbozos 

básicos. Para habilitarlas, compruebe la opción Support Overlay and Underlay Arts (Admitir 

capas superior y de fondo) de la pestaña Advanced (Avanzado) del cuadro de diálogo Preferences 

(Preferencias), al que se puede acceder seleccionando Editar (W indows/Linux) o Harmony 

Advanced (macOS) > Preferences (Editar (W indows/Linux) o Harmony Advanced (macOS) 

> Preferencias) en el menú superior.
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Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En 

la animación tradicional, es común nombrar a las capas de animación con letras individuales (A, B, C, etc.) y las 

capas de diseño con acrónimos (BG para fondo, OL para superposición, etc.). Así, puede comenzar la escena 

dando a la primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de línea de tiempo

 1. En la vista de línea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

Aparece un campo de entrada de texto sobre el nombre.

 2. Escriba el nuevo nombre de la capa y pulse Intro/retorno.

La capa tiene un nuevo nombre.

Adición de capas

Adición de un elemento de dibujo desde la vista de línea de tiempo

 1. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic en el botón  Add Drawing Layer (Agregar capa de 

dibujo).

 l En el menú superior, seleccione Insert > Drawing (Insertar > Dibujo).

 l Pulse Ctrl + R (W indows/Linux) o ⌘  + R (macOS).

Aparece el cuadro de diálogo Add Drawing Layer (Agregar capa de dibujo).
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 2. En el campo Name (Nombre), escriba el nombre de la nueva capa.

 2. Seleccione si desea que la capa Line Art (Líneas) sea Vector o Bitmap (Mapa de bits).

 3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).

 4. Realice una de las siguientes acciones:

 l Haga clic en Add (Agregar) para crear esta capa, pero deje abierto el cuadro de diálogo para 

poder crear más capas.

 l Haga clic en Add and Close (Agregar y cerrar) para crear esta capa y cerrar el cuadro de 

diálogo.

Se agrega a la vista de línea de tiempo una nueva capa de dibujo.

Eliminación de capas

Eliminación de capas en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione las capas que desea eliminar.

35

Guía de introducción de Harmony 22 Advanced                          



Capítulo 3: Adición de capas

NOTA 

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayús, 

haciendo clic en la primera capa que desee seleccionar y, a continuación, en la última. 

También puede seleccionar varias capas manteniendo pulsada la tecla Ctrl 

(W indows/Linux) o ⌘  (macOS) y haciendo clic en cada capa que desee seleccionar.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de capa de la vista de línea de tiempo, haga clic en el botón  

Delete Layers (Eliminar capas). 

 l Haga clic con el botón derecho en la selección y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de línea de tiempo.

Cambio de orden de capas

Reorganización de capas en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione las capas que desea mover.

 2. Haga clic y arrastre la selección, y realice una de las siguientes acciones:

 l Coloque la selección entre dos capas para moverla entre ellas. Aparecerá una línea cian 

entre las capas donde se moverá la selección.
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 l Coloque la selección en una capa para aplicar un rig de las capas seleccionadas como hijas 

sobre esa capa.

Agrupación de capas

La agrupación de capas permite mantener la estructura de la escena organizada.

Además, puede colocar varias capas dentro de un grupo y, a continuación, agregar un efecto en este grupo 

para aplicarlo en todas las capas del mismo.

Agrupación de capas en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione los elementos que desee agrupar.

NOTA 

Las capas que se encuentren entre las seleccionadas se agruparán con las capas 

seleccionadas.

 2. Realice una de las siguientes acciones:

 l Haga clic con el botón derecho en las capas resaltadas y seleccione Group Selection 

(Agrupar selección).

 l Pulse Ctrl + Mayús + G (W indows/Linux) o ⌘  + mayúsculas + G (macOS). 

Se agrega una nueva capa de grupo a la vista de línea de tiempo.
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Si hace clic en el botón  Expand Group (Expandir grupo), encontrará las capas agrupadas en rig 

como hijos de la capa de grupo. 

Ocultar y visualizar capas

Puede ocultar capas temporalmente para que no desordenen la vista de cámara mientras trabaja en otras 

capas.

Cómo ocultar una capa en la vista de línea de tiempo

 1. En la vista de línea de tiempo, a la izquierda de la capa que desea ocultar, haga clic en el botón  

Disable Layer (Deshabilitar capa).

La capa se volverá invisible en la vista de cámara.

 2. Si desea mostrar la capa, haga clic en el botón  Enable Layer (Activar capa) para volver a 

mostrarla.

Bloqueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas bloqueadas se pueden editar en la vista de línea de tiempo o 

de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de cámara. Esto puede 

ser útil para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o 

personajes con los que no esté trabajando actualmente.
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Bloqueo de una capa en la vista de línea de tiempo

 1. En la vista de línea de tiempo, a la izquierda de la capa que desea bloquear, haga clic en el botón 
 Lock (Bloquear).

Será imposible seleccionar la capa o dibujar en ella en la vista de cámara. El nombre de la capa 

aparecerá en rojo en la vista de línea de tiempo.

 2. Si desea desbloquear la capa, haga clic en el botón  Unlock Layer (Desbloquear capa) para 

volver a mostrarla.
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Capítulo 4: Cómo dibujar

Cuando crea una escena, la escena incluye una capa de dibujo predeterminada en la que puede comenzar a 

dibujar de inmediato.

NOTA 

Según su estilo de dibujo y con lo que se sienta cómodo, es posible que prefiera trabajar con la 

herramienta Brush (Pincel) o la herramienta Pencil (Lápiz). Para obtener más información sobre la 

diferencia entre estas dos herramientas, consulte Cuando crea una escena, la escena incluye una 

capa de dibujo predeterminada en la que puede comenzar a dibujar de inmediato. en la página 40.

Dibujo con la herramienta Brush (Pincel)

 1. En la vista de línea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de 

dibujo.

 2. Si desea dibujar con la herramienta Brush (Pincel), realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta  Brush (Pincel).

 l En el menú superior, seleccione Tools > Brush (Herramientas > Pincel).

 l Pulse Alt + B.

Si desea dibujar con la herramienta Pencil (Lápiz), realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta  Pencil (Lápiz).

 l En el menú superior, seleccione Tools > Pencil (Herramientas > Lápiz).

 l Pulse Alt + /.

 3. En la lista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione 

un pincel o lápiz predefinido que desee util izar.
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 4. Util ice el control deslizante Maximum Size (Tamaño máximo) para seleccionar el tamaño deseado 

para el pincel o lápiz.

 5. Para seleccionar un color, haga clic en el color que desee util izar en la vista de color. Para obtener 

más información sobre la creación y edición de colores, consulte Creación o edición de muestras de 

colores en la página 59.

 6. En la vista de dibujo o de cámara, comience a dibujar.

 7. Si desea realizar cambios en su pincel o lápiz, en la vista propiedades de la herramienta, haga clic 

en el botón de flecha para abrir el cuadro de diálogo Brush Properties (Propiedades del pincel) o 

Pencil Properties (Propiedades del lápiz). En el cuadro de diálogo Brush Properties (Propiedades 

del pincel), puede personalizar el tamaño, la forma, la textura, el calado y el suavizado de línea del 

pincel. En el cuadro de diálogo Pencil Properties (Propiedades del lápiz), puede personalizar el 

tamaño, el suavizado, la textura y los finales de línea del lápiz.
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CONSEJOS 

 l Puede ajustar rápidamente el tamaño de la herramienta de dibujo seleccionada 

manteniendo pulsada la tecla y, a continuación, haciendo clic en la tecla O y, a 

continuación, arrastrando en el espacio de dibujo. Si util iza un lápiz de tableta, al hacerlo 

con la punta del borrador del lápiz ajustará el tamaño de la herramienta Eraser (Borrador), 

independientemente de la herramienta de dibujo seleccionada.

 l Si mantiene pulsada la tecla Mayús antes de dibujar o mientras lo hace, dibujará una línea 

recta.

 l Si mantiene pulsada la tecla barra espaciadora mientras dibuja una línea recta, se fijará el 

ángulo de la línea. Si util iza una tableta sensible a la presión, puede dibujar sobre la línea 

para ajustar su grosor.

 l Si mantiene pulsadas las teclas Mayús y Alt antes de dibujar o mientras lo hace, dibujará 

una línea recta horizontal o vertical.

 l Si mantiene pulsada la tecla Ctrl (W indows/Linux) o ⌘  (macOS) mientras dibuja, su trazo 

de dibujo se convertirá en una forma cerrada.

 l Si mantiene pulsada la tecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un 

dibujo existente, el comienzo del trazo se conectará con el otro dibujo.

 l Si mantiene pulsada la tecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro 

dibujo existente, el final del trazo se conectará con dicho dibujo.

Ajuste de ilustración

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el último trazo, borrar partes de un 

dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

NOTA 

No puede manipular o modificar los trazos del dibujo al dibujar en una capa de mapa de bits; 

consulte Adición de capas en la página 31.

Deshacer el último trazo

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Edit > Undo (Editar > Deshacer).

 l Pulse Ctrl + Z (W indows/Linux) o ⌘  + Z (macOS).
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Cómo borrar

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Eraser (Borrador) o 

pulse Alt + E.

 2. En la vista de dibujo o de cámara, dibuje un trazo de borrador sobre las partes del dibujo que desee 

borrar.

Manipulación de los trazos del dibujo

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Select (Seleccionar) o 

pulse Alt + S.

 2. En la vista de cámara o de dibujo, seleccione los trazos que desee editar realizando una de las 

siguientes acciones:

 l Haga clic en un trazo para seleccionarlo.

 l Mantenga pulsada la tecla Mayús mientras hace clic en un trazo para agregarlo a la 

selección.

 l Dibuje un lazo alrededor de los trazos de dibujo para seleccionarlas simultáneamente.

 3. Realice una de las siguientes acciones para editar la selección:

 l Para cambiar la ilustración seleccionada de posición, haga clic en ella y arrástrela a la 

posición deseada.
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NOTA 

También puede realizar un desplazamiento pequeño de la selección con las 

teclas de flecha y, para realizar un desplazamiento rápido, mantenga pulsado 

Mayús y pulse las teclas de flecha.

 l Para rotar la ilustración seleccionada, haga clic fuera de la imagen y coja uno de los 

controladores en las esquinas del cuadro de control y rótela.

 l Para escalar la ilustración seleccionada, haga clic y arrastre uno de los puntos de control en 

las esquinas o en el centro de los bordes del cuadro de control.

CONSEJO 

Mientras escala la ilustración, puede conservar las proporciones manteniendo 

pulsada la tecla Mayús.

 l Para sesgar, arrastre hacia los lados o hacia arriba y abajo de los lados o los segmentos 

superior e inferior, entre los puntos de control.
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 l Para eliminar, pulse Supr (W indows/Linux) o retroceso (macOS).

Edición de las líneas

 1. Realice una de las siguientes acciones:

 l Si dibujó con la herramienta Brush (Pincel), en la barra de herramientas de herramientas, 

haga doble clic en  Contour Editor (Editor de contorno) y seleccione  Centerline Editor 

(Editor de línea central) en el menú emergente, o pulse Alt + W .

 l Si ha dibujado con la herramienta Pencil (Lápiz), en la barra de herramientas de 

herramientas, seleccione la herramienta  Contour Editor (Editor de contorno) o pulse Alt + 

Q.

 2. En la vista de dibujo o de cámara, haga clic en la forma, el contorno o la línea de lápiz que desee 

editar cerca del área que desee modificar.

Aparecen los puntos de control de la forma o de la línea.

 3. Haga clic en uno de los puntos para seleccionarlo. 

Aparecen los controladores de curva Bézier del punto, así como los controladores de curva Bézier 

para los puntos circundantes.
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CONSEJO 

Puede seleccionar varios puntos dibujando un lazo alrededor de los mismos, o 

manteniendo pulsado Mayús mientras hace clic en los puntos para agregarlos a la 

selección. Puede util izar Contour Editor (Editor de contorno) para escalar y rotar una 

selección de varios puntos habilitando la opción  Show Contour Editor Control 

(Mostrar control de editor de contorno) en la vista de propiedades de la herramienta.

 4. Realice una de las siguientes acciones:

 l Para mover un punto o una selección de varios puntos, haga clic y arrástrelo.

 l Para cambiar la curva en ambos lados de un punto, arrastre uno de sus controladores de 

curva Bézier.

 l Para cambiar la curva en un solo lado de un punto, mantenga pulsada la tecla Alt y, a 

continuación, arrastre uno de sus controladores de curva Bézier.
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 l Para deformar el contorno, arrastre una parte del contorno entre dos puntos.

 l Para deformar la curva entre dos puntos, mantenga pulsada la tecla Mayús y arrastre el 

contorno entre dos puntos.

 l Para eliminar los controladores de curva Bézier de un punto y hacer que las líneas a las que 

está conectado sean rectas, mantenga pulsada la tecla Alt y haga clic en el punto.
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 l Las líneas rectas no tienen controladores de curva Bézier en sus puntos de forma 

predeterminada. Para crear controladores de curva Bézier para estos puntos y hacer que sus 

líneas sean curvas, mantenga pulsada la tecla Alt y, a continuación, haga clic y mantenga 

pulsado el punto y arrastre el cursor del ratón lejos de él. Un nuevo controlador de curva 

Bézier seguirá el cursor del ratón hasta que suelte el botón del ratón.

 l Para agregar un punto de control, pulse Ctrl (W indows/Linux) o ⌘  (macOS) y haga clic en el 

contorno donde desea que se cree el nuevo punto.

 l Para eliminar un punto de control, seleccione el punto de control y pulse Supr 

(W indows/Linux) o retroceso (macOS).

Cómo cortar dibujos

 1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla)  o 

pulse Alt + T.

48



 2. En la vista de cámara o de dibujo, dibuje un lazo alrededor del trabajo que desea cortar.

El trabajo dentro del lazo que ha dibujado se cortará del resto del trabajo y se seleccionará.

CONSEJOS 

 l Puede agregar otra parte del trabajo a la selección manteniendo pulsado Mayús y 

dibujando otro lazo.

 l De forma predeterminada, la herramienta Cutter (Cuchilla) solo funcionará en la 

capa actual. Puede cortar trabajos de todas las capas visibles manteniendo pulsada 

la tecla Ctrl (W indows/Linux) o ⌘  (macOS).

 3. Una vez que haya cortado la imagen, puede manipularla como con la herramienta Select 

(Seleccionar). Por ejemplo:

 l Para mover el trabajo seleccionado, haga clic y arrástrelo.

 l Para eliminar el área seleccionada, pulse Supr.

 l Para escalar, rotar o sesgar la selección, util ice los controles alrededor del cuadro 

delimitador de la selección.
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Cómo recortar una sola línea

 1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla)  o 

pulse Alt + T.

 2. En la vista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de 

cuchilla), seleccione el lazo .

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de línea).

 3. Seleccione el modo Single Line Cutting Gesture (Gesto de corte de una sola línea) .

 4. En la vista de escena o de cámara, deslice la herramienta Cutter (Cuchilla) por el extremo de una 

línea que desee recortar.

El extremo de la línea desaparece.

Antes
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Después

 

NOTA 

Incluso si el gesto del ratón toca otras líneas, solo desaparece la primera línea con la que la 

herramienta Cutter (Cuchilla) entra en contacto.

51

Guía de introducción de Harmony 22 Advanced                          



Capítulo 4: Cómo dibujar

Cómo recortar varias líneas

 1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla)  o 

pulse Alt + T.

 2. En la vista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de 

cuchilla), seleccione el lazo .

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de línea).

 3. En la vista de propiedades de la herramienta, seleccione Multiple Lines Cutting Gesture Mode 

(Modo de gesto de corte de varias líneas) .

 4. En la vista de escena o de cámara, deslice la herramienta Cutter (Cuchilla) por el extremo de una 

línea que desee recortar.

Los extremos de la línea desaparecen.

Antes

Después
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Acerca de estilos artísticos, herramientas de dibujo y tipos de capas

Las dos herramientas de dibujo principales en Harmony son la herramienta  Brush (Pincel) y la herramienta 
 Pencil (Lápiz). Según el estilo de dibujo que desee lograr, es posible que prefiera trabajar con capas de 

vectores o de mapas de bits.

En las capas de vectores, es posible dibujar con líneas de lápiz, líneas de lápiz con textura, pinceles de vectores 

y pinceles de vectores con textura. Mientras que las líneas de lápiz son líneas centrales de vectores a las que 

puede agregar grosor, los trazos de pincel son formas de vector sólidas rellenas con un color y los trazos de 

pincel con textura son trazos de pincel rellenos de una textura de mapa de bits que filtra su color.
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En las capas de mapa de bits, solo puede dibujar util izando pinceles de mapa de bits sólidos o con textura. Por 

lo tanto, aunque las capas de vectores son más flexibles porque permiten manipular y ajustar fácilmente 

partes de la ilustración, también pueden albergar más estilos artísticos.

Sin embargo, si util iza un pincel con textura en una capa de vectores, los trazos de pincel tendrán una textura 

de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa de bits, intentar ajustar o 

cambiar el tamaño de un trazo de pincel con textura requerirá que Harmony vuelva a probar la textura, lo que 

puede hacer que pierda calidad de imagen, a menos que su resolución de textura se hubiera aumentado lo 

suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los 

dibujos de mapa de bits siempre están hechos de un solo lienzo plano, los trazos de pincel de vectores se 

guardan como objetos independientes. Esto significa que colocar muchos trazos de pincel con textura en un 

dibujo de vectores requerirá que Harmony almacene la textura para cada uno de estos trazos y los componga 

en tiempo real para mostrar el dibujo. Esto puede hacer que los dibujos de vectores cargados de textura, a 

diferencia de los dibujos de mapa de bits, hagan que el rendimiento de la aplicación sea más lento y el tamaño 

del archivo sea mayor. Sin embargo, este es el único caso en el que es probable que un dibujo de vectores sea 

más pesado que un dibujo de mapa de bits.

Aunque no se recomienda para el esbozo, las líneas de lápiz con textura son una buena solución. Las líneas de 

lápiz con textura son más ligeras y fáciles de editar. Esto significa que la textura se actualizará con la 

transformación si escala o ajusta la línea de lápiz. Esto también significa que se puede cambiar la textura 

aplicada a una línea de lápiz existente o aplicar una textura a una línea de lápiz que aún no la tenga. Las 

texturas de pincel se recomiendan sobre las líneas de lápiz con textura cuando se trata de conseguir 

pinceladas de aspecto natural.
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NOTA 

Incluso si aplana la ilustración, los trazos de pincel con textura de distintos colores no se pueden 

aplanar juntos en capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Harmony:

Herramienta de 

dibujo

Tipo de 

capa
Especificaciones

Lápiz sólido Vector

Ventajas: muy ligero y fácil de ajustar. Se puede manipular, volver a 

colorear y ajustar mediante la línea central. Se puede acercar o aumentar 

de tamaño sin perder calidad.

Desventajas: no está optimizado para transparencia.

Uso recomendado: dibujos limpios con un estilo de contorno sólido y 

uniforme.

Lápiz con textura Vector

Ventajas: l igero y fácil de ajustar. Se puede manipular, volver a colorear y 

ajustar mediante la línea central. Se puede acercar o aumentar de tamaño 

sin perder calidad.

Desventajas: no está optimizado para transparencia. No se recomienda 

para realizar bocetos. No tiene un aspecto tan natural como los pinceles 

con textura.

Uso recomendado: para ilustraciones de textura ligera o de estilo mixto 

que requieren mucha manipulación de líneas.

Pincel de vectores 

sólido
Vector

Ventajas: tamaño de archivo ligero. Reproduce el estilo de animación 

tradicional. Se puede manipular, volver a colorear y editar mediante el 

contorno o la línea central. Se puede acercar o aumentar de tamaño sin 

perder calidad.

Desventajas: no puede reproducir el aspecto de los medios naturales.

Uso recomendado: bocetos, dibujos limpios de animación tradicional.

Pincel de vectores 

con textura
Vector

Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta 

con las mismas capacidades que los pinceles de mapa de bits con textura, 

pero se puede manipular, editar y volver a colorear como un pincel de 

vectores sólido.

Desventajas: los trazos superpuestos de pincel pueden provocar que el 

dibujo haga que el rendimiento de la aplicación sea lento y el tamaño de los 

archivos sea pesado. Los trazos de pincel de distintos colores no se pueden 

aplanar a la vez. Si se ajusta, aumenta de tamaño o acerca la ilustración, 

puede disminuir la calidad de la textura.

55

Guía de introducción de Harmony 22 Advanced                          



Capítulo 4: Cómo dibujar

Herramienta de 

dibujo

Tipo de 

capa
Especificaciones

Uso recomendado: para ilustraciones con textura de estilo de mapa de bits 

ligera o ilustraciones de estilo mixto.

Pincel de mapa de 

bits con textura

Mapa de 

bits

Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor 

rendimiento y tamaño de archivo más ligero que las ilustraciones de 

vectores cargados de textura. Se puede editar píxel a píxel.

Desventajas: los trazos de pincel siempre se aplanan a la vez y no se 

pueden modificar por separado. Solo se pueden dibujar o borrar. Si se 

aumenta de tamaño o se acerca la ilustración, puede disminuir la calidad de 

la imagen.

Uso recomendado: ilustración de mapa de bits cargado de textura.
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Capítulo 5: Cómo pintar

Toon Boom Harmony Advanced incluye algunas funciones de pintura muy útiles para agregar color a los 

dibujos. Mientras que otro software solo permite que los usuarios trabajen con muestras de color de una en 

una, la pintura en Harmony se realiza con paletas que contienen varias muestras de color que se pueden 

almacenar y reutil izar según sea necesario.

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo. 

Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y 

modificarlas.

Cuando modifique el color de una muestra existente, se actualizarán automáticamente todas las zonas 

pintadas con esta muestra en toda la escena. La muestra de color tiene un número de ID exclusivo que la 

asocia con las zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento 

sin necesidad de volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por 

ejemplo, además de la paleta habitual para un personaje, también puede tener una para ese personaje en la 

lluvia con colores más apagados y menos vivos que los colores de días secos, o incluso otra para una escena 

de noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para 

ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animación se util izan colores específicos para pintar cada parte de cada personaje. Con el fin de mantener 

una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la 

producción. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada área que se deba colorear. Cada muestra 

almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este último se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:

 l Cada personaje conserva permanentemente sus colores específicos.

 l No puede usar por error un color que no esté en la paleta maestra.

 l Estandarización y uniformidad del color durante la producción.

 l Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony util iza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite 

un control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creará una nueva paleta 

y agregará un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el 

pelo, la lengua, la camiseta, los pantalones, etc.

Creación de una nueva paleta

 1. En el menú de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botón 
 New Palette (Nueva paleta).

Se abre el cuadro de diálogo Create Palette (Crear paleta).

 2. Introduzca el nombre de la paleta según el modelo.

 3. Haga clic en OK (Aceptar).

La paleta aparece en la lista de paletas.
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Creación o edición de muestras de colores

 1. Si desea crear una nueva muestra de color, haga clic en el botón  Add Colour (Agregar color) en 

la vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de 

color.

 2. Realice una de las siguientes acciones para editar la muestra de color:

 l En el menú de vista de color, seleccione Colours > Edit (Colores > Editar).

 l Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

 3. Para definir el color, realice una de las siguientes acciones:

 l Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation 

(Saturación) o Value (Valor) para cambiar el espectro del círculo cromático y, a 

continuación, haga clic en el color que desee en el círculo cromático.

 l Introduzca los valores de matiz, saturación, valor, rojo, verde y azul de forma manual 

en los campos correspondientes. Todos los valores oscilan entre 0 y 255.
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NOTA 

Si cambia una muestra de color después de haber dibujado o pintado con él áreas de un 

dibujo, todas las áreas pintadas con este color en los dibujos vectoriales se actualizarán al 

nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cómo pintar dibujos

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

 2. En la barra de herramientas de herramientas, seleccione la herramienta  Paint (Pintar) o pulse 

Alt + I.

 3. En la vista de color, seleccione una paleta del personaje.

 4. Seleccione un color de la paleta.

 5. En la vista de dibujo o de cámara, comience a pintar el dibujo con los colores.
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NOTA 

Al abrir una escena, las paletas de esta no se cargarán inmediatamente en la vista de color. 

Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas áreas del dibujo no estaban completamente cerradas debido a 

pequeños huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el área, ya que solo 

rellena formas cerradas. Para cerrar la zona, puede dibujar una línea sobre el hueco con la herramienta Brush 

(Pincel) o Pencil (Lápiz). Sin embargo, solo es posible cerrar el hueco agregando encima una línea invisible, 

que la herramienta Paint (Pintar) considerará como una línea normal. En Harmony, las líneas invisibles 

util izadas para definir las áreas que se deben colorear se denominan líneas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequeños huecos en el contorno de un dibujo 

dibujando al instante una línea vectorial transparente para rellenar el hueco. A diferencia de la herramienta 

Stroke (Línea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con 

precisión. Solo tiene que dibujar un trazo básico junto al hueco para que se cree automáticamente una línea 

vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

 1. Antes de trabajar con líneas vectoriales transparentes, se recomienda habilitar la opción Show 

Strokes (Mostrar líneas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo 

o de cámara. Puede habilitar la opción Show Strokes (Mostrar líneas vectoriales transparentes) 

realizando una de las siguientes acciones:

 l En el menú superior, seleccione View > Show > Show Strokes (Ver > Mostrar > 

Mostrar líneas vectoriales transparentes).

 l Pulse K.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas , seleccione la herramienta  Close 

Gap (Cerrar hueco).

 l En el menú superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo > 

Herramientas de dibujo > Cerrar hueco).

 l Pulse Alt + C.

 3. En la vista de cámara o de dibujo , trace una línea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automáticamente.

NOTA 

La herramienta Paint (Pintar) también incluye una opción Close Gap (Cerrar hueco), que se 

puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada, 

Harmony intentará encontrar y cerrar automáticamente pequeños huecos cuando intente 

rellenar una forma que no esté cerrada.
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Creación de un boceto de animación

El primer paso para crear una animación sin papel es la creación de un boceto, que es el esqueleto de la 

animación. Por lo general, empezaría animando la parte más importante de la acción de un personaje. Por 

ejemplo, para animar un ciclo de andar, comenzará por el movimiento del torso y de las piernas. Después se 

puede agregar una animación secundaria como la cabeza, los brazos y la ropa.

Para que la animación sea satisfactoria, comience animando la acción principal con esbozos básicos y rápidos 

y, a continuación, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos 

los detalles inmediatamente, perderá mucho tiempo en caso de tener que realizar correcciones, y es probable 

que la animación tenga una apariencia rígida.

Creación de un boceto de animación

 1. En la fila superior de la vista de línea de tiempo, haga clic en  Show All Thumbnails (Mostrar 

todas las imágenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

 2. Pulse Ctrl + U (W indows/Linux) o ⌘  + U (macOS) para abrir el cuadro de diálogo Preferences 

(Preferencias).

 3. Seleccione la pestaña Exposure Sheet (Carta de exposición).

 4. Seleccione la opción Use Current Frame as Drawing Name (Usar fotograma actual como nombre 

de dibujo). Cuando esta preferencia esté habilitada, los dibujos nuevos se nombrarán con el 

número de fotograma en el que se crearon.
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 5. En la barra de herramientas de herramientas, seleccione la herramienta  Brush (Pincel) o pulse 

Alt + B.

 6. En la vista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para 

el boceto de animación. Esto facilitará el proceso de clean up, ya que las líneas oscuras y limpias 

harán contraste con las líneas esbozadas claras.

 7. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca 

el primer dibujo.

 8. En la vista de cámara o de dibujo, dibuje el primer dibujo clave.

En cuanto dibuje el primer trazo, se crea automáticamente un dibujo en la celda seleccionada.

 9. Aumente el nivel de zoom de la vista de línea de tiempo hasta que vea las imágenes en miniatura 

dentro de las celdas realizando una de las siguientes acciones:

 l Arrastre el control deslizante  Timeline Zoom (Zoom de línea de tiempo) hacia 

la derecha.

 l Haga clic en la pestaña de la vista de línea de tiempo y pulse 2 de forma reiterada.
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 l Mueva el cursor del ratón en la vista de línea de tiempo, mantenga pulsado Ctrl 

(W indows/Linux) o ⌘  (macOS) y gire la rueda del ratón hacia arriba.

 10. Con la primera celda aún seleccionada, realice una de las siguientes acciones para marcar el dibujo 

como dibujo clave. Esto le ayudará a mantener el orden.

 l Habilite la barra de herramientas Mark Drawing (Marcar dibujo) seleccionando 

W indows > Toolbar > Mark Drawing (Ventanas > Barra de herramientas > Marcar 

dibujo) en el menú superior y, a continuación, haga clic en el botón  Mark Selected 

Drawings as Key (Marcar como dibujo clave).

 l Habilite la barra de herramientas de carta de rodaje centrándose en la carta de rodaje 

y seleccione W indows > Toolbar > Xsheet (Ventanas > Barra de herramientas > 

Carta de rodaje) en el menú superior. A continuación, haga clic en el botón  Mark as 

Key Drawing (Marcar como dibujo clave).

 l En el menú de la vista de línea de tiempo, seleccione Drawings > Mark Drawing As > 

Key Drawing (Dibujos > Marcar dibujo como > Dibujo clave).

 

 11. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca 

el próximo dibujo clave.

 12. En la barra de herramientas de herramientas, haga clic en el botón  Onion Skin (Papel cebolla). 

Esto mostrará los dibujos anteriores y siguientes en un color claro en la vista de cámara o de dibujo, 

detrás del dibujo actual, para que pueda util izarlos como referencias para realizar nuevos dibujos 

con precisión. Esta opción puede ser útil para dibujar poses de descomposición entre dos poses 

65

Guía de introducción de Harmony 22 Advanced                          



Capítulo 6: Creación de una animación tradicional sin papel

clave, o para agregar un dibujo intercalado entre otros dos dibujos.

 13. Asegúrese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo 

dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic y arrastre el marcador de papel cebolla roja 

para que incluya los dibujos anteriores que desea mostrar en el papel cebolla y, a 

continuación, haga clic y arrastre el marcador de papel cebolla verde para que incluya 

los siguientes dibujos que desea mostrar en el papel cebolla.

 l Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar 

la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

 l Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic 

en el botón  Add Previous Drawing (Agregar dibujo anterior) en la barra de 

herramientas de la vista de cámara/dibujo.

 l Para reducir la cantidad de dibujos anteriores que se van a mostrar, haga clic 

en el botón  Remove Previous Drawing (Eliminar dibujo anterior) en la barra 

de herramientas de la vista de cámara/dibujo.

 l Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic 

en el botón  Add Next Drawing (Agregar dibujo siguiente) en la barra de 

herramientas de la vista de cámara/dibujo.

 l Para reducir la cantidad de dibujos siguientes que se van a mostrar, haga clic 

en el botón  Remove Next Drawing (Eliminar dibujo siguiente) en la barra de 

herramientas de la vista de cámara/dibujo.
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NOTA 

En la vista de dibujo, puede util izar la barra de herramientas de papel cebolla 

para que el papel cebolla solo muestre tipos específicos de dibujos, como 

dibujos clave o descomposiciones. Tenga en cuenta que esto no funciona en la 

vista de cámara.

 14. Cree un nuevo dibujo vacío mediante una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo o de carta de rodaje, haga clic en el 

botón  Create Empty Drawing (Crear dibujo vacío).

 l Pulse Alt + Mayús + R.

 15. En la vista de cámara o de dibujo, dibuje el segundo dibujo clave.

 16. En la vista de carta de rodaje o de línea de tiempo, identifique el dibujo como dibujo clave.
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 17. En la vista de línea de tiempo o de carta de rodaje, seleccione una celda entre los dos dibujos clave.

 18. Al usar los marcadores de papel cebolla, asegúrese de que el papel cebolla cubra tanto el primer 

como el último dibujo.

 19. Cree un nuevo dibujo vacío mediante una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo o de carta de rodaje, haga clic en el 

botón  Create Empty Drawing (Crear dibujo vacío).

 l Pulse Alt + Mayús + R.

 20. En la vista de cámara o de dibujo, dibuje la nueva pose.

 21. En la vista de línea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos 

anteriores para cada nuevo dibujo.

NOTA 

Al trabajar con capas de superposición en la vista de cámara, puede habilitar la opción  

Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de 

cámara para hacer que la capa en la que está trabajando aparezca sobre las otras capas.
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Revisión de la animación

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se está trabajando conectan bien 

entre sí y crean la ilusión de movimiento adecuada. Puede desplazarse rápidamente por los dibujos con los 

atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente, o con la barra de herramientas de flipping 

sencillo.

Desplazamiento por los dibujos

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee 

desplazarse.

 2. Realice una de las siguientes acciones:

 l Pulse F para ir al dibujo anterior.

 l Pulse G para ir al dibujo siguiente.

 3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atrás o 

hacia delante.

Uso de la barra de herramientas de flipping sencillo

 1. Cambie a la vista de dibujo.

 2. En el menú superior, seleccione W indows > Toolbars > Easy Flipping (Ventanas > Barras de 

herramientas > Flipping sencillo) para habilitar la barra de herramientas de flipping sencillo.

 3. En la barra de herramientas de flipping sencillo, haga clic en el botón  Previous (Anterior) o  

Next (Siguiente) para ver el dibujo anterior o siguiente de la animación.

 4. Para mostrar los dibujos del primer fotograma después de llegar al último fotograma de la 

animación, seleccione la opción Loop (Bucle).

 5. Mueva el control deslizante hacia la derecha para desplazarse hacia delante y hacia la izquierda 

para desplazarse hacia atrás por los dibujos.

Cuanto más mueva el control deslizante hacia la izquierda o la derecha, más deprisa se 

desplazarán los dibujos.
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 6. En el campo Preroll (Preprocesamiento), introduzca la cantidad de dibujos por los que desplazarse 

automáticamente antes y después del dibujo actual.

 7. En el campo FPS, introduzca la velocidad a la que desee desplazarse automáticamente por los 

dibujos en fotogramas por segundo.

 8. Haga clic en el botón  Easy Flip (Flip sencillo) para desplazarse automáticamente por los dibujos 

en función de la configuración de Preroll (Preprocesamiento) y FPS.

Cuando el boceto de animación esté terminado, reprodúzcalo para asegurarse de que es lo que se esperaba 

antes de continuar con el siguiente paso.

Reproducción de la animación

 1. En la vista de línea de tiempo, haga clic en el botón del modo  Solo a la izquierda de cada capa 

que desee ver durante la reproducción en la vista de línea de tiempo para habilitar el modo  Solo 

en estas capas.

Cuando una o más capas tengan habilitado el modo Solo, únicamente se mostrarán las capas que 

tengan este modo habilitado, y las otras capas quedarán ocultas.

 2. En la vista de línea de tiempo, mueva el cabezal rojo al primer fotograma de la animación y haga 

clic en el botón Start (Iniciar) en la barra de herramientas de línea de tiempo. A continuación, 

mueva el cabezal al último fotograma de la animación y haga clic en el botón Stop (Detener).

 3. En la barra de herramientas de reproducción, haga clic en el botón  Loop (Bucle) para habilitar la 

opción de bucle durante la reproducción.

 4. En la barra de herramientas de reproducción, haga clic en el botón  Play (Reproducir) para 

comenzar la reproducción.

Limpieza

Una vez que se haya completado el boceto de animación, es el momento de limpiarlo y tintarlo. A este paso 

también se le denomina trazado. Consiste en trazar líneas sólidas y limpias sobre el boceto de animación para 

cerrar las zonas abiertas. Es el paso final de la animación sin papel antes del paso de ink and paint.
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En una animación tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el 

boceto debajo, que se puede ver con la mesa de luz del disco de animación. Del mismo modo, en Harmony, 

tendrá que agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando 

haya terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animación para 

que no aparezca en la animación final. Este enfoque también permite mantener los bocetos y los dibujos de 

clean up intactos y administrarlos de manera independiente.

En la vista de cámara, verá el boceto de animación mientras trabaja en la capa de clean up. Si prefiere trabajar 

en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animación mientras realiza 

trazados en la capa de clean up.

Trazado de la animación en una nueva capa

 1. En la vista de línea de tiempo, cambie el nombre de la capa en la que creó el boceto de animación 

haciendo doble clic en su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

 2. En la vista de línea de tiempo, agregue una capa realizando una de las siguientes acciones:

 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en el 

botón  Add Drawing Layer (Agregar capa de dibujo).

 l Pulse Ctrl + R (W indows/Linux) o ⌘  + R (macOS).

Aparece el cuadro de diálogo Add Drawing Layer (Agregar capa de dibujo).

 2. En el campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".

 2. Seleccione si desea que la capa Line Art (Líneas) sea Vector o Bitmap (Mapa de bits).

 3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).

 4. Haga clic en Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.

71

Guía de introducción de Harmony 22 Advanced                          



Capítulo 6: Creación de una animación tradicional sin papel

Se agrega a la vista de línea de tiempo una nueva capa de dibujo.

 5. En la vista de línea de tiempo, haga clic en el icono  Lock (Bloquear) de la capa que contiene el 

boceto de animación para impedir que dicha capa se pueda seleccionar en la vista de cámara.

 6. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que 

corresponda al primer dibujo clave del boceto de animación.

 7. En la barra de herramientas de herramientas, seleccione una herramienta de dibujo, como la 

herramienta  Pencil (Lápiz).

 8. En la vista de color, seleccione un color para trazar la animación. Seleccione un color oscuro 

intenso, como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del 

boceto de animación.

 9. En la vista de cámara o de dibujo, comience a trazar el primer dibujo clave.
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NOTA 

Si las capas de superposición están en medio, puede deshabilitarlas 

temporalmente haciendo clic en su botón  Enable/Disable 

(Habilitar/deshabilitar) en la vista de línea de tiempo para que solo se muestren 

el boceto de animación y las capas de clean up.

 10. En la vista de línea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a 

un boceto de dibujo.

 11. En la barra de herramientas de herramientas, haga clic en el botón  Enable Onion Skin (Habilitar 

papel cebolla) para habilitar el papel cebolla.

 12. Asegúrese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las 

siguientes acciones:

 l En la vista de línea de tiempo, haga clic y arrastre el marcador de papel cebolla roja 

para que incluya los dibujos anteriores que desea mostrar en el papel cebolla y, a 

continuación, haga clic y arrastre el marcador de papel cebolla verde para que incluya 

los siguientes dibujos que desea mostrar en el papel cebolla.
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 l Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar 

la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

 l Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic 

en el botón  Add Previous Drawing (Agregar dibujo anterior) en la barra de 

herramientas de la vista de cámara/dibujo.

 l Para reducir la cantidad de dibujos anteriores que se van a mostrar, haga clic 

en el botón  Remove Previous Drawing (Eliminar dibujo anterior) en la barra 

de herramientas de la vista de cámara/dibujo.

 l Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic 

en el botón  Add Next Drawing (Agregar dibujo siguiente) en la barra de 

herramientas de la vista de cámara/dibujo.

 l Para reducir la cantidad de dibujos siguientes que se van a mostrar, haga clic 

en el botón  Remove Next Drawing (Eliminar dibujo siguiente) en la barra de 

herramientas de la vista de cámara/dibujo.

 13. En la vista de cámara, trace el siguiente dibujo.

 14. Repita los pasos anteriores para cada dibujo.
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Capítulo 7: Aplicación de morphing a dibujos

La animación dibujada a mano requiere que pase mucho tiempo trazando dibujos intercalados. La función de 

morphing de Harmony puede ayudar a acelerar el proceso. Esta útil función crea automáticamente dibujos 

generados por ordenador entre los dibujos de vectores para ahorrar tiempo y aumentar la productividad. 

Puede modificar fácilmente el tiempo y la velocidad (aceleración y desaceleración gradual) de una animación 

de morphing.

Uno de los principales usos de la función de morphing es la animación de efectos. Por ejemplo, la animación 

de humo o agua puede llevar mucho tiempo, ya que estos tipos de efectos suelen ser de movimiento lento, lo 

que requiere un gran número de intercalados estrechamente conectados.

La función de morphing se util iza para animar formas similares y simples, como pelo o humo. De este modo, 

podrá ahorrar tiempo durante tareas de intercalado y trazado pesadas. A su vez, le proporciona más tiempo 

para emplearlo en tareas complejas de animación, como ciclos de andar o secuencias acrobáticas.

Para aprender a aplicar morphing a dibujos, es mejor comenzar con formas básicas, como círculos y 

rectángulos. Una vez que esté más familiarizado con la herramienta, puede aumentar sus conocimientos y 

experiencia. En muy poco tiempo, producirá algunos efectos notables.

Es útil conocer los pros y los contras del morphing antes de comenzar. Si sabe lo que puede hacer y qué líneas 

de dibujo pueden ser más útiles o problemáticas, podrá diseñar dibujos clave para aplicar el morphing de 

forma eficiente.

NOTA 

Cuanto más compleja es la forma, más tarda en aplicarse el morphing. Si necesita más tiempo para 

transformar un dibujo que para dibujarlo a mano, es mejor animarlo en lugar de aplicar la técnica 

de morphing. Sin embargo, si encuentra una ocasión en la que pueda aplicar morphing a los 

dibujos, hágalo. Permite fijar el tiempo y la velocidad rápidamente sin la necesidad de crear dibujos 

adicionales.

75

Guía de introducción de Harmony 22 Advanced                          



Capítulo 7: Aplicación de morphing a dibujos

Creación de un elemento de morphing básico

 1. En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Drawing Layer 

(Agregar capa de dibujo) para agregar una nueva capa al proyecto.

 2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

 3. En la vista de línea de tiempo o de carta de rodaje, seleccione la primera celda de la capa.

 4. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta Rectangle 

(Rectángulo) .

 l Pulse Alt + 7.

 5. En la vista de cámara o de dibujo, dibuje un rectángulo.

NOTA 

Al dibujar un rectángulo o una elipsis, puede mantener pulsada la tecla Mayús 

para dibujar su forma con las mismas dimensiones, así como para hacer un 

cuadrado o un círculo en su lugar. También puede mantener pulsada la tecla Alt 

para dibujar la forma desde su centro y no desde su esquina.

 6. Pinte el rectángulo con la herramienta Paint (Pintar).

 7. En la vista de carta de rodaje o de línea de tiempo, seleccione la celda en la que desea que termine 

la secuencia de morphing.
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 8. Realice una de las siguientes acciones:

 l En la barra de herramientas de herramientas, seleccione la herramienta Ellipse 

(Elipse) .

 l Pulse Alt + =.

 9. Dibuje y pinte la elipse con el mismo contorno y colores de relleno que en el rectángulo.

 10. En la vista de carta de rodaje o de línea de tiempo, seleccione el rango de fotogramas que va desde 

el primer dibujo hasta el segundo dibujo, incluidos los fotogramas que contienen los mismos.

 11. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Animation > Morphing > Create Morphing 

(Animación > Morphing > Crear morphing).

 l En la vista de carta de rodaje o de línea de tiempo, haga clic con el botón derecho y 

seleccione Morphing > Create Morphing (Morphing > Crear Morphing).

 l Pulse Alt + M.

Aparecen las flechas que van desde el primer dibujo clave hasta el segundo dibujo clave, que 

indican que se han creado los intercalados generados por ordenador.
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Ajuste de la velocidad de morphing

Si observa la animación, notará que el movimiento de morphing es constante. Para producir un movimiento 

menos mecánico, es probable que desee crear alguna aceleración o desaceleración gradual.

Adición de aceleración y desaceleración gradual a un elemento de morphing

 1. En la barra de herramientas de herramientas, seleccione la herramienta Morphing  o pulse F3.

 2. En la vista de línea de tiempo, haga clic en un fotograma de la secuencia de morphing que desee 

ajustar.

 3. En la vista de propiedades de la herramienta, aumente o reduzca el valor de Ease In (Aceleración 

gradual) y Ease Out (Desaceleración gradual) para ajustar la velocidad de la secuencia.

Adición de sugerencias de morphing

La herramienta Morphing de Harmony permite controlar su secuencia de morphing de muchas maneras. Una 

de esas maneras es colocar sugerencias para asegurarse de que Harmony transforme los dibujos de la manera 

que tenía prevista.

Las sugerencias son puntos que se colocan en los dibujos de origen y de destino para asociar zonas y líneas 

entre los dos dibujos. Se util izan para corregir errores de las transformaciones de dibujos que realiza Harmony, 

como una línea que no sigue la zona de relleno de color o cuando una parte del dibujo de origen no se 

transforma en su parte correspondiente del dibujo de destino. De forma predeterminada, Harmony asociará 
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una esquina o un punto en el dibujo de origen con la esquina o punto más cercanos del dibujo de destino. Por 

lo tanto, las sugerencias son necesarias si la forma que se va a transformar o su movimiento son complejos.

Adición de sugerencias

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo de origen de la secuencia de 

morphing.

 2. En la barra de herramientas de herramientas, seleccione la herramienta  Morphing o pulse F3.

Utilice como referencia el otro dibujo clave de morphing, mostrado en la esquina inferior derecha de 

la vista de dibujo.

 3. En la vista de propiedades de la herramienta, seleccione el tipo de sugerencia que desea util izar.

 l Seleccione Contour Hint (Sugerencia de contorno) para corregir el contorno de una 

línea de pincel o de una zona de color (vector de contorno).

Los puntos de Contour Hint (Sugerencia de contorno) se comportarán de manera 

similar a los puntos de Pencil Hint (Sugerencia de lápiz) cuando se util icen en una 

línea de lápiz. Tenga en cuenta que obtiene mejores resultados util izando el punto de 

Pencil Hint (Sugerencia de lápiz) en la línea de lápiz en lugar de los puntos de 

Contour Hint (Sugerencia de contorno).

 l Seleccione Pencil Hint (Sugerencia de lápiz) para corregir una línea de lápiz (vector 

central).
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 l Seleccione Zone Hint (Sugerencia de zona) para corregir una coincidencia de 

morphing de zona de color.

 l Seleccione Vanishing Point Hint (Sugerencia de punto de desaparición) para corregir 

la trayectoria de una forma de desaparición.

 l Seleccione Appearing Point Hint (Sugerencia de punto de aparición) para corregir la 

trayectoria de una forma de aparición.

 4. En la vista de cámara o de dibujo, haga clic en el dibujo situado junto al área problemática.

 5. Seleccione el punto de la sugerencia y muévalo a su posición correcta.

 6. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo de destino.

 7. Busque y mueva el punto de la sugerencia correspondiente a la parte coincidente del dibujo de 

destino.
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 8. En la barra de herramientas de reproducción, pulse el botón  Play (Reproducir) para ver el 

resultado.

81

Guía de introducción de Harmony 22 Advanced                          



Capítulo 8: Importación de imágenes

Capítulo 8: Importación de imágenes

De forma predeterminada, Harmony trabaja con imágenes de vectores creadas dentro de su propia interfaz. 

Las imágenes de vectores se componen principalmente de información sobre las distintas formas que 

componen las imágenes, así como de sus colores de línea y de relleno. Esto hace que sean fáciles de editar y 

pintar, y permite redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imágenes de 

mapa de bits se componen de información de color sobre cada píxel individual que compone la imagen. Por lo 

tanto, son más adecuados para imágenes muy detalladas o realistas, pero no se pueden escalar sin perder 

calidad de imagen, ni se pueden editar tan fácilmente como las imágenes de vectores.

Normalmente, es necesario trabajar con imágenes de mapa de bits si debe crear algunos de los recursos de 

escena, como fondos o props, en un software diferente. A continuación, puede importar los archivos de 

imágenes de mapa de bits en su escena de Harmony.

Al importar una imagen de mapa de bits, debe decidir cómo debe procesarla Harmony. Puede elegir entre las 

siguientes opciones:

 l Keep as Original Bitmap (Mantener como mapa de bits original): importa la imagen exactamente tal 

como está y garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opción es útil 

para util izar fondos creados en el proyecto con un software diferente.

 l Import as Toon Boom Bitmap Drawing (Importar como dibujo de mapa de bits de Toon Boom): 

importa la imagen tal como está, pero permite editarla con las herramientas de dibujo de mapa de bits 

de Harmony.

 l Import as Toon Boom Vector Drawing (Importar como dibujo vectorial de Toon Boom): convierte un 

mapa de bits en un dibujo vectorial de Toon Boom que se puede pintar y editar fácilmente con las 

herramientas de dibujo vectorial de Harmony. Esta opción puede ser útil para la importación de capa de 

líneas escaneadas o creadas con un software diferente.

Importación de una imagen de mapa de bits en su formato original

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 

Imágenes).

 l En la barra de herramientas de archivo, haga clic en el botón  Import Images 

(Importar imágenes).

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 

área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).
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 2. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic 

en Browse (Examinar) para buscar y seleccionar una o más imágenes en el ordenador.

 3. Agregue la imagen de mapa de bits a una nueva capa seleccionando la opción Create Layer(s) 

(Crear capas) y una de las siguientes opciones:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 

con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames  (Crear capas basadas en nombres de archivo): 

Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 

importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 

denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 

imágenes, mientras que la "b" contendrá la tercera. 

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 

capa especificada. Tenga en cuenta que solo puede importar en las capas que son 

compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 

como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 4. En la sección Vectorization (Vectorización), asegúrese de que la opción Vectorize Image (Vectorizar 

imagen) no esté marcada.

 5. En la sección Import Options (Opciones de importación), seleccione la opción Keep As Original 

Bitmap (Mantener como mapa de bits original).

 6. En la sección Alignment (Alineación), decida el tamaño y la posición de la imagen dentro del 

encuadre de cámara. Puede elegir entre las siguientes opciones:
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Parámetro Descripción

Fit (Ajustar)

Ajusta el tamaño de la imagen para que se adapte completamente al 

campo de la escena, tanto vertical como horizontalmente, asegurándose 

de que toda la imagen sea visible.

Si la orientación de la imagen es vertical, ajustará la altura de la imagen 

para que se adapte a la altura del campo sin que afecte a la proporción de 

la imagen:

Si la orientación de la imagen es horizontal, ajustará el ancho de la imagen 

para que se adapte al ancho del campo sin que afecte a la proporción de la 

imagen:

Pan (Panear)

Esto tiene el efecto opuesto al parámetro de ajuste. La dimensión más 

pequeña de la imagen se ajustará a la dimensión coincidente del 

fotograma de la escena, y la dimensión más grande de la imagen se 

ajustará proporcionalmente, haciendo que la imagen llene todo el campo 

de la escena y abarque más allá de sus límites si su proporción no coincide 

con la proporción del campo. Esta opción se puede util izar para importar 
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una imagen de fondo de paneo, también denominada paneo.

Si la orientación de la imagen es vertical, ajustará el ancho de la imagen 

para que se adapte al ancho del campo sin que afecte a su proporción:

Si la orientación de la imagen es horizontal, ajustará la altura de la imagen 

para que se adapte a la altura del campo sin que afecte a su proporción:

Project 

Resolution 

(Resolución de 

proyecto)

Escala la imagen para que se ajuste a la resolución de la escena, haciendo 

que cada píxel de la imagen tome un píxel del campo de la escena. Por 

ejemplo, si las dimensiones de la imagen en píxeles son la mitad de la 

resolución de la escena en píxeles, las dimensiones de la imagen 

parecerán ser la mitad de las dimensiones del campo de la escena.

 7. Si la imagen tiene transparencia, en la sección Transparency (Transparencia), seleccione cómo se 

premultiplicaron los valores de color en los píxeles semitransparentes de la imagen con sus valores 

de alfa. Esto permite que Harmony demultiplique los valores para poder combinar correctamente la 

imagen con los otros elementos de la escena.

Puede elegir entre las siguientes opciones:
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Parámetro Descripción

Premultiplied w ith W hite 

(Premultiplicado con blanco)

Los valores de color de los píxeles semitransparentes de la 

imagen se han codificado de modo que cuanto más 

transparentes sean, más cercanos al blanco estarán. Cuando 

se carga una imagen premultiplicada con blanco en un 

software que no admite transparencia, aparece combinada 

con un fondo blanco. Seleccione esta opción para hacer que 

Harmony revierta esta premultiplicación de modo que la 

imagen se combine correctamente con otros elementos 

visuales de la escena.

Premultiplied w ith Black 

(Premultiplicado con negro)

Los valores de color de los píxeles semitransparentes de la 

imagen se han codificado de modo que cuanto más 

transparentes sean, más cercanos al negro estarán. Cuando 

se carga una imagen premultiplicada con negro en un 

software que no admite transparencia, aparece combinada 

con un fondo negro. Seleccione esta opción para hacer que 

Harmony revierta esta premultiplicación de modo que la 

imagen se combine correctamente con otros elementos 

visuales de la escena.

Straight (Recto)

El color de los píxeles semitransparentes en la imagen se 

codifica independientemente de su transparencia. Cuando se 

carga una imagen que no está premultiplicada en un software 

que no admite transparencia, los píxeles semitransparentes 

simplemente aparecen completamente opacos, lo cual hace 

que sus bordes parezcan pixelados.

Clamp Colour to Alpha (Fijar 

color a alfa)

Es lo mismo que Premultiplied with Black (Premultiplicado 

con negro), salvo que también evita que los valores de color 

de un píxel dado sean más altos que el valor de alfa de dicho 

píxel. Esta opción solo es útil si está trabajando con imágenes 

que se supone que se deben premultiplicar con negro, pero 

donde los valores de color de los píxeles se han incrementado 

sin que sus valores de alfa se hayan ajustado en 

consecuencia.
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CONSEJO 

El tipo de transparencia para una imagen puede depender del software que se 

util ice para crearla. Por ejemplo, las imágenes exportadas por Harmony en 

cualquier formato que no sea PNG suelen ser Premultiplied with Black 

(Premultiplicado con negro), mientras que las imágenes PNG exportadas por 

Harmony util izan el tipo de transparencia Straight (Directo).

Los siguientes son modos de transparencia que suele util izar otro software para 

tipos de archivos específicos:

 l Gráficos de red portátiles (.png): Straight (Directo)

 l Documento de Photoshop (.psd, .psb):

 l Importado como una sola imagen: Premultiplied w ith W hite 

(Premultiplicado con blanco)

 l Importado como capas separadas: Straight (Directo)

 l Formato de archivo de imagen etiquetada (.tif): Premultiplied w ith Black 

(Premultiplicado con negro)

 l Truevision TARGA (.tga): Straight (Directo)

 l Imagen de Silicon Graphics (.sgi): Straight (Directo)

 8. Haga clic en OK (Aceptar).

NOTA 

De forma predeterminada, las imágenes de mapa de bits se mostrarán en baja resolución en la 

vista de cámara para evitar que afecten al rendimiento de la reproducción. También puede 

ajustar la calidad de visualización de una imagen de mapa de bits seleccionándola con la 

herramienta Transform (Transformar) y, a continuación, abriendo el cuadro de diálogo Bitmap 

Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality 

(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa 

de bits en la resolución de la escena activando el modo  Render Preview (Vista de render) 

en la vista de cámara.

Vectorización de imágenes

Harmony permite importar imágenes como dibujos de vectores. Los dibujos de vectores se pueden pintar y 

editar fácilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser útil para la 

importación de capa de líneas escaneadas o creadas con un software diferente, ya que luego puede pintarla en 

Harmony.
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Importación de una imagen de mapa de bits como un dibujo de mapa de bits de Toon 
Boom

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 

Imágenes).

 l En la barra de herramientas de archivo, haga clic en el botón  Import Images 

(Importar imágenes).

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 

área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).

 1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic 

en Browse (Examinar) para seleccionar una o más imágenes del ordenador.

 2. Seleccione el destino de las imágenes:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 

con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames  (Crear capas basadas en nombres de archivo): 

Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 

importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 
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denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 

imágenes, mientras que la "b" contendrá la tercera. 

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 

capa especificada. Tenga en cuenta que solo puede importar en las capas que son 

compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 

como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 2. En la sección Alignment (Alineación), decida el tamaño y la posición de la imagen dentro del 

encuadre de la cámara. Puede elegir entre las siguientes opciones:

Parámetro Descripción

Vertical Fit 

(Ajuste vertical)

Ajusta el tamaño de la imagen para que su altura coincida con la altura de 

la escena, sin que afecte a su proporción.

Horizontal Fit 

(Ajuste 

horizontal)

Ajusta el tamaño de la imagen para que su ancho coincida con el de la 

escena sin que afecte a su proporción.
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Actual Size 

(Tamaño real)

Importa la imagen a tamaño real sin ajustar su tamaño en proporción a la 

resolución de la escena. Por ejemplo, si las dimensiones de la imagen en 

píxeles son la mitad de la resolución de la escena en píxeles, las 

dimensiones de la imagen parecerán ser la mitad de las dimensiones del 

campo de la escena.

 3. Si la imagen tiene transparencia, en la sección Transparency (Transparencia), seleccione cómo se 

premultiplicaron los valores de color en los píxeles semitransparentes de la imagen con sus valores 

de alfa. Esto permite que Harmony demultiplique los valores para poder combinar correctamente la 

imagen con los otros elementos de la escena.

Puede elegir entre las siguientes opciones:

Parámetro Descripción

Premultiplied w ith W hite 

(Premultiplicado con blanco)

Los valores de color de los píxeles semitransparentes de la 

imagen se han codificado de modo que cuanto más 

transparentes sean, más cercanos al blanco estarán. Cuando 

se carga una imagen premultiplicada con blanco en un 

software que no admite transparencia, aparece combinada 

con un fondo blanco. Seleccione esta opción para hacer que 

Harmony revierta esta premultiplicación de modo que la 

imagen se combine correctamente con otros elementos 

visuales de la escena.

Premultiplied w ith Black 

(Premultiplicado con negro)

Los valores de color de los píxeles semitransparentes de la 

imagen se han codificado de modo que cuanto más 
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transparentes sean, más cercanos al negro estarán. Cuando 

se carga una imagen premultiplicada con negro en un 

software que no admite transparencia, aparece combinada 

con un fondo negro. Seleccione esta opción para hacer que 

Harmony revierta esta premultiplicación de modo que la 

imagen se combine correctamente con otros elementos 

visuales de la escena.

Straight (Recto)

El color de los píxeles semitransparentes en la imagen se 

codifica independientemente de su transparencia. Cuando se 

carga una imagen que no está premultiplicada en un software 

que no admite transparencia, los píxeles semitransparentes 

simplemente aparecen completamente opacos, lo cual hace 

que sus bordes parezcan pixelados.

 4. Haga clic en OK (Aceptar).

Importación y vectorización de una imagen de mapa de bits

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 

Imágenes).

 l En la barra de herramientas de archivo, haga clic en el botón  Import Images 

(Importar imágenes).

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 

área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).
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 1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic 

en Browse (Examinar) para seleccionar una o más imágenes del ordenador.

 2. Seleccione el destino de las imágenes:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 

con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames  (Crear capas basadas en nombres de archivo): 

Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 

importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 

denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 

imágenes, mientras que la "b" contendrá la tercera. 

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 

capa especificada. Tenga en cuenta que solo puede importar en las capas que son 

compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 

como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 3. En la sección Import Options (Opciones de importación), seleccione la opción Convert to Toon 

Boom Vector Drawing (Convertir a dibujo de vector de Toon Boom).

 4. En la sección Vectorization (Vectorización), decida si desea importar la imagen en blanco y negro, o 

en grises. También puede hacer clic en el botón  New Preset (Nuevo valor predef.) para crear un 

parámetro de vectorización personalizado.
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 l Black and W hite (Blanco y negro): vectoriza los dibujos como una línea negra sólida; crea un 

dibujo 100 % basado en vectores. Los contornos de los dibujos se pintarán con la muestra 

de color de la línea vectorizada de la paleta de colores de la escena.

 l Grey (Gris): vectoriza la imagen como una mezcla de contorno de vectores y relleno de mapa 

de bits en escala de grises. Las líneas conservan la textura de la digitalización, y el blanco 

del papel pasa a ser transparente.

NOTA 

Puede hacer doble clic en los valores predefinidos en cualquier momento para abrir el cuadro 

de diálogo Vectorization Parameters (Parámetros de vectorización) para personalizar su 

opción.

 5. Haga clic en OK (Aceptar).

Las imágenes vectorizadas aparecerán en los destinos seleccionados.

NOTA 

Si tiene imágenes de mapa de bits en la librería, puede arrastrarlas y colocarlas directamente en la 

escena como una manera rápida de importar una imagen de mapa de bits. Sin embargo, no tendrá 

acceso a todas las opciones de importación.
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Capítulo 9: Colocación y animación de capas

La configuración de una escena se puede comparar con la construcción de la escenografía para un programa 

de televisión. Este es el punto en el que coloca el elemento de escena, como el encuadre de cámara, los 

elementos de fondo y los personajes.

Colocación de capas

El primer paso para configurar la escena es colocar cada capa en su posición, ángulo y tamaño iniciales. Puede 

realizar cualquier tipo de transformación geométrica en una capa con la herramienta  Transform 

(Transformar).

Paneo, rotación, escala o sesgo de una capa con la herramienta Transform 
(Transformar)

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar) o pulse Mayús + T.

 2. En la barra de herramientas de herramientas, si está habilitado el modo  Animate Current Frame 

(Animar fotograma actual) o  Animate Onion Skin Range (Animar intervalo de papel cebolla), 

haga clic en él para abrir el menú emergente Animate (Animar) y seleccione  Animate Off 

(Animar desactivado).

 3. En la vista de propiedades de la herramienta, asegúrese de que la opción  Peg Selection Mode 

(Modo de selección de peg) está deshabilitada.

 4. En la vista de cámara o de línea de tiempo, haga clic en la capa que desea manipular para 

seleccionarla.

CONSEJOS 

 l Si desea seleccionar varias capas en la vista de cámara, mantenga pulsado Mayús y 

haga clic en cada capa que desee seleccionar.

 l Si desea seleccionar varias capas en la vista de línea de tiempo, mantenga pulsado 

Ctrl (W indows/Linux) o ⌘  (macOS) y haga clic en cada capa que desee seleccionar.

 l Si desea seleccionar una serie contigua de capas en la vista de línea de tiempo, 

mantenga pulsado Mayús, haga clic en la primera capa que desea seleccionar y 

luego en la última.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

 1. Realice una de las siguientes acciones:

 l Mover: mueva el cursor por la ilustración. Cuando el cursor se convierta en , haga clic y 

arrástrelo sobre la ilustración para moverla.

 l Rotar: coloque el puntero fuera de una esquina del cuadro de límite. Cuando el cursor se 

convierta en , haga clic y arrástrelo para rotar.

 l Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del 

manipulador. Cuando el cursor se convierta en , haga clic y arrastre para escalar la capa. 
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NOTA 

Al realizar el escalado de la selección, puede mantener pulsado Mayús para 

mantener las proporciones entre el ancho y la altura.

 l Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el 

cursor se convierta en , haga clic y arrastre hacia arriba o hacia abajo para sesgar la capa 

en vertical. 

 l Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el 

cursor se convierta en , haga clic y arrastre hacia la izquierda o hacia la derecha para 

sesgar la capa en horizontal. 

Cambio de posición del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotación, escala, sesgo y volteo, se 

realizan de forma relativa a la posición del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta 
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rotará alrededor de su punto de pivote, y al escalar la capa, se escalará como si su centro fuera realmente su 

punto de pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el 

pivote de la selección. Sin embargo, esto no tiene un efecto permanente. Solo cambiará temporalmente la 

posición del pivote para que le ayude a realizar transformaciones en el fotograma seleccionado, pero el punto 

de pivote real de la capa de dibujo permanecerá igual.

Puede cambiar de forma permanente la posición del punto de pivote de una capa util izando una de las 

herramientas de la barra de herramientas de animación avanzada.

NOTA 

Al mover de forma permanente el punto de pivote de una capa que ya está animada, todas las 

transformaciones realizadas en la capa en otros fotogramas clave se volverán a calcular de 

acuerdo con la posición del nuevo punto de pivote. Por lo tanto, la animación existente tendrá una 

apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que 

siempre se asegure de que el punto de pivote se encuentre en la posición idónea antes de 

comenzar la animación.

Cambio de posición permanente del punto de pivote de una capa

 1. En la barra de herramientas de animación avanzada, seleccione la herramienta  Translate 

(Traslación),  Rotate (Rotar),  Scale (Escalar) o  Skew (Sesgar).

 2. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, seleccione la capa a la que desee mover el pivote. 

 l En la vista de cámara, util ice Ctrl + clic (W indows/Linux) o ⌘  + clic (macOS) en la capa para 

la que desea mover el pivote.

El punto de pivote  aparece en la vista de cámara.

 3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratón se convierta en , haga clic y 

arrástrelo al punto de pivote para cambiar de posición.
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El punto de pivote de la capa ha cambiado de posición. Si la capa se ha animado, su posición se 

desplazará por las escenas de forma relativa a la cantidad que acaba de desplazar el punto de 

pivote.

Animación de una capa

Puede animar una capa colocándola en diferentes posiciones, ángulos y tamaños en distintos puntos a lo largo 

de la línea de tiempo de la escena. Para ello, puede crear fotogramas clave de animación en la capa. Un 

fotograma clave registra las transformaciones geométricas en una capa en un punto específico en el tiempo. 

Cuando dos fotogramas clave de animación se encuentren en una capa en diferentes puntos de la línea de 

tiempo de la escena, Harmony interpolará automáticamente la posición, el ángulo y el tamaño de la capa en 

cada fotograma entre esos dos fotogramas clave, creando una animación.

Animación de una capa

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar) o pulse Mayús + T.

 2. En la barra de herramientas de herramientas, si está seleccionado el modo  Animate Off (Animar 

desactivado) o  Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él 

para abrir el menú emergente Animate (Animar) y seleccione  Animate Current Frame (Animar 

fotograma actual).
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 3. Si la capa tiene un peg padre:

 l Si desea animar en el peg en lugar de en la capa, asegúrese de que el modo  Peg 

Selection (Selección de peg) esté habilitado en la vista de propiedades de la herramienta.

 l Si desea animar directamente en la capa, asegúrese de que el modo  Peg Selection 

(Selección de peg) esté deshabilitado en la vista de propiedades de la herramienta.

 4. En la vista de línea de tiempo, vaya al primer fotograma.

 5. En el menú superior, seleccione Animation (Animación) y asegúrese de que la opción Stop-Motion 

Keyframe (Fotograma clave de Stop-motion) no está marcada. De este modo, Harmony creará la 

animación automáticamente entre los fotogramas clave de la animación que cree.

 6. Seleccione la celda donde desee crear el primer fotograma clave.

 7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de línea de tiempo.

 8. En la vista de cámara, seleccione el elemento que desea animar y muévalo, rótelo, escálelo o 

sésguelo de modo que esté en su posición de inicio correcta.
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 9. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer la segunda posición.

 10. Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botón derecho en la 

selección y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en la lista de línea de tiempo, junto con una línea desde el 

primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se 

animará mediante Harmony.

 11. En la vista de cámara, mueva, rote, escale o sesgue el elemento de modo que esté en su segunda 

posición correcta.

 12. En la vista de línea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la 

animación.

 13. En la barra de herramientas de reproducción, haga clic en el botón  Play (Reproducir) para 

obtener una vista previa de la animación.
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NOTA 

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones 

desde las vistas superior, lateral o de perspectiva durante la reproducción. Sin embargo, la 

reproducción está deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en 

el menú superior seleccione Play > Enable Playback > Top View (Reproducir > Activar 

reproducción > Vista superior), Side View (Vista lateral) o Perspective View (Vista de 

perspectiva).
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Capítulo 10: Colocación y animación de la cámara

En Harmony, puede animar objetos dibujándolos en su capa individual y colocándolos a continuación en 

distintas ubicaciones en diferentes fotogramas clave a través de la línea de tiempo para crear una ruta de 

movimiento. Se puede aplicar el mismo principio a la cámara de la escena, ya que se trata de una capa.

Adición de una cámara

De forma predeterminada, una escena no tiene capa de cámara. Para poder ajustar el ángulo de la cámara y la 

posición de la escena, debe agregar una a su escena.

Adición de una cámara 

 1. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic en el botón  Add Layer (Agregar capa) del 

menú emergente y seleccione Camera (Cámara).

 l En el menú superior, seleccione Insert > Camera (Insertar > Cámara).

Se agrega a la escena una nueva capa de cámara y aparece en la vista de línea de tiempo.

Aunque es posible tener varias cámaras en la misma escena, solo puede ver su escena util izando las cámaras 

de una en una. Esto puede resultar útil si aún está trabajando en la composición de escena y tiene distintas 

configuraciones de cámara para probar.

Cambio entre cámaras

 1. En el menú superior, seleccione Scene > Camera (Escena > Cámara).

 2. Entre las cámaras de la lista, seleccione la cámara con la que desea trabajar.

Adición de un peg padre

Aunque es posible colocar una cámara sin necesidad de usar un rigging debajo de un peg, se recomienda 

hacerlo siempre por dos motivos:

 l Permite colocar, rotar y alejar o acercar la cámara con la herramienta Transform (Transformar).

 l Permite animar los movimientos de la cámara. Sin un peg padre, la posición, el ángulo y el zoom de la 

cámara son estáticos.
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Adición de un peg padre a una cámara

 1. En la vista de línea de tiempo, seleccione la capa de cámara.

.

 2. En la barra de herramientas de capas, haga clic en el botón  Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de cámara y se conecta a ella 

automáticamente.

Colocación de la cámara

La acción de la escena tiene lugar dentro del encuadre de cámara, de modo que es muy importante 

configurarlo correctamente. Puede ajustar la resolución de la cámara y otros parámetros relacionados en la 

ventana Scene Settings (Configuración de escena), a la que se puede acceder desde el menú principal de 

Scene (Escena).

Para cambiar la posición de la cámara directamente, puede moverla con la herramienta  Transform 

(Transformar) o  Translate (Traslación), puede rotarla con la herramienta  Rotate (Rotar) y puede alejarla 

o acercarla con la herramienta  Scale (Escalar) de la barra de herramientas de animación avanzada. 

También puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha usado un rig 
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de cámara debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta Transform 

(Transformar). Los siguientes pasos indican cómo manipular la cámara al usar un rig debajo de un peg.

Colocación de una cámara en la que se ha usado un rig debajo de un peg en la vista de 
cámara

 1. Realice una de las siguientes acciones para seleccionar el peg padre de la cámara.

 l En la vista de línea de tiempo, haga clic en la capa del peg padre de la cámara.

 l En la vista de cámara, haga clic en el encuadre de la cámara. El encuadre de la cámara es un 

rectángulo fino alrededor de la etapa de la escena. 

Aparece un cuadro de control alrededor del encuadre de la cámara.

 2. Realice una de las siguientes acciones:

 l Mover el encuadre de la cámara: coloque el cursor sobre cualquiera de sus bordes o sobre 

el centro. Cuando el cursor cambie a , haga clic y arrástrelo en el encuadre de la cámara 

para cambiarlo de posición.
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 l Acercar o alejar: coloque el cursor en una de las esquinas del encuadre de la cámara. 

Cuando el cursor cambie a , haga clic y arrástrelo a la esquina para cambiar el tamaño del 

encuadre de la cámara. Al contraer el encuadre de la cámara se acercará la escena, y al 

expandirlo, se alejará. 

 l Rotar la cámara: coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a 
, haga clic y arrástrelo para rotar el encuadre de la cámara.

Animación de la cámara

La cámara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de 

línea de tiempo y puede util izar las mismas herramientas y modos de selección para compensarla o animarla. 

Sin embargo, la capa de la cámara en sí es estática, lo que significa que mantiene la misma posición y ángulo 

en toda la escena. Para poder animar la cámara, es necesario conectarla a una capa de peg, que se puede 

animar, y que afectará directamente a la posición y al ángulo de la cámara.

Puede animar los movimientos de la cámara directamente en la vista de cámara.
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Animación de la cámara

 1. En la barra de herramientas de herramientas, si está seleccionado el modo  Animate Off (Animar 

desactivado) o  Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él 

para abrir el menú emergente Animate (Animar) y seleccione  Animate Current Frame (Animar 

fotograma actual).

 2. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar) o pulse Mayús + T.

 3. En el lado derecho de la vista de línea de tiempo, en la capa de peg de cámara, seleccione el 

fotograma en el que desee que comience el movimiento de cámara.

 4. Realice una de las siguientes acciones para agregar un fotograma clave:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave 

mantendrán la misma posición de cámara que este fotograma clave.

 5. En la vista de cámara, manipule la cámara para que esté en la posición correcta cuando la cámara 

comience a moverse.
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 6. En la vista de línea de tiempo, haga clic en la celda en la que terminará el movimiento de cámara.

 7. Realice una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Aparece un fotograma clave en dicha celda.

 8. En la vista de cámara, manipule la cámara para que esté en la posición correcta cuando la cámara 

termine de moverse.

 9. En la vista de línea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la 

animación.
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 10. En la barra de herramientas de reproducción, haga clic en el botón  Play (Reproducir) para 

obtener una vista previa de la animación.
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Capítulo 11: Creación de un rig de un personaje cut-out

En Harmony, un rig de personaje es básicamente una plantil la basada en el modelo del personaje, pero en la 

cual todas las partes móviles están divididas en distintas capas y ordenadas en una jerarquía que facilita la 

animación digital, también conocida como animación cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del 

que partir. Si tiene un dibujo de un personaje disponible, impórtelo en una nueva escena y, a continuación, 

ajuste la escala y colóquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en 

Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig 

con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta sección, aprenderá uno de los 

métodos más comunes y sencillos. Para la primera descomposición de personaje, siga estas instrucciones para 

hacerse una idea de cómo funciona Harmony. Una vez que conozca las funciones y comandos básicos de 

Harmony, podrá crear sus propias técnicas para cumplir las necesidades de su producción.

Dibujo de las piezas

La técnica de descomposición principal que se muestra es el trazado del modelo.

Descomposición de un personaje mediante trazado

 1. En la vista de línea de tiempo, agregue una nueva capa de dibujo para cada parte del cuerpo que 

desee separar. Puede pulsar Ctrl + R (W indows/Linux) o ⌘  + R (macOS) para agregar nuevas 

capas de dibujo.
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 2. En la vista de línea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la 

parte.

 3. En la barra de herramientas de herramientas, seleccione la herramienta de dibujo que desee. 

Existen dos métodos que se suelen util izar para dibujar las partes de un modelo de personaje cut-

out:

 l Utilizar la herramienta  Pencil (Lápiz) y suavizar las líneas con la herramienta  

Smooth Editor (Editor suave).

 l Utilizar la herramienta  Polyline (Polilínea). Este método permite dibujar con gran 

precisión, pero puede llevar más tiempo.

Estos métodos garantizan que cada parte se realice con el menor número de puntos posible, para 

que sean fáciles de manipular, modificar o volver a dibujar.

 4. En la vista de color, seleccione una muestra de color. Si todavía no ha creado ninguna paleta para el 

personaje, consulte Cómo pintar en la página 57.

 5. Si prefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las 

demás capas con colores descoloridos:

 l En la barra de herramientas de la vista de dibujo, haga clic en el botón  Light Table 

(Mesa de luz).

 l Pulse Mayús + L.

 6. En la vista de cámara o de dibujo, dibuje la nueva parte.
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 7. Si desea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una línea visible con 

la herramienta  Stroke (Línea vectorial transparente).

NOTA 

De forma predeterminada, las líneas vectoriales transparentes creadas con la 

herramienta Stroke (Línea vectorial transparente) no son visibles. Para ver las líneas 

vectoriales transparentes en el dibujo, seleccione View > Show > Show Strokes (Ver > 

Mostrar > Mostrar líneas vectoriales transparentes) en el menú superior o pulse K.

 8. En la barra de herramientas de herramientas, seleccione la herramienta  Paint (Pintar) o pulse 
 Paint Unpainted (Pintar área no pintada) para colorear el dibujo.

 9. En la vista de color, cree el color de relleno deseado si no se encuentra todavía en la paleta y, a 

continuación, selecciónelo.

 10. En la vista de cámara o de dibujo, pinte el dibujo.

111

Guía de introducción de Harmony 22 Advanced                          



Capítulo 11: Creación de un rig de un personaje cut-out

 11. En la barra de herramientas de herramientas, seleccione la herramienta  Select (Seleccionar). 

Seleccione el dibujo y acople las líneas haciendo clic en el botón  Flatten (Acoplar) de la vista de 

propiedades de la herramienta.

 12. Si las líneas están compuestas por varios trazos de lápiz, puede que desee combinarlas en una 

única línea de lápiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las líneas de 

lápiz que se deben combinar y, en la vista de propiedades de la herramienta, haga clic en el botón 
 Merge Pencil Lines (Combinar líneas de lápiz).

 13. Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.
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Adición de pegs

Los pegs son un tipo especial de capa que no contiene ningún dibujo. Solo se util izan para compensar y 

transformar dibujos que estén debajo de su jerarquía, sin transformar directamente los dibujos.

Al crear un rigging o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo. 

De este modo, se permite mantener los fotogramas clave y los dibujos de animación en capas separadas, lo 

que facilita el trabajo sobre la posición y exposición de las capas de dibujo por separado en la vista de línea de 

tiempo. También facilita la creación de una jerarquía de las partes del cuerpo que se pueden animar juntas y 

por separado.
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Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Selección de peg) de la herramienta 

Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas 

de dibujo de animación para que solo se puedan animar los pegs.

NOTA 

También es posible hacer que una capa de dibujo sea padre de otra capa de dibujo. Al igual que la 

forma de animación de un peg anima sus capas hijas, la animación de una capa de dibujo con hijos 

también animará sus capas hijas. Ambas capas seguirán apareciendo en la animación.

Cómo emparentar pegs a las capas en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione todas las capas.

 2. En la barra de herramientas de capa de línea de tiempo, haga clic en el botón  Add Peg (Agregar 

peg) para agregar un peg padre a todas las capas seleccionadas.

Creación de una jerarquía de capas

Harmony permite crear el rig en una jerarquía elaborada, lo que permite a su vez establecer qué partes del rig 

deben influir en otros miembros y cómo pueden moverse de forma independiente. Por ejemplo, al crear un 

rigging del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo, 

114



y que la capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el 

antebrazo, la mano también lo hará, y si mueve el brazo, el antebrazo y la mano también lo harán.

Al crear un rig de personaje básico, debe tener al menos una jerarquía para cada brazo y cada pierna. Puede 

crear una jerarquía que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de 

las piernas a las caderas. Esto crearía una jerarquía como esta:

Creación de una jerarquía en la vista de línea de tiempo

 1. En el área izquierda de la vista de línea de tiempo, seleccione la capa que desee que sea la capa 

hija.

 2. Arrastre el hijo y colóquelo sobre la capa que desee que sea la capa padre. Asegúrese de no 

colocar la capa hija entre dos capas.
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 3. Repita el proceso hasta que haya creado una jerarquía que manipule todas las partes del personaje, 

con un peg maestro en la raíz. Al crear un rig, si desea que varias capas tengan un padre común, 

pero ninguna de las partes existentes del rigging puede servir como dicho padre, cree un nuevo peg 

y anide esas capas debajo de dicho peg.

NOTA 

En la vista de línea de tiempo, puede desconectar una capa de su capa padre manteniendo 

presionada la tecla Mayús, arrastrando la capa padre lejos de la capa hija y colocándola en 

cualquier lugar de la lista.

Al crear un rigging, tenga en cuenta que el orden de las capas en la vista de línea de tiempo afecta al orden en 

que se representan. Las capas de la parte superior de la lista se representarán sobre las capas de la parte 

inferior de la lista.  Si tiene que cambiar el orden de una capa durante la animación, puede realizar un 

desplazamiento pequeño de la posición de esta capa sobre el eje Z para anular el orden de la capa y forzarla a 

aparecer debajo o sobre otras capas.

Desplazamiento pequeño de una capa sobre el eje Z

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar).

 2. En la vista de línea de tiempo, de nodos o de cámara, seleccione la capa que desea desplazar.

 3. Si ha seleccionado la capa en la vista de línea de tiempo o de nodos, haga clic en la pestaña de la 

vista de cámara para establecer el enfoque en esta vista.

 4. Realice una de las siguientes acciones:

 l Para realizar un desplazamiento pequeño de la capa hacia delante, pulse Alt + flecha 

abajo.
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 l Para realizar un desplazamiento pequeño de la capa hacia atrás, pulse Alt + flecha 

arriba.

Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. El peg maestro 

permite manipular todo el rig desde una única capa, sin necesidad de manipular cada parte individual. Esto es 

útil para colocar y escalar el personaje en relación a la escena, así como para animar la trayectoria del 

personaje cuando tiene que moverse entre las áreas de la escena.

Adición de un peg maestro en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione la capa superior.

 2. En la vista de línea de tiempo, haga clic en el botón  Add Peg (Agregar peg).

Se agrega a la línea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.

 3. Asigne el nombre Master más el nombre del personaje al nuevo peg.

 4. En la vista de línea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. 

Recuerde que la capa superior ya es un hijo del peg, así que no lo incluya en la selección.

 5. Arrastre la selección SOBRE la capa del peg para emparentar todas las piezas del personaje al 

peg. Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres 

de nuevo a la parte superior de la pila de capas.

117

Guía de introducción de Harmony 22 Advanced                          



Capítulo 11: Creación de un rig de un personaje cut-out

118



Capítulo 12: Animación de un personaje cut-out

Harmony ofrece herramientas muy útiles para animar modelos de personajes cut-out. Con la herramienta 

Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony 

crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos 

de las partes del personaje se pueden intercambiar en cualquier punto de la animación con objeto de permitir 

combinar los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creación de una animación cut-out simple

Crearemos una animación cut-out simple realizando la primera pose del personaje en el primer 

fotograma, la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

 1. En la vista de línea de tiempo, contraiga el personaje con la flecha Expand/Collapse 

(Expandir/Contraer).

 2. Seleccione el primer fotograma de la escena.

 3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de diálogo 

Extend Exposure (Extender exposición) realizando una de las siguientes acciones:
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 l Haga clic con el botón derecho en el primer fotograma de la vista de línea de tiempo y 

seleccione Extend Exposure (Extender exposición).

 l Pulse F5.

 4. En el cuadro de diálogo Extend Exposure (Extender exposición), escriba el número de fotogramas 

de la escena y confirme. De este modo, el modelo quedará expuesto (será visible) en toda la 

escena.

 5. Ahora crearemos la primera pose del personaje. En primer lugar, asegúrese de que haya un 

fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando 

cree la segunda pose más tarde, la primera pose no se verá afectada. Para llevarlo a cabo, realice 

una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se agrega un fotograma clave al fotograma actual.

 6. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar) o pulse Mayús + T.

 7. En la barra de herramientas de herramientas, si está seleccionado el modo  Animate Off (Animar 

desactivado) o  Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él 

para abrir el menú emergente Animate (Animar) y seleccione  Animate Current Frame (Animar 

fotograma actual).

 8. En la vista de cámara, seleccione las partes que desea animar. El cuadro de control de la 

herramienta Transform (Transformar) aparecerá alrededor de la capa seleccionada. Cada parte del 

cuadro de control de la herramienta Transform (Transformar) se puede usar para realizar distintos 

tipos de transformaciones:
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 9. Util ice la herramienta  Transform (Transformar) para rotar, sesgar, escalar o trasladar la 

selección a su nueva posición.

 10. Repítalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.

 11. En la barra de herramientas de herramientas, active la función  Onion Skin (Papel cebolla).

 12. En la vista de línea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

 13. Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.
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El segundo fotograma clave aparece, junto con una línea desde el primer fotograma clave al 

segundo fotograma clave. Esto indica que cada fotograma intercalado se interpolará mediante 

Harmony.

Si no aparece ninguna línea, significa que se ha creado el primer fotograma clave como un 

fotograma clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

 l Haga clic con el botón derecho en el primer fotograma clave y seleccione Set Motion 

Keyframe (Definir fotograma clave de movimiento).

 l Seleccione el primer fotograma clave y pulse Ctrl + K (W indows/Linux) o ⌘  + K (macOS)

Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de 

forma predeterminada, seleccione Animation (Animación) en el menú superior y asegúrese de que 

la opción Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA 

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma 

clave de Stop-motion. Los fotogramas entre dos fotogramas clave están interpolados 

por Harmony si el primero de los dos fotogramas clave es un fotograma clave de 

movimiento.

 14. En la vista de cámara, cambie de nuevo la pose del personaje.

 15. Repita este proceso para todas las poses que desee agregar a la animación.
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Ajuste de la velocidad de la animación

 1. En la vista de línea de tiempo, contraiga la jerarquía del rig (o de la parte del rig) a la que desea 

aplicar una velocidad.

NOTA 

Cuando se aplica una velocidad a una capa con hijos y se contrae la jerarquía de esta 

capa, la velocidad se aplica a esa capa y a todos sus hijos.

 2. Seleccione uno de los fotogramas clave de la animación.

NOTA 

Solo debe seleccionar un fotograma clave. El cuadro de diálogo Set Ease for Multiple 

Parameters (Definir aceleración para varios parámetros) solo puede editar la 

aceleración en un fotograma clave a la vez, pero también le permite saltar rápidamente 

entre fotogramas clave en la línea de tiempo.

 3. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic con el botón derecho y seleccione Set Ease 

For Multiple Parameters (Definir aceleración para varios parámetros).

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Set Ease For 

Multiple Parameters (Definir aceleración para varios parámetros).
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Se abre el cuadro de diálogo Set Ease For Multiple Parameters (Definir aceleración para varios 

parámetros).

 4. En el editor de Bézier, haga clic y arrastre el controlador Bézier para ajustar la velocidad de los 

fotogramas clave seleccionados.

 5. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de 

tiempo) y Value Ratio (Ratio de valor) debajo del editor de Bézier. Los valores se calculan como un 

porcentaje.

 l En los campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de 

tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que desea que 

dure la velocidad. Las curvas Bézier se alejarán horizontalmente de su fotograma clave. El 

valor debe estar entre el 0 % y el 100 %.

 l En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de 

valor derecho), escriba el valor como porcentaje correspondiente a la cantidad de sesgo que 

desea que tenga la velocidad. La curva Bézier se moverá verticalmente hacia el fotograma 
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clave más cercano si el valor es positivo o lejos del fotograma clave más cercano si su valor 

es negativo. El valor debe estar entre el 0 % y el 100 %.

 6. Para aplicar estos parámetros de velocidad únicamente a un tipo de función determinado, como 

Rotation (Rotación) o Scale (Escala), en la sección Filters (Filtros), anule la selección de los tipos de 

función a los que no desee que se apliquen.

 l Motion (Movimiento): aplica los parámetros de velocidad a las funciones Position X 

(Posición X), Position Y (Posición Y), Position Z (Posición Z) y 3D Path (Ruta 3D) 

seleccionadas.

 l Rotation (Rotación): aplica los parámetros de velocidad a las funciones de ángulo 

seleccionadas.

 l Scale (Escala): aplica los parámetros de velocidad a las funciones de escala 

seleccionadas.

 l Skew (Sesgar): aplica los parámetros de velocidad a las funciones de inclinación 

seleccionadas.

 l Morphing: aplica los parámetros de velocidad a las funciones de velocidad de 

morphing seleccionadas. Tenga en cuenta que se aplica cuando la función Morphing 

Velocity (Velocidad de morphing) de la ventana Layer Properties (Propiedades de 

capa), no es la velocidad de morphing básica en la vista de propiedades de la 

herramienta.

 l Other (Otras): aplica los parámetros de velocidad a todas las demás funciones 

seleccionadas, como todas las funciones creadas para animar parámetros de efecto.

 7. Haga clic en uno de los siguientes botones:

 l Apply/Previous (Aplicar/anterior): aplica los parámetros de velocidad al fotograma 

clave seleccionado y, a continuación, salta al fotograma clave anterior de la línea de 

tiempo para que después pueda ajustar su velocidad.

 l Apply (Aplicar): aplica los parámetros de velocidad al fotograma clave seleccionado.

 l Apply/Next (Aplicar/siguiente): aplica los parámetros de velocidad al fotograma 

clave seleccionado y, a continuación, salta el siguiente fotograma clave de la línea de 

tiempo para que después pueda ajustar su velocidad.

 l Close (Cerrar): cierra el cuadro de diálogo. Si no ha aplicado las modificaciones, se 

cancelarán

Desplazamiento por las capas

Dado que la animación cut-out normalmente implica modelos complejos con amplias jerarquías, aprender los 

atajos para desplazarse fácilmente entre las capas puede ahorrar mucho tiempo.
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Un truco de gran util idad para aprender es el comando Centre on Selection (Centrar en selección), junto con su 

atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de línea 

de tiempo. Por lo tanto, puede usar la vista de cámara para seleccionar de forma visual la capa con la que 

desee trabajar y, a continuación, usar el atajo de Centre on Selection (Centrar en selección) para encontrar la 

capa en la vista de línea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la selección actual en la vista de línea de tiempo

 1. En la vista de línea de tiempo, contraiga todas las capas.

 2. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar).

 3. En la vista de cámara, seleccione una capa.

 4. Realice una de las siguientes acciones:

 l Haga clic en la pestaña de la vista de línea de tiempo para ajustar el centrado en la 

misma y, a continuación, pulse O.

 l En la barra de herramientas de la vista de línea de tiempo, haga clic en el botón  

Centre on Selection (Centrar en selección).

La vista de línea de tiempo está ahora centrada en la capa seleccionada y todos sus padres se han 

expandido automáticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer tedioso tener que hacer clic en la pestaña de 

vista de línea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse Enter 

(Centrarse en ratón). Ajustará el centrado en una vista en cuanto el cursor del ratón entre en ella y hará 

funcionales al instante todos los atajos de teclado de esta vista.

Activación de la preferencia Focus On Mouse Enter (Centrarse en ratón)

 1. En el menú superior, vaya a Edit > Preferences (Editar > Preferencias) (W indows/Linux) o 

Harmony > Preferences (Harmony > Preferencias) (macOS).

 2. Abra la pestaña General.

 3. En la sección Options (Opciones), active la casilla de verificación Focus On Mouse Enter (Centrarse 

en ratón).

 4. Haga clic en OK (Aceptar).

Los atajos de teclado para vistas específicas funcionarán en cuanto el cursor del ratón entre en la 

vista prevista.
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Harmony también tiene comandos y atajos de teclado para cambiar rápidamente la selección de la capa 

seleccionada actualmente a su su padre, su hijo o uno de sus hermanos, permitiendo así el desplazamiento con 

rapidez por la jerarquía del personaje desde una capa a una de sus capas relacionadas.

Selección del padre o del hijo de la capa seleccionada

 1. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar).

 2. En la vista de propiedades de la herramienta Transform (Transformar), asegúrese de que esté 

desactivado el modo  Peg Selection (Selección de peg).

 3. En la vista de cámara o de línea de tiempo, seleccione una capa u objeto conectado a una jerarquía.

 4. Realice una de las siguientes acciones:

 l Seleccione Animation > Select Parent (Animación > Seleccionar padre) o pulse B para 

seleccionar la capa padre.

 l Seleccione Animation > Select Child (Animación > Seleccionar hijo) o pulse Mayús + B para 

seleccionar la capa hija.

 l Seleccione Animation > Select Children (Animación > Seleccionar hijos) para seleccionar 

todas las capas hijas al mismo tiempo.
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NOTA 

Al subir o bajar la jerarquía de nodos, estos atajos de teclado omiten cualquier nodo de efecto 

de la jerarquía y solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se 

optimizan para la animación cut-out. En el cuadro de diálogo Keyboard Shortcuts (Atajos de 

teclado), en la sección General, estos atajos de teclado se denominan Select Parent Skipping 

Effects (Seleccionar efectos de omisión del padre) y Select Child Skipping Effects 

(Seleccionar efectos de omisión del hijo). Si desea util izar los atajos de teclado para navegar 

por la jerarquía sin omitir los nodos de efectos, puede asignar atajos de teclado 

personalizados para los comandos Select Parent (Seleccionar padre) y Select Child 

(Seleccionar hijo).

Selección de los hermanos de la capa seleccionada

 1. En la vista de línea de tiempo, seleccione una capa que tenga al menos un hermano y realice una de 

las siguientes acciones:

 l Para seleccionar el hermano previo de la familia, pulse /.

 l Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de 

interrogación (?).
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Capítulo 13: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones 

generadas por ordenador. Las deformaciones funcionan mediante la creación de puntos de control en un 

dibujo. Al mover dichos puntos, el dibujo se dobla o distorsiona de modo que las partes del dibujo que están 

vinculadas a un punto de control siguen dicho punto al lugar donde lo posicione.

Los deformadores pueden aumentar considerablemente el rango de movimientos y animaciones que el rig de 

un personaje cut-out sea capaz de realizar sin necesidad de dibujar nuevas poses o recurrir a la animación 

fotograma a fotograma. Un personaje cut-out en rig con deformaciones se puede animar de una forma que se 

asemeje a la fluidez y flexibilidad de la animación tradicional. Además, los deformadores se pueden util izar 

para modificar, mejorar o facilitar la animación fotograma a fotograma cuando sea necesario.

Los deformadores funcionan al crear un rigging con ellos en la parte del cuerpo que desee deformar, crear una 

estructura de deformación y, a continuación, animarlo. Se puede realizar fácilmente con la herramienta  

Rigging.

Hay  dos tipos de deformadores disponibles en Harmony Advanced:

 l Hueso

 l Hueso para juego

Deformador de huesos

La deformación de hueso permite crear una estructura similar al hueso en la que cada parte es sólida, pero las 

articulaciones son flexibles. Esto es sobre todo útil para la animación de los miembros de un personaje, como 

los brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos.

Por ejemplo, se puede util izar una deformación de hueso para articular un brazo que está hecho de un solo 

dibujo, de modo que el brazo y el antebrazo se puedan mover de forma independiente, sin necesidad de 

dibujar la parte superior del brazo y el antebrazo en capas diferentes. Harmony deformará el dibujo para que 

parezca que está articulado. Las distintas partes de una deformación de hueso se pueden rotar alrededor de su 

articulación, extenderse y acortarse, proporcionándole las mismas capacidades que las articulaciones de 

animación en distintas capas, sin tener que preocuparse por la separación de piezas, puntos de pivote o recorte 

de contornos.
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Deformador de hueso para juego

La deformación de hueso para juego es parecida a la deformación de hueso. Le permite crear estructuras 

compuestas de puntos, que representan las articulaciones, y segmentos de líneas rectas vinculando dichos 

puntos que representan los huesos. La deformación de hueso para juego es diferente, ya que se optimiza para 

motores de juego como Unity. Por lo tanto, generalmente solo se usa para personajes animados destinados a 

importarse en juegos de Unity y no para producciones de animación.

A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen  una propiedad 

de sesgo. Los pliegues de la articulación también parecen ligeramente más redondos.

Creación de deformadores

La manera más sencilla de crear deformadores es usar la herramienta  Rigging, disponible en la barra de 

herramientas de deformación. Con esta herramienta, todo lo que necesita hacer para crear un deformador es 
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seleccionar la capa que desee deformar y, a continuación, colocar cada punto del deformador en la vista de 

cámara.

Los deformadores existen en la escena como una jerarquía de capas de deformación. Cuando crea un nuevo 

deformador, el primer punto que define es la raíz del deformador y cada punto nuevo que crea es un hijo del 

punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la 

jerarquía del personaje. Por ejemplo, si crea un deformador para un brazo, la raíz debe ser la articulación del 

hombro, el segundo punto debe ser el codo y el tercero, la muñeca.

Un deformador afecta a todas las capas que hay debajo de su jerarquía. Al crear un nuevo deformador 

util izando la herramienta Rigging, se crea automáticamente como padre de la capa seleccionada, y afectará a 

la capa seleccionada y a todos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de 

intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazo y el brazo se divide en varias capas, se puede crear 

un rig del brazo en una jerarquía donde el brazo superior sea la raíz, el antebrazo sea el hijo del brazo superior 

y la mano sea el hijo del antebrazo. A continuación, si crea su deformador en la parte superior del brazo, se 

creará como padre de la parte superior del brazo y, por lo tanto, afectará a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al 

crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los 

hijos de este peg. Esto se debe a que es probable que un peg sea más útil sobre un deformador que debajo de 

él. Si mueve las capas que están debajo de un deformador, saldrán de la zona de deformación prevista y 

pueden aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones 

posibles debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el 

deformador se queda intacto. Dado que el deformador se creará como padre de todos los hijos del peg, 

afectará a todas las capas que haya debajo de este.

Creación de un deformador de hueso

 1. Una vez seleccionado el elemento, seleccione la herramienta  Rigging en la barra de 

herramientas de deformación.

 2. En la vista de propiedades de la herramienta, habilite el modo  Bone (Hueso).
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 3. Haga clic en el lugar donde desee crear la articulación de raíz de la estructura ósea. La articulación 

de raíz debería ser la que esté vinculada al resto del cuerpo. Por ejemplo, en un brazo, la 

articulación de raíz sería el hombro.

 4. Haga clic en el lugar donde desee crear la segunda articulación.

Se creará un hueso entre la primera y la segunda articulación.

 5. Haga clic en el lugar donde desee crear la siguiente articulación.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un círculo. Se trata del 

radio de la articulación, lo que permite determinar qué cantidad de dibujo debe formar parte de la 

articulación. Cada punto de un deformador de hueso, a excepción del primero y del último, cuenta 

con un radio.

 6. Haga clic y mantenga pulsado el punto de control del radio de la articulación anterior y ajuste el 

radio de la articulación de modo que cubra la articulación correctamente.

 7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Asegúrese de crear cada 

articulación en el orden correcto desde la raíz hasta la extremidad.
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Visualización de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de cámara independientemente de la 

selección actual. Al crear una cadena de deformación, sus controles de deformación se muestran en la vista de 

cámara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores 

existentes, sus controles de deformación no se mostrarán automáticamente. Asimismo, al desactivar una 

cadena de deformación no se ocultarán sus controles de deformación.

Para poder animar o modificar una cadena de deformación existente, debe mostrarla de forma manual.

Visualización de los controles de deformación

 1. Realice una de las siguientes acciones:

 l En la vista de cámara o de línea de tiempo, seleccione una de las capas de dibujo vinculadas 

a la cadena de deformación que desee visualización.

 l En la vista de línea de tiempo, seleccione cualquier parte de la cadena de deformación que 

desee visualización.

 2. En la barra de herramientas de deformación:

 l Haga clic en el botón Show the Selected Deformation Chain and Hide All Others (Mostrar la 

cadena de deformación seleccionada y ocultar el resto)  para mostrar la cadena de 

deformación del elemento seleccionado y ocultar cualquier otra cadena de deformación que 

se muestre.

 l Haga clic en el botón Show Selected Deformers (Mostrar deformadores seleccionados)  

para mostrar la cadena de deformación del elemento seleccionado junto a cualquier otra 

cadena de deformación que se muestre.

Los controles de deformación aparecen en la vista de cámara.

NOTA 

El botón Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de 

deformación seleccionada y ocultar el resto) mostrará todas las cadenas de deformación que 

se encuentran en la jerarquía de la selección. Por ejemplo, si está seleccionado el peg maestro 

de un modelo de personaje, se mostrarán todas sus cadenas de deformación. Asimismo, si 

están seleccionadas varias capas vinculadas con distintas cadenas de deformación, se 

mostrarán todas sus cadenas de deformación.

Cómo ocultar los controles de deformación

 1. Realice una de las siguientes acciones:
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 l Haga clic en el espacio negativo de la vista de cámara, de línea de tiempo o de nodos 

para descartar la selección actual y, a continuación, haga clic en el botón  Show the 

Selected Deformation Chain and Hide All Others (Mostrar la cadena de deformación 

seleccionada y ocultar el resto) de la barra de herramientas de deformación.

 l Seleccione una capa que no esté vinculada a ningún deformador y, a continuación, 

haga clic en el botón  Show the Selected Deformation Chain and Hide All Others 

(Mostrar la cadena de deformación seleccionada y ocultar el resto) de la barra de 

herramientas de deformación.

 l En la barra de herramientas de cámara, haga clic en el botón  Hide All Controls 

(Ocultar todos los controles).

 l En el menú superior, seleccione View > Hide All Controls (Ver > Ocultar todos los 

controles). 

 l Pulse Mayús + C.

Animación con deformadores

Al igual que con los pegs de animación y las capas de dibujo, puede animar los deformadores creando 

fotogramas clave en sus capas correspondientes en la línea de tiempo. La animación de deformadores 

funciona exactamente igual que la realización de modificaciones en un deformador, excepto que requiere el 

uso de la herramienta  Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la 

herramienta Transform (Transformar), los controles de deformación de la vista de cámara se muestran en 

color verde, lo que significa que se encuentran en modo de animación, mientras que cuando se selecciona la 

herramienta Rigging, se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animación de deformaciones de hueso y hueso para juego

 1. En la vista de línea de tiempo, contraiga el personaje con la flecha Expand/Collapse 

(Expandir/Contraer).

 2. Seleccione el primer fotograma de la escena.
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 3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de diálogo 

Extend Exposure (Extender exposición) realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en el primer fotograma de la vista de línea de tiempo y 

seleccione Extend Exposure (Extender exposición).

 l Pulse F5.

 4. En el cuadro de diálogo Extend Exposure (Extender exposición), escriba el número de fotogramas 

de la escena y confirme. De este modo, el modelo quedará expuesto (será visible) en toda la 

escena.

 5. Ahora crearemos la primera pose del personaje. En primer lugar, asegúrese de que haya un 

fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando 

cree la segunda pose más tarde, la primera pose no se verá afectada. Para llevarlo a cabo, realice 

una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se agrega un fotograma clave al fotograma actual.

 6. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar) o pulse Mayús + T.

 7. En la barra de herramientas de herramientas, si está seleccionado el modo  Animate Off (Animar 

desactivado) o  Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él 

para abrir el menú emergente Animate (Animar) y seleccione  Animate Current Frame (Animar 

fotograma actual).

 8. Realice una de las siguientes acciones:

 l En la vista de cámara o de línea de tiempo, seleccione una de las capas de dibujo vinculadas 

a la cadena de deformación que desee animar.

 l En la vista de línea de tiempo, seleccione cualquier parte de la cadena de deformación que 

desee animar.
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 9. En la barra de herramientas de deformación:

 l Haga clic en el botón Show the Selected Deformation Chain and Hide All Others (Mostrar la 

cadena de deformación seleccionada y ocultar el resto)  para mostrar la cadena de 

deformación del elemento seleccionado y ocultar cualquier otra cadena de deformación que 

se muestre.

 l Haga clic en el botón Show Selected Deformers (Mostrar deformadores seleccionados)  

para mostrar la cadena de deformación del elemento seleccionado junto a cualquier otra 

cadena de deformación que se muestre.

Los controles de deformación aparecen en la vista de cámara.

 10. En la vista de cámara, realice lo siguiente:

 l Para rotar el miembro entero, haga clic y arrastre el primer hueso. Esto girará el 

primer hueso y todos los huesos subsiguientes.

 l Para doblar el miembro, haga clic y arrastre otro hueso. Esto girará el hueso y todos 

los huesos subsiguientes, pero dejará los huesos anteriores en su posición actual.

 l Para cambiar una articulación de posición, haga clic y arrastre su punto de control. 

Esto se puede util izar para rotar, reducir o extender el hueso, y desplazará todos los 

huesos subsiguientes.
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 l Para reducir o extender un hueso sin rotarlo, mantenga pulsada la tecla Alt y, a 

continuación, haga clic y arrastre su punto de control.

 l Para desplazar el miembro entero, haga clic y arrastre su punto de raíz.

CONSEJO 

También puede realizar un desplazamiento pequeño de una articulación 

en cualquier dirección seleccionándola y, a continuación, pulsando las 

teclas de flecha.

 11. En la vista de línea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.

 12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:
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 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add 

Keyframe (Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma 

clave).

 l Pulse F6.

 13. Transforme el punto del deformador para crear su nueva pose clave.

 14. Repita los pasos anteriores hasta que la animación haya terminado.
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Importación de sonido

Si desea agregar sonido a la animación, es recomendable que edite y mezcle los archivos de sonido en un 

software de edición de sonido. Al tener pistas de sonido de larga duración mezcladas previamente, se 

garantiza que el sonido conserve su tiempo, mezcla y calidad si util iza software de terceros para la 

postproducción. Otra buena práctica es mantener la pista de sonido separada en pistas de música, efectos de 

sonido y personajes para facilitar la sincronización de la animación con voces y sonidos. De lo contrario, es 

posible recortar los efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como 

escenas de Harmony independientes. La pista de sonido del storyboard se cortará por escena y cada pieza se 

insertará en las escenas exportadas, lo que permite ahorrar tiempo en la división e importación de la pista de 

sonido.

Harmony puede importar archivos de sonido .wav, .aiff y .mp3.

NOTA 

La importación de una pista de sonido más larga que la escena no ampliará la longitud de esta 

última. La reproducción de sonido se detendrá al final de la duración de la escena.

Importación de un archivo de sonido

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 

área de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

 l En el menú Xsheet (Carta de rodaje), seleccione File > Import > Sounds (Archivo > 

Importar > Sonidos).

 l En el menú Timeline (Línea de tiempo), seleccione Import > Sounds (Importar > 

Sonidos).

Se abre el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido).

 2. En el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un 

archivo de sonido.
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El archivo de sonido aparece como una capa en la vista de línea de tiempo. Su forma de onda se 

muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido 

de la pista de sonido.

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no 

mostrará una forma de onda de manera predeterminada. Si lo desea, puede visualizar la forma de 

onda de una columna de sonido haciendo clic con el botón derecho en ella y seleccionando Sound 

Display > W aveform (Visualización de sonido > Forma de onda).

Detección automática de sincronización de labios

La adición de la sincronización de labios a la animación es fundamental para que parezca que los personajes 

están vivos. Sin embargo, también es una parte especialmente pesada del proceso de animación.

Para solucionar este problema, Harmony proporciona una función de detección automática de sincronización 

de labios. Esta función analiza el contenido de una pista de sonido de la escena y asocia cada fonema que 

detecta con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estándar 

de la industria de la animación.
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NOTA 

Las letras asignadas a estas formas de boca son identificadores estándar y NO se corresponden 

con el sonido que se pretende producir.

Esta es una aproximación de los fonemas ingleses que cada forma de boca puede util izar para representar:

 l A: m, b, p, h

 l B: s, d, j, i, k, t

 l C: e, a

 l D: A, E

 l E: o

 l F: u, oo

 l G: f, ph

 l X: silencio, sonido indeterminado

Al realizar la detección automática de sincronización de labios, Harmony no crea dibujos de boca. Simplemente 

rellena la columna de dibujo de la capa de la boca del personaje con la sincronización de labios generada, 

insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que 

la detección automática de sincronización de labios funcione, la capa de la boca del personaje ya debe 

contener un dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de 

su letra correspondiente.

Generación de una detección de sonido para sincronización de labios mediante la vista 
de propiedades de capa

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione la capa de sonido.
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Las opciones para dicha capa aparecerán en la vista de propiedades de capa.

 2. En las propiedades de capa, haga clic en Detect (Detectar).

Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronización de labios a 

cada celda de sonido.

 3. Haga clic en el botón Map (Asignar) para abrir el cuadro de diálogo Lip-Sync Mapping (Asignación 

de sincronización de labios).

 4. En el menú Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de 

la boca para la pista de voz del personaje.
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NOTA 

Si la capa seleccionada contiene símbolos, puede asignar la sincronización de labios 

util izando dibujos situados directamente en la capa, o bien util izar los fotogramas del 

símbolo. En el campo Symbol Layer (Capa de símbolos), seleccione Don't Use Any 

Symbol (No usar ningún símbolo) si desea util izar los dibujos o el símbolo deseado del 

menú desplegable.

 5. En la sección Mapping (Asignación), escriba el nombre del dibujo o los fotogramas del símbolo en 

el campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de 

las letras del fonema, puede saltarse este paso.

 6. Haga clic en OK (Aceptar).

 7. En la barra de herramientas de reproducción, habilite la opción  Enable Sound (Habilitar sonido).

 8. Pulse el botón  Play (Reproducir) en la barra de herramientas de reproducción para ver y oír los 

resultados en la vista de cámara.

Si tiene que realizar ajustes a la sincronización de labios generada automáticamente, consulte 

Animación manual de sincronización de labios en la página 143.

Animación manual de sincronización de labios

Puede crear la sincronización de labios para la escena de forma manual seleccionando qué dibujo de boca 

debe exponerse en cada fotograma del cuadro del diálogo de su personaje. Para este proceso, util izará la 

función Sound Scrubbing (Depuración de sonido), que reproduce la parte de la pista de sonido en el fotograma 

actual cada vez que mueva el cursor de la línea de tiempo, lo que permite identificar los fonemas que debe 

hacer coincidir con la boca de su personaje. También se util izará un dibujo de sustitución para cambiar el dibujo 

de la boca que se expone en cada fotograma.

Animación de sincronización de labios utilizando la vista de línea de tiempo

 1. En la barra de herramientas de reproducción, active el botón  Sound Scrubbing (Depuración de 

sonido).

 2. En la vista de línea de tiempo, arrastre el cabezal de reproducción rojo a lo largo de la forma de 

onda de la capa de sonido.

 3. Cuando llegue a un fotograma en el que deba ir una posición determinada de la boca, por ejemplo, 

una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en 

la capa de formas de boca.

 4. En la sección Parameters (Parámetros), y continuando en la capa de formas de boca, coloque el 

cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al 
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puntero de intercambio .

 5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. El 

dibujo actual se cambia automáticamente a la nueva selección.

Animación de sincronización de labios utilizando la vista de librería

 1. En la barra de herramientas de reproducción, active el botón  Sound Scrubbing (Depuración de 

sonido).

 2. En la vista de línea de tiempo, arrastre el cabezal de reproducción rojo a lo largo de la forma de 

onda de la capa de sonido.

 3. Cuando llegue a un fotograma en el que deba ir una posición determinada de la boca, por ejemplo, 

una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en 

la capa de formas de boca.

 4. En la ventana Drawing Substitution (Sustitución de dibujo) de la vista de librería, arrastre el control 

para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de vista previa.
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Intercambio de dibujos utilizando la vista de sustituciones de dibujo

 1. Agregue la vista de sustituciones de dibujo a su zona de trabajo realizando una de las siguientes 

acciones:

 l En la esquina superior derecha de las vistas existentes, haga clic en el botón  Add View 

(Agregar vista) y seleccione Drawing Substitutions (Sustituciones de dibujo).

 l En el menú superior, seleccione W indows > Drawing Substitutions (Ventanas 

> Sustituciones de dibujo).

 2. En la barra de herramientas de reproducción, active el botón  Sound Scrubbing (Depuración de 

sonido).

 3. En la vista de línea de tiempo, arrastre el cabezal de reproducción rojo a lo largo de la forma de 

onda de la capa de sonido.

 4. Cuando llegue a un fotograma en el que deba ir una posición determinada de la boca, por ejemplo, 

una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en 

la capa de formas de boca.

 5. En la vista de sustituciones de dibujo, haga clic en la pose de la boca que desee exponer en el 

fotograma actual.

CONSEJO 

También puede pulsar [ para sustituir el dibujo seleccionado por el dibujo anterior y ] para 

sustituirlo por el siguiente dibujo.
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Capítulo 15: Adición de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animación esté terminada, puede agregar 

efectos, como desenfoques, bril los, sombras, filtros de color y de transparencia, así como mejorar la calidad 

del proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una 

capa de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se 

aplican al elemento al que están conectados. Esto proporciona flexibilidad a la hora de decidir a qué 

elementos de la escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el área a 

la que deben afectar.  Un buen ejemplo de ello es el efecto de tono, que se usa para agregar una sombra de 

una forma determinada a una capa. De forma independiente, el efecto de tono no tiene ningún impacto en el 

dibujo al que está conectado. Una vez combinado con una capa de mate, el efecto de tono usará la forma del 

mate para aplicar una sombra al dibujo. Incluso si la forma del mate sale fuera de los contornos del dibujo, la 

sombra solo se aplicará dentro de los contornos del dibujo. 
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Una capa de mate es una capa de dibujo habitual que está conectada a un efecto como su mate. El efecto toma 

la forma del dibujo en la capa de mate para determinar el área del dibujo a la que afecta. Los colores y detalles 

de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En la vista de línea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al 

que debe afectar.

Si el efecto puede usar una capa de mate, tendrá un parámetro de mate al ampliar la lista de parámetros. 

Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el parámetro de mate del 

efecto para vincularlos.

Si el efecto puede usar una capa de mate, tendrá un puerto de mate a su izquierda al que se puede conectar la 

capa de mate.

Una vez que el efecto está conectado, puede ajustar sus parámetros seleccionándolo y, a continuación, 

ajustando sus parámetros en la vista de propiedades de capa. También puede hacer doble clic en la capa para 

abrir su cuadro de diálogo de propiedades de capa.  Si se desea, incluso puede animar los parámetros del 

efecto convirtiendo sus valores a funciones.

Adición de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efecto y, a 

continuación, agregando el efecto a través del menú Add Layers (Agregar capas) de la vista de línea de 

tiempo. A continuación, puede conseguir el efecto previsto ajustando los parámetros en la vista de 

propiedades de capa y conectándolos a una capa de mate, según proceda.

Adición de un efecto

 1. En la vista de línea de tiempo, seleccione la capa en la que desee agregar un efecto.

 2. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el 

efecto que desea agregar.
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 l En la barra de herramientas de capas situada encima de la lista de capas, haga clic en 

el botón  Add Layers (Agregar capas), seleccione Effects (Efectos) y, a 

continuación, seleccione el efecto que desee agregar.

 l Haga clic con el botón derecho en la capa, seleccione Insert > Effects (Insertar > 

Efectos) y, a continuación, seleccione el efecto que desee agregar.

El efecto aparece en la vista de línea de tiempo, debajo de la capa seleccionada.

 3. En la vista de cámara, haga clic en el botón  Render View (Vista de render) para ver el fotograma 

y el efecto actuales renderizados de la escena.

NOTA 

El fondo aparecerá en negro de forma predeterminada. Para corregirlo, puede 

agregar una capa de la carta de color en la parte inferior de la lista de capas y 

cambiar su color en la vista de propiedades de capa.

 4. En la vista de línea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer 

Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus 

propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los parámetros disponibles para el efecto 

seleccionado.

 5. En la vista de propiedades de capa, ajuste los parámetros del efecto según sea necesario.

NOTA 

Cada vez que realice un cambio, la vista de cámara tendrá que actualizar la imagen 

renderizada, lo cual puede provocar una ligera demora antes de que pueda observar el 

efecto.
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 6. La mayoría de los efectos no se reproducirán en tiempo real en Harmony. Para reproducir la escena 

con los efectos finales, haga clic en el botón  Render and Play (Renderizar y reproducir) de la 

barra de herramientas de reproducción de la barra de herramientas de la vista de línea de tiempo.

NOTA 

Una vez que haya establecido los parámetros para el efecto, puede almacenarlo en la vista de 

librería como plantil la para poder reutil izarlo rápidamente sin necesidad de volver a 

establecer los parámetros; consulte Creación y uso de plantil las en la página 180.

 Adición de un efecto con un mate

El siguiente tutorial muestra cómo usar el efecto de cuchilla con un mate. En Harmony, varios efectos usan 

mates para determinar el área de la imagen a la que afectan.

El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se 

pretende cortar, así como a una capa de mate. La cuchilla adoptará la forma del dibujo de la capa de mate y 

cortará esta forma de la capa de dibujo. Esto es particularmente útil si desea que un personaje desaparezca 

entre un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Al igual que todos los efectos que util izan un mate, el efecto de cuchilla tiene un parámetro Inverted 

(Invertido), que está deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchilla tendrá el 

efecto contrario: en lugar de cortar la forma del mate del dibujo, cortará todo lo que se encuentre fuera de la 

forma del mate del dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate. 

Uso del efecto de cuchilla

 1. Seleccione una capa de dibujo.
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 2. Realice una de las siguientes acciones:

 l En la barra de herramientas sobre la lista de capas en la vista de línea de tiempo, haga clic 

en el botón  Add Layer (Agregar capa) y seleccione Effects > Cutter (Efectos > Cuchilla).

 l Haga clic con el botón derecho en la capa y seleccione Insert > Effects > Cutter (Insertar 

> Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

 1. En la barra de herramientas sobre la lista de capas en la vista de línea de tiempo, haga clic en  

Add Drawing Layer (Agregar capa de dibujo).

 2. En el cuadro de diálogo Add Drawing Layer (Agregar capa de dibujo), asigne a la nueva capa de 

dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuación, haga 

clic en Add and Close (Agregar y cerrar).

 3. En la nueva capa de dibujo de mate, dibuje un mate para el efecto. El mate puede ser una forma 

simple, pero se debe rellenar con un color, ya que solo se tendrán en cuenta las partes del mate 

que sean opacas.

NOTA 

Los mates también pueden tener áreas semitransparentes. Las áreas del dibujo 

cubiertas por áreas semitransparentes del mate se ven parcialmente afectadas por el 

efecto.
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 4. En la vista de línea de tiempo, haga clic en el botón  Expand (Expandir) situado a la derecha de la 

capa Cutter (Cuchilla).

Debajo aparece el parámetro Matte (Mate) de la cuchilla.

 5. Arrastre y coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo 

de la columna Parameters (Parámetros).

La capa de dibujo de mate se convierte en el mate de la capa Cutter (Cuchilla). En este punto, las 

áreas de la ilustración que se cruzan con la ilustración de la capa de dibujo de mate están ocultas.

 6. Si desea invertir el efecto de cuchilla, para que la ilustración que se cruza con la ilustración de la 

capa de mate sea visible y todo lo demás esté oculto, haga doble clic en la capa Cutter (Cuchilla) 

(pero no en su nombre) para abrir su cuadro de diálogo de propiedades de capa y, a continuación, 

marque el parámetro Inverted (Invertido).

Otros dos ejemplos de efectos que funcionan con mates son los efectos de tono y resaltado. El efecto de tono 

aplica una sombra a su dibujo basada en su mate, mientras que el efecto de resaltado aplica un resaltado a un 
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dibujo basado en un mate. Estos efectos no se aplican fuera de los dibujos a los que están conectados, de 

modo que solo tiene que dibujar los resaltados y la sombra del personaje en las capas de mate sin 

preocuparse por dibujar fuera del trazado.

La adición de estos efectos a un dibujo funciona exactamente igual que la adición de una cuchilla a un dibujo, 

salvo que tienen parámetros adicionales para configurar el color, la intensidad y el renderizado del efecto.

Animación de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede 

desear que el radio de un efecto de bril lo aumente y disminuya lentamente para hacer que vibre a lo largo de 

una escena, o puede desear que la transparencia de un efecto de transparencia aumente de 0 % a 100 % para 

hacer desaparecer un dibujo.

Casi todos los parámetros numéricos de un efecto se pueden unir a una función. Una función permite definir un 

parámetro para distintos valores en diferentes puntos de la escena agregándole fotogramas clave y 

definiendo cada fotograma clave en un valor específico. Entre fotogramas clave, el valor del parámetro 

avanzará desde el valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de 

dibujo se animan asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar 

asociando sus parámetros a funciones.

Algunos parámetros de efectos se pueden animar directamente en la vista de línea de tiempo, pero no todos. 

Al expandir los parámetros de un efecto en la vista de línea de tiempo, algunos de sus parámetros pueden 

estar ocultos para evitar saturar la vista de línea de tiempo. Puede animar esos parámetros desde la vista de 

propiedades de capa o el cuadro de diálogo de propiedades de capa, que muestra todos los parámetros de una 

capa.
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Animación de un parámetro de efecto en la vista de línea de tiempo

 1. En la vista de línea de tiempo, localice el efecto que desea animar y haga clic en el botón  Expand 

(Expandir) situado a la derecha de su nombre.

Aparece en la vista de línea de tiempo la lista de parámetros que muestra los parámetros de 

efectos disponibles.

 2. En el área derecha de la vista de línea de tiempo, en la misma fila que el parámetro que desee 

animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animación para 

el efecto.

 3. Cree un fotograma clave realizando una de las siguientes acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.
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 4. En el área de la izquierda de la vista de línea de tiempo, debajo de la columna Parameters 

(Parámetros), ajuste el valor del parámetro para este fotograma clave realizando una de las 

siguientes acciones:

 l Haga clic y mantenga pulsado el valor del parámetro. A continuación, arrástrelo hacia la 

izquierda para reducir su valor o hacia la derecha para aumentarlo.

 l Haga clic en el valor del parámetro. Aparecerá un campo de texto. Escriba el nuevo valor del 

parámetro y pulse Entrar.

 5. En el área derecha de la vista de línea de tiempo, haga clic en el fotograma en el que desee crear el 

segundo fotograma clave de animación para el efecto.

 6. Cree el segundo fotograma clave para la animación del efecto realizando una de las siguientes 

acciones:

 l En la barra de herramientas de línea de tiempo, haga clic en el botón  Add Keyframe 

(Agregar fotograma clave).

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

 7. En la columna Parameters (Parámetros), ajuste el valor del parámetro en el fotograma clave actual.
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 8. Repita los pasos para crear tantos fotogramas clave de animación para el efecto como sea 

necesario.

 9. Para ajustar el tiempo entre los fotogramas clave de la animación, seleccione el primer fotograma 

clave.

 10. En la barra de herramientas de línea de tiempo, haga clic en el botón  Set Ease for Multiple 

Parameters (Definir aceleración para varios parámetros).

Aparece el cuadro de diálogo Set Ease For Multiple Parameters (Definir aceleración para varios 

parámetros). El gráfico de funciones de este cuadro de diálogo se centrará en el primer  

fotograma clave de la animación, que debe tener un controlador de la  curva Bézier al lado 

apuntando hacia la derecha.

 11. Haga clic en el controlador de la  curva Bézier y arrástrelo hacia la derecha, en cualquier ángulo, 

para ajustar la aceleración gradual de la animación.

 12. Haga clic en Apply/Next (Aplicar/siguiente).
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El cuadro de diálogo Set Ease For Multiple Parameters (Definir aceleración para varios parámetros) 

se centrará en el segundo fotograma clave. Si este es el último fotograma clave de la animación, 

solo tendrá un controlador de curva Bézier apuntando hacia la izquierda. Si hay más fotogramas 

clave de animación después de este, tendrá dos controladores de la curva Bézier, uno apuntando 

en cada dirección.

 13. Haga clic en el controlador izquierdo de la  curva Bézier y arrástrelo hacia la izquierda, en 

cualquier ángulo, para ajustar la desaceleración gradual de la animación entre el fotograma clave 

anterior y el fotograma clave actual.

 14. Si hay un controlador de curva Bézier  apuntando hacia la derecha, haga clic en él y arrástrelo 

hacia la derecha, en cualquier ángulo, para ajustar la aceleración gradual de la animación entre el 

fotograma clave actual y el siguiente fotograma clave.
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 15. Repita los pasos anteriores hasta que el tiempo de la animación se ajuste a lo largo de toda la 

escena.

Animación de un efecto en el cuadro de diálogo de propiedades de capa

 1. Abra las propiedades de capa del efecto realizando una de las siguientes acciones:

 l Agregue la vista de propiedades de capa a la zona de trabajo y seleccione el efecto en la 

vista de línea de tiempo.

 l En la vista de línea de tiempo, haga doble clic en la capa del efecto, pero no en su nombre.

 2. En las propiedades de capa del efecto, localice el parámetro que desea animar y haga clic en el 

botón  Function (Función) situado a su derecha.

El campo de entrada del parámetro se atenuará. Esto se debe a que no puede editar un parámetro 

directamente una vez conectado a una función. El campo indicará el nombre de la función que se 

creó para él en este formato:

Nombre de capa: Nombre de función: Valor en fotograma actual

 3. Haga clic de nuevo en el botón Function (Función) del parámetro.

Se abre el cuadro de diálogo Bezier Editor (Editor de Bézier).
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Este cuadro de diálogo permitirá animar la función. El gráfico de funciones de la parte inferior sirve 

para representar los valores de la función a lo largo de cada fotograma de la escena.

 4. En el gráfico de funciones, haga clic y arrastre el cursor rojo  para moverlo al fotograma donde 

desea crear el primer fotograma clave de animación.

 5. Haga clic en el botón  Add Keyframe (Agregar fotograma clave) para crear el primer fotograma 

clave de animación para el efecto.

Se crea un fotograma clave  y debe ser visible en el gráfico de funciones. Si no se ve, es porque el 

gráfico de funciones no está colocado para incluir el fotograma clave en su fotograma. Para mover 

el gráfico de funciones con el fin de ver el fotograma clave de la función, haga clic en el botón  

Reset View (Restablecer vista) o  Reset View Vertically (Restablecer vista vertical).
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 6. Ajuste el valor del parámetro al fotograma actual realizando una de las siguientes acciones:

 l En el campo Value (Valor) sobre el gráfico de funciones, escriba el valor deseado para el 

parámetro.

 l En el gráfico de funciones, haga clic y arrastre el  fotograma clave y muévalo hacia arriba 

para aumentar su valor o hacia abajo para disminuirlo. 

CONSEJO 

Si desea establecer el fotograma clave en un valor que está fuera del fotograma 

del gráfico de funciones, puede pulsar la tecla 1 para alejarse. También puede 

pulsar la tecla 2 para volver a acercarse.
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 7. Haga clic y arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo 

fotograma clave de animación.

 8. Haga clic en el botón  Add Keyframe (Agregar fotograma clave) para crear el segundo 

fotograma clave de animación para el efecto.

 9. Ajuste el valor del parámetro al fotograma actual realizando una de las siguientes acciones:

 l En el campo Value (Valor) sobre el gráfico de funciones, escriba el valor deseado para el 

parámetro.

 l En el gráfico de funciones, haga clic y arrastre el  fotograma clave y muévalo hacia arriba 

para aumentar su valor o hacia abajo para disminuirlo. 
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 10. Si desea ajustar el tiempo de la animación entre el primer y el segundo fotograma clave, haga lo 

siguiente:

 l Haga clic y arrastre el controlador de la  curva Bézier del primer fotograma clave hacia la 

derecha, en cualquier dirección, para que afecte a la aceleración gradual de la animación.

 l Haga clic y arrastre el controlador de la  curva Bézier del segundo fotograma clave hacia la 

izquierda, en cualquier dirección, para que afecte a la desaceleración gradual de la 
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animación.

 11. Repita estos pasos hasta que haya creado y sincronizado los fotogramas clave de animación 

necesarios para animar el efecto.

Creación de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra cómo combinar efectos con otras funciones de Harmony para crear 

fácilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra 

paralela que seguirá automáticamente la animación del personaje, incluso si después cambia la animación.

Creación de una sombra paralela para un personaje animado

 1. En la vista de línea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el 

personaje está bajo un peg maestro, también funcionará si selecciona el peg maestro.

 2. Asegúrese de que el rig de personaje se encuentre en un grupo. De no ser así, haga clic con el 

botón derecho en la selección y, a continuación, seleccione Group Selection (Agrupar selección).
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 3. Una vez seleccionado el personaje en la vista de línea de tiempo, cree un clon del personaje 

realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Clone 

Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y 

tiempo).

 l En el menú superior, seleccione Edit > Clone: Drawings and Timing 

(Editar > Clonar: Dibujos y tiempo).

NOTA 

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempo y la 

misma exposición que su capa de origen, incluso si su capa de origen se cambia más 

tarde. Por lo tanto, puede cambiar la animación del personaje y la animación del 

personaje clonado se actualizará automáticamente con estos cambios.

 4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en  

Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Insert > 

Effects > Shadow (Insertar > Efectos > Sombra).

 5. En la vista de línea de tiempo, seleccione la capa raíz del clon del personaje.

 6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en el 

botón  Add Peg (Agregar peg).

 l Pulse Ctrl + P (W indows/Linux) o ⌘  + P (macOS).

 7. En la vista de línea de tiempo, seleccione el peg padre del clon.

 8. En la barra de herramientas de herramientas, seleccione la herramienta  Transform 

(Transformar).

 9. En la vista de cámara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Las guías de dibujo son ayudas para dibujar que puede agregar a su escena para ayudarle a dibujar fondos y 

objetos con líneas rectas, ángulos rectos y efectos de proyección gráfica, como la proyección isométrica, la 

perspectiva recta y la perspectiva curvilínea. En el arte tradicional, esto se realiza con herramientas, como 

reglas, reglas T, escuadras y puntos de desaparición. Las guías permiten simular el uso de dichas herramientas 

junto con las herramientas de dibujo en Harmony.

Harmony admite distintos tipos de guías de dibujo, cada una diseñada para distintos tipos de tareas de dibujo. 

La mayoría de las guías de dibujo de Harmony funcionan agregando una línea de horizonte y puntos de 

desaparición a su espacio de dibujo. Cuando util iza una guía de dibujo, aparecen líneas de guía de puntos 

mediante el cursor del ratón. Estas líneas de guía son paralelas o perpendiculares a la línea de horizonte, o van 

desde uno de los puntos de desaparición de la guía hasta el cursor del ratón. Cuando empieza a dibujar un 

trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guía, como si dibujara con una 

regla. También puede util izar las guías de dibujo como simples referencias visuales sin fijar la herramienta de 

dibujo a los ejes.

Harmony admite los siguientes tipos de guías de dibujo:

 l La regla le permite colocar y rotar un eje y, a continuación, dibujar una línea a lo largo de dicho eje, 

como una regla normal.

 l La cuadrícula cuadrada le ayuda a dibujar líneas paralelas o perpendiculares a la línea de horizonte.
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 l La guía de perspectiva isométrica le ayuda a dibujar líneas paralelas a uno de los tres ejes: el eje x, el 

eje y, y el eje z. El ángulo de cada eje se puede personalizar según sea necesario.

Este tipo de seudoperspectiva, también conocida como proyección paralela, a menudo se util iza en 

juegos 2D, infografías y esquemas para representar objetos y entornos 3D sin util izar ninguna 

perspectiva, escorzo o renderizado 3D real. En la animación 2D, a menudo se util iza para dibujar fondos 

de paneo largos desde un ángulo alto o bajo.

 

 l La guía de perspectiva con 1 punto le ayuda a dibujar líneas procedentes de un único punto de 

desaparición en el centro del horizonte. También le ayuda a dibujar líneas paralelas o perpendiculares a 

la línea de horizonte.

Esto es útil para dibujar estructuras de forma de cuboide que se encuentran de cara a la cámara.

 l La guía de perspectiva con 2 puntos le ayuda a dibujar líneas procedentes de uno de los dos puntos de 

desaparición, que se colocan en la línea de horizonte fuera del campo de la cámara. También le ayuda a 

dibujar líneas perpendiculares a la línea de horizonte.

Esto es útil para dibujar estructuras de forma de cuboide desde un ángulo horizontal específico.
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 l La guía de perspectiva con 3 puntos le ayuda a dibujar líneas procedentes de uno de los tres puntos de 

desaparición. Como con la guía de perspectiva con 2 puntos, se colocan dos puntos de desaparición en 

la línea de horizonte que se util izan para dibujar líneas horizontales en el eje x o en el eje z. El otro punto 

de desaparición se coloca debajo de la línea de horizonte para ayudarle a dibujar líneas en el eje y.

Esto es útil para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

 l La guía de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar líneas procedentes de uno de los 

tres puntos de desaparición. Como con la guía de perspectiva con 2 puntos, se colocan dos puntos de 

desaparición en la línea de horizonte que se util izan para dibujar líneas horizontales en el eje x o en el 

eje z. El otro punto de desaparición se coloca encima de la línea de horizonte para ayudarle a dibujar 

líneas en el eje y.

Esto es útil para dibujar estructuras de forma de cuboide desde un punto de vista bajo.

167

Guía de introducción de Harmony 22 Advanced                          



Capítulo 16: Uso de guías de dibujo

 l La guía de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panorámicos 

horizontales, con líneas horizontales curvilíneas. Un punto de desaparición se coloca en el centro de la 

línea de horizonte para ayudarle a dibujar líneas en el eje z y dos puntos de desaparición se colocan en 

la línea de horizonte fuera del campo de la cámara para definir la curva de las líneas horizontales. Las 

líneas verticales se colocan perpendicularmente a la línea de horizonte.

Esto es útil para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la 

cámara sobre el fondo dibujado con una guía de perspectiva con 3 puntos (paneo horizontal) simulará 

una rotación de la cámara en el eje y.

 l La guía de perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panorámicos verticales, 

con líneas verticales curvilíneas. Un punto de desaparición se coloca en el centro de la línea de 

horizonte para ayudarle a dibujar líneas en el eje z y dos puntos de desaparición se colocan debajo de la 

línea de horizonte, fuera del campo de la cámara, para definir la curva de las líneas verticales. Las líneas 

horizontales se colocan en paralelo a la línea de horizonte.

Esto es útil para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la cámara 

sobre el fondo dibujado con una guía de perspectiva con 3 puntos (paneo vertical) simulará una rotación 

vertical de la cámara en el eje X.
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 l La guía de perspectiva continua con 4 puntos es muy parecida a la guía de perspectiva con 3 puntos 

(paneo horizontal), salvo que está diseñada para ayudarle a dibujar fondos panorámicos completos de 

360°.

Esta guía util iza 5 puntos de desaparición. Cuando dibuja una línea horizontal, se curva formando un 

arco sobre uno de los puntos de desaparición y llegando hasta los dos puntos de desaparición 

circundantes. Esto crea un efecto de perspectiva donde cada punto de desaparición representa uno de 

los puntos cardinales, salvo los puntos más a la izquierda y más a la derecha que representan el mismo 

punto cardinal, lo que crea un fondo en bucle. Los fondos creados con la guía de perspectiva continua 

con 4 puntos se pueden repetir en bucle horizontalmente para simular una rotación completa de la 

cámara en el eje y.

 l La guía de perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la guía de 

perspectiva con 2 puntos, salvo que sus líneas verticales son curvilíneas, para que se pueda util izar para 

crear fondos de paneo verticales. Dos puntos de desaparición se encuentran en la línea de horizonte, 
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fuera del campo de la cámara, para ayudarle a dibujar líneas en el eje x y el eje z, y dos puntos de 

desaparición se colocan encima y debajo del campo de la cámara para definir la curva de las líneas 

verticales.

Esto es útil para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de 

cuboide se ven desde un ángulo.

 l La guía de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilíneos en el eje x y en 

el eje y. Tiene un punto de desaparición central en la línea de horizonte desde el que se dibujan líneas 

en el eje z; dos puntos de desaparición en los extremos de su línea de horizonte para definir la curva de 

líneas horizontales; y dos puntos de desaparición encima y debajo de la línea de horizonte para definir la 

curva de las líneas verticales.

Esta guía se puede util izar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo 

de pez. También se puede util izar para dibujar fondos que se deben recorrer en varias direcciones.
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Para usar una guía de dibujo, en primer lugar debe agregarla a la lista de guías de la escena. Para 

familiarizarse con las guías, puede comenzar agregando la guía de dibujo de perspectiva con 1 punto a la lista 

de guías.

Adición de una guía de dibujo de perspectiva con 1 punto a la escena 

 1. En la barra de herramientas de herramientas, seleccione Herramienta  Brush (Pincel),  Pencil 

(Lápiz),  Stroke (Línea vectorial transparente) o  Line (Línea).

NOTA 

Las guías de dibujo solo están visibles en la vista de cámara o de dibujo cuando está 

seleccionada una de las herramientas.

 2. Agregue la vista de guías a su espacio de trabajo realizando una de las siguientes acciones:

 l En la esquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botón  

Add View (Agregar vista) y seleccione Guides (Guías).

 l En el menú superior, seleccione W indows > Guides (Ventanas > Guías). 
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 3. En la vista de guías, haga clic en el botón  New Guide (Nueva guía) y seleccione  1-Point 

Perspective (Perspectiva con 1 punto).

La nueva guía aparece en la lista de guías.

Cuando se agrega una guía nueva, su línea de horizonte se configura en una posición y un ángulo predefinidos 

y sus puntos de desaparición se configuran en una posición predefinida. En muchos casos, debe realizar 

ajustes en la guía para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guía de perspectiva con 1 punto en una 

 1. En la barra de herramientas de herramientas, seleccione Herramienta  Brush (Pincel),  Pencil 

(Lápiz),  Stroke (Línea vectorial transparente) o  Line (Línea).

NOTA 

Las guías de dibujo solo están visibles en la vista de cámara o de dibujo cuando está 

seleccionada una de las herramientas.
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 2. En la vista de guías, asegúrese de que la opción  Enable Guides (Habilitar guías) esté activada.

 3. En la lista de guías, seleccione la guía de perspectiva con 1 punto en una en la que desee 

realizar ajustes.

La guía seleccionada aparece en la vista de cámara o de dibujo.

 4. Realice una de las siguientes acciones:

 l Para cambiar la guía de posición sin rotarla, haga clic y arrastre su punto de desaparición .

 l Para rotar la guía, haga clic y arrastre su línea de horizonte.

CONSEJOS 

 l Cuando el ratón se coloca encima de la línea de horizonte, el cursor del ratón 

cambiará a  para indicar que está a punto de rotar la guía.

 l Al rotar una guía, su ángulo se muestra en la esquina superior izquierda de la 

vista de cámara o de dibujo.

 5. Una vez que haya terminado de realizar ajustes en la guía, puede hacer clic en el botón  

Lock Guides (Bloquear guías) en la vista de guías para evitar modificar su guía accidentalmente 

mientras dibuja.

Una vez que la guía esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guías de dibujo

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacía, y cree un 

nuevo dibujo realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en la celda y seleccione Drawing > Create Empty Drawing 

(Dibujo > Crear dibujo vacío).

 l Pulse Alt + Mayús + R.

173

Guía de introducción de Harmony 22 Advanced                          



Capítulo 16: Uso de guías de dibujo

 2. En la barra de herramientas de herramientas, seleccione Herramienta  Brush (Pincel),  Pencil 

(Lápiz),  Stroke (Línea vectorial transparente) o  Line (Línea).

NOTA 

Las guías de dibujo solo están visibles en la vista de cámara o de dibujo cuando está 

seleccionada una de las herramientas.

 3. En la vista de guías, seleccione la guía que desee usar.

 4. Para evitar editar su guía accidentalmente mientras dibuja, haga clic en el botón  Lock Guides 

(Bloquear guías) en la vista de guías para activarla.

 5. Si desea bloquear sus trazos con los ejes de la guía, asegúrese de que la opción  Align 

w ith Guide (Alinear con guía) de la vista de guías esté activa. En caso contrario, desactívela para 

poder dibujar libremente y use solo las guías como referencias.

 6. Mueva el cursor del ratón por el espacio de dibujo. Observe que las líneas de guías pasan por el 

cursor del ratón, una por cada uno de los ejes de la guía de dibujo.

 7. Comience a dibujar en trazo en el mismo ángulo que uno de los ejes.

Si la opción  Align w ith Guide (Alinear con guía) está habilitada, el trazo se alinea con el eje más 

cercano a su ángulo, como si dibujara con una regla.
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CONSEJOS 

 l También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las 

teclas Flecha izquierda y Flecha derecha para pasar por cada eje. El eje seleccionado 

aparecerá más resaltado que los demás. Si pasa por todos los ejes, ningún eje estará 

resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a 

determinar en función del ángulo de su trazo.

 l Esté dibujando o no, puede fijar la posición y el ángulo de las líneas de guía manteniendo 

pulsada la tecla Alt. Las líneas de guía dejarán de seguir el cursor del ratón, lo que le 

permitirá mantenerlas en un ángulo y posición específicos. Esto se puede util izar para 

dibujar sobre la misma línea varias veces para ajustar su longitud y grosor.

Una vez que haya terminado de trabajar con las guías, puede deshabilitarlas. Cuando las guías de dibujo están 

deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de 

dibujo.

Habilitación y deshabilitación de guías de dibujo

 1. Para habilitar o deshabilitar las guías de dibujo, realice una de las siguientes acciones:

 l En la vista de guías, haga clic en el botón Enable Guide (Habilitar guía) .

 l Pulse Mayús + G.

NOTAS 

 l Las guías se habilitan automáticamente al agregar una nueva guía o al seleccionar una 

guía en la lista de guías.

 l La guía que se seleccionó cuando deshabilitó las guías se volverá a seleccionar cuando 

vuelva a habilitar las guías.

 l Las guías de dibujo solo funcionan con las herramientas Herramientas  Brush (Pincel), 
 Pencil (Lápiz),  Stroke (Línea vectorial transparente) y  Line (Línea). Si se 

selecciona cualquier otra herramienta, las guías de dibujo se comportarán como si 

estuvieran deshabilitadas.
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Capítulo 17: Creación de un multiplano

En la acción en vivo, cuando la cámara se mueve alrededor de una escena, parecerá que los objetos cercanos a 

la cámara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animación 2D, se 

puede conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar fácilmente un multiplano creando un fondo sobre varias capas, extendiéndolas 

en el eje z para agregar profundidad y moviendo la cámara por el entorno resultante para crear una ilusión de 

perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada una representa un objeto que se 

encuentra a una distancia diferente de la cámara. A la izquierda, puede ver cómo se sitúa cada objeto en 

relación con la cámara, como si estuviera mirándolos desde un lado. A la derecha, puede ver cómo se sitúan 

las capas en relación entre sí como si estuviera mirando la escena desde una esquina. A continuación, puede 

ver la escena desde el punto de vista de la cámara.
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Mediante la herramienta Maintain Size (Mantener tamaño), puede convertir fácilmente un fondo multicapa 

normal en un multiplano. Esta herramienta permite mover una capa más cerca o más lejos de la cámara 

mientras se ajusta automáticamente el tamaño de la capa proporcionalmente a su distancia de la cámara, 

conservando su tamaño aparente desde el punto de vista de la cámara. Por lo tanto, no tiene que preocuparse 

por el tamaño y la posición de las capas al diseñar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los 

pasos que se muestran a continuación para convertir el fondo en un multiplano.

Configuración de un multiplano con la herramienta Maintain Size (Mantener tamaño)

 1. Asegúrese de que la opción No Z Dragging (Sin arrastre de eje z) del menú superior Animation 

(Animación) esté deshabilitada.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas de animación avanzada, seleccione la herramienta  

Maintain Size (Mantener tamaño).

 l En el menú superior, seleccione Animation > Tools > Maintain Size (Animación > 

Herramientas > Mantener tamaño).
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 l Pulse Alt + 6.

 3. En la vista lateral o superior, seleccione una de las capas de la sección de imágenes en miniatura. 

También puede seleccionar una capa en la vista de línea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cámara.

 4. Arrastre la capa a lo largo del eje Z dentro del cono de cámara.

El elemento se moverá en el eje Z de la escena, pero mantendrá el mismo tamaño aparente en la 

vista de cámara.

Puede ver el multiplano desde distintos puntos de vista mediante la vista de perspectiva.

Visualización del multiplano en la vista de perspectiva

 1. Habilite la vista de perspectiva realizando una de las siguientes acciones:

 l Haga clic en el botón  Add view (Agregar vista) situado junto a las pestañas de las 

vistas de cámara y de dibujo y seleccione Perspective (Perspectiva).

 l En el menú superior, seleccione W indows > Perspective (Ventanas > Perspectiva).

 2. Para rotar la vista de perspectiva en las 3 dimensiones, mantenga pulsado Ctrl + Mayús 

(W indows/Linux) o ⌘  + mayúsculas (macOS) y, a continuación, haga clic y arrastre.
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Capítulo 18: Creación y uso de plantillas

Puede crear una plantil la a partir de una capa o de celdas. Puede almacenar como una plantil la cualquier 

elemento disponible en la vista de línea de tiempo.

Creación de una plantilla

Creación de una plantilla

 1. En la vista de línea de tiempo, seleccione varias celdas o capas.

Puede crear una plantil la a partir de una jerarquía de capas entera contrayendo la jerarquía y 

seleccionando su capa raíz. Esto puede ser útil para crear plantil las basadas en rigs de personajes o 

fondos de escena.

 2. En la vista de librería, seleccione una carpeta para almacenar la plantil la. De forma predeterminada, 

tendrá una librería denominada Librería de Harmony Advanced almacenada en el ordenador, en la 

subcarpeta Librería de Toon Boom Harmony Advanced de la carpeta Documentos.

 3. Si la carpeta de librería está  bloqueada, haga clic con el botón derecho y seleccione Right to 

Modify (Derecho para modificar).

 4. Arrastre la selección a la carpeta de la librería elegida.

 5. En el cuadro de diálogo Rename (Cambiar nombre), asigne un nombre a la nueva plantil la.

 6. Haga clic en OK (Aceptar).
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CONSEJO 

Para cambiar el nombre de una plantil la una vez creada, haga clic en ella con el botón derecho y 

seleccione Rename (Cambiar nombre).

Importación de una plantilla

Importación de una plantilla 

 1. En la vista de librería, seleccione la plantil la que desee importar.

 2. Arrastre la plantil la seleccionada a la vista de cámara o a la izquierda de la vista de línea de tiempo.

Si coloca la plantil la en la vista de cámara, sus capas se agregarán en la parte superior de la lista de 

capas. Si coloca una plantil la en la lista de capas de la vista de línea de tiempo, se insertará entre 

las capas en las que la colocó.

Si la plantil la tiene la misma estructura de capas que una parte de la escena, puede colocarla 

directamente en los fotogramas del lado derecho de la vista de línea de tiempo. En lugar de 

insertar nuevas capas en la escena, esta acción reemplazará los dibujos y los fotogramas clave de 

la escena por los de la plantil la. Esto es útil para importar plantil las de pose o animación para los 

personajes que ya se encuentran en la escena.
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Capítulo 19: Exportación de una película

A través del cuadro de diálogo Export Movie (Exportar película), puede exportar la animación como un archivo 

de vídeo. De forma predeterminada, Harmony exportará toda la escena en su resolución completa. Si lo 

prefiere, puede elegir exportar solo un rango de fotogramas específico en la escena o exportarlo en una 

resolución más pequeña, lo cual puede ser útil si necesita ahorrar tiempo o espacio en disco. En función del 

formato en el que exporte la película, también puede personalizar los ajustes de compresión de vídeo y de 

audio para más calidad o para obtener espacio en disco.

Exportación de un archivo de película

 1. En el menú superior, seleccione File > Export > Movie (Archivo > Exportar > Película).

Se abre el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime).

 2. En la sección Output (Salida), abra el menú desplegable Video Format (Formato de vídeo) y 

seleccione el formato deseado para su archivo de película:

 l QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de 

exportación predeterminado que se recomienda por su portabilidad y porque le 

permite elegir entre varios códecs de vídeo.
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NOTAS 

 l En W indows, se debe instalar QuickTime de Apple para que Harmony 

pueda exportar películas de QuickTime. Puede configurar que las 

películas de QuickTime util icen cualquier códec compatible con 

QuickTime, incluidos H.264, MPEG-4 y Animation, para su 

exportación.

 l En macOS, Harmony util iza Apple AVFoundation para exportar 

películas de QuickTime, lo que le permite util izar códecs como H.264, 

Apple ProRes 422 y Apple ProRes 4444, entre otros.

 l Si desea exportar una película de QuickTime con transparencia, 

asegúrese de elegir un códec que admita la codificación con un canal 

alfa.

 l En GNU/Linux, Harmony util iza la librería OpenQuickTime para 

exportar las películas de QuickTime. Esto solo permite exportar vídeos 

en formatos comunes, como M-JPEG, JPEG para fotos, PNG o RGB sin 

comprimir.

 l H.264/MPEG-4 (*.mov): formato de película sencillo que util iza el códec H.264 

compatible con la mayoría de navegadores web.

NOTAS 

 l El uso de este formato no requiere software adicional. Sin embargo, si 

es la primera vez que exporta una película en formato H.264/MPEG-4, 

se le solicitará que descargue la librería OpenH264 de Cisco. 

Simplemente haga clic en Yes (Sí) cuando se le solicite y Harmony 

descargará la librería automáticamente y, a continuación, exportará la 

película.

 l No hay opciones de codificación para este formato.

 l Este formato admite resoluciones de hasta 4096×2304. Cada 

dimensión debe ser un múltiplo de 16 píxeles.

 l El audio exportado en este formato está codificado en PCM estéreo de 

16 bits y 22,05 kHz.

 l W indows Media Video (*.wmv): formato nativo para W indows Media Player.
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NOTAS 

 l Los archivos W indows Media Video (.wmv) solo se pueden exportar 

en W indows.

 l Los reproductores de vídeo y editores en sistemas que no sean de 

W indows normalmente no pueden abrir archivos W indows Media 

Video (.wmv).

 3. Haga clic en el botón Browse (Examinar).

 4. En el cuadro de diálogo Save (Guardar) que aparece, examine la ubicación en la que desee exportar 

el archivo de película.

 5. En el campo File name (Nombre de archivo), escriba el nombre del archivo que desee darle al 

archivo de película.

 6. Haga clic en Save (Guardar).

 7. En la sección Export Range (Rango de exportación), realice una de las siguientes acciones:

 l Seleccione All (Todo) si desea renderizar la escena entera.

 l Seleccione Frames (Fotogramas) si desea renderizar una parte de la escena. A continuación, 

en el campo de la derecha, introduzca el primer fotograma de la secuencia que desea 

exportar, y en el otro campo, el último fotograma de la secuencia que desea renderizar.

 8. Abra la lista desplegable Resolution (Resolución) y realice una de las siguientes acciones:

 l Seleccione Same as Scene Resolution (Igual que resolución de escena) si desea exportar 

una película con la misma resolución que la escena.

 l Seleccione 3/4 of Scene Resolution (3/4 de resolución de escena), 1/2 of Scene Resolution 

(1/2 de resolución de escena), 1/3 of Scene Resolution (1/3 de resolución de escena) o 1/4 

of Scene Resolution (1/4 de resolución de escena) si desea exportar una película que sea 

inferior a la resolución de la escena.
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 l Seleccione Custom (Personalizado) si desea establecer la resolución de exportación 

manualmente. A continuación, en los campos W idth (Ancho) y Height (Altura), introduzca 

en píxeles la resolución deseada para su película.

 9. En el menú desplegable Colour Space (Espacio de color), seleccione el espacio de color al que 

desea exportar la película.

 10. Haga clic en OK (Aceptar).

 11. En el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime), haga clic en 

OK (Aceptar).

Aparece una barra de progreso.

 12. Desplácese a la ubicación en el ordenador en la que ha exportado el archivo de película y haga 

doble clic en él para verlo en el reproductor de vídeo.
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Glosario

3D estereoscópico Imágenes o películas que generan dos imágenes diferentes, cada uno 

desde el punto de vista de uno de los ojos humanos. Cuando se visualizan o 

proyectan a través de dispositivos especiales, como una pantalla 3D o 

gafas de realidad virtual, se crea la ilusión que los elementos de la imagen 

se encuentran enfrente del espectador.

aberración 

cromática

En óptica, una aberración cromática (CA), acromatismo o distorsión 

cromática, es un tipo de distorsión en el que una lente no puede enfocar 

todos los colores en el mismo punto de convergencia.

aceleración En animación, la velocidad es la aceleración y la desaceleración de un 

movimiento. Puede ser un movimiento creado mediante una curva de 

función o una serie de dibujos animados. Otros términos comunes para 

aceleración gradual y desaceleración gradual son aceleración y 

desaceleración.

aceleración de 

entrada

Aceleración drástica al principio de la acción.

aceleración de 

salida

Aceleración drástica al final de la acción.

aceleración gradual Aceleración gradual en la acción. Conocida también como aceleración.

alimentador de 

papel automático

Método automatizado de introducir dibujos en un escáner en el que hay 

varios dibujos apilados en un alimentador de hojas. Cuando se activa el 

escáner, los dibujos se digitalizan de forma consecutiva, sin ninguna otra 

intervención del usuario.

animación Simulación de movimiento que se crea dibujando o editando fotogramas 

individuales.

animación cut-out El proceso conocido como animación cut-out es la acción de animar 

personajes compuestos por varias piezas moviéndolos de fotograma en 

fotograma. La animación cut-out se puede generar por ordenador o 

realizarse del modo tradicional util izando papel.

187

Guía de introducción de Harmony 22 Advanced                          



Glosario

animación directa Técnica en la cual se dibuja por orden una secuencia completa desde la 

primera posición hasta la última. Esta metodología requiere muy poca 

planificación. El lugar en el que el personaje termina y cómo llega hasta allí 

pueden ser una sorpresa tanto para el público como para el animador. Este 

enfoque es espontáneo y creativo, pero puede generar resultados 

imprecisos.

animación pose a 

pose

El proceso de animación pose a pose es la acción que consiste en crear 

todas las poses de acción principales, denominadas poses clave, y después 

colocar las poses secundarias entre las claves. Las poses secundarias se 

denominan descomposición. Por último, el animador rellena los huecos con 

los dibujos intercalados para lograr una animación fluida.

animación 

secundaria

Movimiento secundario provocado por la acción principal. Por ejemplo, un 

personaje que corre y lleva puesta una capa. La acción principal es el 

cuerpo que corre. Esto provocará que la capa siga el movimiento, aunque no 

se moverá al mismo tiempo, sino que reaccionará varios fotogramas 

después y seguirá la curva de movimiento principal.

animación sin papel El proceso de animación sin papel es la acción de animar digitalmente. El 

principal proceso de animación sin papel es dibujar la animación, fotograma 

a fotograma, directamente en el software.

animación 

tradicional

Tipo de proceso de animación mediante el cual todas las secuencias de 

animación se dibujan a mano en papel antes de digitalizarlos o tintarlos en 

celdas.

animática Una película hecha con secuenciación de paneles en un storyboard, en la 

que se establece el tiempo aproximado de cada panel para la acción que 

representa y se sincroniza cada panel con la pista de sonido. Las animáticas 

se util izan para convertir el storyboard en un borrador de la película final 

con el fin de determinar el tiempo asignado a cada escena y a cada acción y 

sincronizar la acción con la pista de sonido.

anime Animación japonesa.

arco La acción no suele producirse de forma directa, sino que más bien se suele 

desplegar en lo que los narradores denominan un arco. El propósito de un 

arco de historia es mover un personaje o situación de un estado o escenario 
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al siguiente.

arrastrar Operación que consiste en hacer clic en un elemento, mantenerlo pulsado y, 

a continuación, moverlo mediante el movimiento del cursor del ratón. Esto 

se puede realizar con el botón izquierdo del ratón o con la punta del lápiz.

artista de layout Artista que dibuja el fondo y crea la cámara y la guía de campo, haciendo 

coincidir la escena y el movimiento de la cámara. Dibujará en el modelo las 

poses de acción principales.

atajos de teclado Tecla de teclado o combinación de teclas de teclado que se asigna para 

realizar un comando específico en la aplicación al pulsarlos.

baja resolución Formato idóneo para vídeos destinados a la web, donde el tamaño y la 

descarga rápida del archivo de vídeo tienen prioridad respecto a la calidad. 

Una imagen de baja resolución es aquella que no contiene detalles 

precisos.

bocetos Es un nombre común en una película de animación para un dibujo que se 

util iza como referencia, pero no forma parte de la imagen final. Un layout es 

un boceto. Es el esbozo del esqueleto de una animación o diseño. Los 

bocetos consisten principalmente en líneas y formas esbozadas, pero 

también pueden contener detalles de diseño.

campo Unidad de medida que se util iza en la animación tradicional para registrar y 

realizar un seguimiento de la cámara, así como de su proximidad a la 

escena.

canal alfa Canal de imagen que contiene información de transparencia. De partida, 

una imagen tiene tres canales: rojo, verde y azul (RGB). El canal alfa es el 

cuarto canal (A). El mate, o información de transparencia, se almacena en 

este cuarto canal. Una imagen sin canal alfa siempre es opaca.

capa En animación, una capa es una columna, nivel o personaje individual. Las 

capas de una escena están superpuestas para formar la imagen final.

capa de fondo En animación, una capa de fondo es una parte específica de la decoración 

colocada detrás de la animación principal.
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capa superior Parte del entorno de una escena, como una silla o un arbusto, que se coloca 

delante de la animación principal.

carta de color Una carta de color es una tarjeta que contiene un color sólido con el mismo 

tamaño que la cámara. La carta de color rellena el fondo con un color sólido 

cuando no se ha incluido ninguna imagen de fondo.

carta de exposición Hoja con varias columnas verticales y fotogramas horizontales que se 

util iza para indicar el tiempo de una escena. Cada columna representa una 

capa de escena. Los números de dibujos de cada columna se indican y se 

repiten a lo largo de la cantidad de fotogramas determinada en la que 

deben aparecer.  La carta de exposición la util izan los animadores, directores 

y otros miembros del equipo para trazar la secuencia y el tiempo de las 

imágenes, el diálogo, los efectos de sonido, las pistas de sonido y los 

movimientos de cámara. Conocida también como carta de rodaje.

carta de fonemas Carta basada en los ocho fonemas de la animación (A, B, C, D, E, F, G y X, 

que se util iza para representar el silencio) util izados para la sincronización 

de labios.

carta de rodaje La util izan los animadores, directores y otros miembros del equipo para 

trazar la secuencia y el tiempo de las imágenes, el diálogo, los efectos de 

sonido, las pistas de sonido y los movimientos de cámara. Conocida 

también como carta de exposición.

celda En la animación tradicional, una celda (también denominada celuloide) es 

una hoja transparente en la que la animación se tinta y se pinta antes de 

enviarla a la cámara. El trazado de la imagen se dibuja en la parte delantera 

de la celda y, a continuación, se colorea por la parte trasera.

ciclo Serie de fotogramas de animación que se pueden repetir para simular un 

movimiento continuo. Por ejemplo, un personaje a menudo camina 

mediante una animación en la que da dos pasos, uno con cada pie y, a 

continuación, repitiendo la animación.

ciclo de andar Serie de dibujos "en el lugar" que describen cómo camina un personaje. La 

ilusión de movimiento se crea util izando paneos de fondo. Para evitar 

realizar innumerables dibujos, los animadores suelen realizar un ciclo de 

andar para un personaje.
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cinemática directa La cinemática directa es una función util izada para animar principalmente 

personajes 3D y marionetas cut-out con jerarquía. Se util iza para animar 

una marioneta a partir de una de sus partes padres, como un hombro, y 

hacer que el resto del brazo se mueva con ella como un todo.

cinemática inversa 

(IK)

Función util izada principalmente para animar personajes 3D y marionetas 

cut-out con jerarquía. La cinemática inversa animará una marioneta desde 

una de las extremidades, como una mano, y permitirá que el resto del 

cuerpo la siga con naturalidad.

círculo cromático Visualización del espectro de colores en forma de círculo.

clean up Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido 

de la imagen (líneas sobrantes, notas, etc.) para crear dibujos finales que se 

pueden tintar, pintar y filmar. El proceso de clean up hace referencia al 

trazado de una línea limpia sobre un boceto para conseguir la versión final o 

a la eliminación de la suciedad y las líneas adicionales que han quedado 

tras el proceso de digitalización.

CMYK Acrónimo en inglés de cian, magenta, amarillo y negro. Estos colores 

forman el modelo estándar util izado en un proceso denominado impresión 

offset.

código de tiempo Información de tiempo impresa en un clip de película para indicar la escena, 

hora, minuto y segundo que se muestran actualmente en pantalla.

composición La composición es la acción de incorporar todos los elementos de una 

escena para crear el resultado final antes del renderizado. Por ejemplo, el 

artista de la composición importará todas las secuencias, el fondo, las 

superposiciones y las subcapas de la animación en la escena y los colocará 

correctamente. A continuación, el artista definirá el encuadre de cámara y lo 

animará en caso necesario. Por último, el animador creará todos los efectos 

generados por ordenador para el proyecto.

corte Cuando una escena pasa a la escena siguiente de un fotograma a otro sin 

ningún efecto visual.

corte de salto Corte brusco entre dos escenas. Normalmente, un corte de salto no es 

visualmente agradable. Normalmente lo provoca el final de una escena y el 

191

Guía de introducción de Harmony 22 Advanced                          



Glosario

comienzo de otra, con una imagen parecida. La falta de diferencia provoca 

que el ojo vea un pequeño salto entre las dos escenas.

curva Bézier Método para definir líneas curvas inventado por el matemático francés 

Pierre Bézier. Una curva Bézier es una curva matemática o paramétrica. Los 

puntos de control definen las curvas Bézier. En Harmony, las curvas Bézier 

tienen un punto de inicio, un punto de final y dos puntos de control 

interiores que influyen la curva entre los puntos de inicio y final.

depuración de 

sonido

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el 

cabezal de reproducción hacia delante o hacia atrás. Es muy útil para 

realizar el ajuste preciso de una sincronización de labios.

desaceleración Desaceleración gradual en la acción. Conocida también como 

desaceleración gradual.

desaceleración 

gradual

Desaceleración gradual en la acción. Conocida también como 

desaceleración.

descomposición En animación cut-out, la descomposición es la acción de descomponer un 

personaje en trozos para crear una marioneta con articulaciones. Para 

descomponer un personaje, el artista corta partes, como las manos y los 

brazos, del modelo del personaje y las pega en capas independientes. A 

continuación, las articulaciones se fijan y se definen los pivotes.  En la 

animación tradicional, una descomposición es una pose de animación que 

normalmente se encuentra entre dos poses clave. Las poses clave son las 

poses principales de una animación y las descomposiciones son poses 

secundarias que ayudan a describir el movimiento y la curva de rotación 

(normalmente denominada arco).

desglose de pista de 

audio

Desglose de una pista de película animada en sonidos individuales para 

generar la posición fotograma a fotograma precisa de cada sonido.

desplazamiento 

pequeño

Pequeño empujón (izquierda, derecha, arriba, abajo, hacia delante o hacia 

atrás) realizado con las teclas de flecha del teclado en un elemento 

seleccionado. El desplazamiento pequeño se util iza para mover una 

selección de manera muy ligera y precisa.

detección Asignación automática de dibujos en un elemento a la carta de fonemas 
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automática de 

sincronización de 

labios

generada para un sonido. Puede ahorrar tiempo al sincronizar los labios una 

pista de voz.

detección manual de 

sincronización de 

labios

Intercambio manual de dibujos de posición de la boca para que coincidan 

con una pista de voz. Para este proceso, se util izan tanto la depuración de 

sonido (escuchar una onda de sonido descompuesta fotograma a 

fotograma) como las sustituciones de dibujos.

diálogo Texto hablado por un personaje en una película o animación.

diseño del personaje Cada personaje de una película animada se dibuja desde varios ángulos en 

formato de estilo póster denominado hoja de modelo, que sirve como 

referencia para los animadores.

dpi Siglas en inglés para puntos por pulgada, que representa la medida 

estándar de resolución para impresoras computerizadas. En ocasiones se 

aplica a pantallas, en cuyo caso es más exacto denominarlo píxeles por 

pulgada. En cualquier caso, el punto es el elemento diferenciado más 

pequeño que forma la imagen.

eje Línea imaginaria alrededor de la cual rota un objeto.  Para gráficos 2D, hay 

dos ejes: X (horizontal) e Y (vertical).  Para gráficos 3D, hay tres ejes: X 

(horizontal), Y (vertical) y Z (profundidad).  En animaciones que rotan 

constantemente, el elemento de eje especifica alrededor de qué eje rota el 

objeto. Un número negativo provoca que una animación rote en sentido 

contrario a las agujas del reloj, mientras que un número positivo hace que 

una animación rote a la derecha.

escena Plano en una película o programa. Una secuencia está compuesta por varias 

escenas. Una escena cambia a otra mediante un corte simple o por 

transición.

estilo de paleta Un estilo de paleta es una segunda versión de una paleta existente con un 

ligero cambio en el tinte y el valor. Un estilo de paleta se puede util izar para 

crear la versión nocturna de una paleta. También se le puede denominar 

paleta de clonado.

exposición En animación, una exposición es el número de celdas en las que un dibujo 
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aparece en la escena. Para que un dibujo parezca más grande, la exposición 

se debe ampliar durante un número de celdas mayor.

film-1.33 Resolución idónea para el formato de película panorámico que se ajusta a la 

proporción estándar de 4:3 píxeles.

film-1.66 Resolución idónea para el formato de película panorámico que se ajusta a la 

proporción de 16:9 píxeles.

flipping En la animación tradicional, fl ipping es la acción de pasar por los dibujos de 

una secuencia de animación muy rápidamente con el fin de ver la animación 

en movimiento. Flipping también puede ser la acción de crear una 

transformación en espejo de un objeto.

fondo Ilustraciones que llenan el campo de la cámara y que se encuentran detrás 

de los personajes y props. Normalmente, estas ilustraciones representan la 

decoración o escena en la que ocurre la acción.

fonema Unidad de sonido de un idioma.

fotograma Un fotograma de animación es una imagen fotográfica única en una 

película. En la animación tradicional, el estándar norteamericano contiene 

generalmente 24 fotogramas por segundo, mientras que el estándar 

europeo es de 25.

fotograma clave Posiciones importantes en la acción que definen los puntos inicial y final de 

cualquier acción. Un fotograma clave es una posición generada por 

ordenador en un momento específico (fotograma) y en una trayectoria 

determinada.

fotograma clave de 

movimiento

Fotograma clave con interpolación generada por ordenador.

fotograma clave de 

Stop-motion

Fotograma clave sin interpolación generada por ordenador.

fotogramas por 

segundo

Representan la velocidad a la que se reproducen los fotogramas por 

segundo. Se calculan por lo general en fotogramas por segundo. Por 
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ejemplo, una escena se podría reproducir a 12, 24, 25, 30 o 60 fotogramas 

por segundo o a cualquier otro número.  Es la medida de la frecuencia (tasa) 

a la que un dispositivo de imagen produce imágenes consecutivas únicas, 

denominadas fotogramas. El término se aplica por igual a los gráficos por 

ordenador, videocámaras, cámaras de película y sistemas de captura de 

movimiento.  La tasa de fotogramas se suele expresar principalmente en 

fotogramas por segundo (fps) y en monitores de barrido progresivo en 

hercios (Hz).

función Movimiento, trayectoria o ruta generados por ordenador al que se pueden 

conectar parámetros de elementos, otras trayectorias y efectos. La función 

se puede controlar agregando fotogramas clave y puntos de control en la 

curva de función.

fundido de 

entrada/fundido de 

salida

El fundido de entrada o fundido de salida es un efecto de transición 

util izado para abrir o cerrar una secuencia. Un fundido de entrada se 

produce cuando la primera escena aparece progresivamente, desde una 

transparencia total a su opacidad total. Un fundido de salida se produce 

cuando la escena desaparece progresivamente, desde la opacidad total a la 

transparencia total.

fundido encadenado Cuando una escena pasa a la escena siguiente mediante un fundido en el 

que desaparece una y aparece la siguiente.

gama Rango de colores que puede representar un dispositivo determinado.

guion Texto original que contiene la información de toda la película o el 

programa. En animación, el guion contiene todas las descripciones de la 

ubicación, el diálogo, el tiempo, etc. Un proyecto comienza con un guion.

HDTV Acrónimo en inglés de televisión de alta definición, que es el estándar de 

resolución actual para producciones televisivas. La resolución de 

producciones de HDTV es 1280×720 (HD ready) o 1920×1080 (full HD), y 

sus fotogramas por segundo normalmente oscilan entre 23.976 y 30.

hoja de campos Guía que contiene todas las unidades de campo que los artistas de 

animación y layout util izan para definir el tamaño del campo de la cámara, 

así como sus movimientos.
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hold Fotograma en la animación en el cual el personaje mantiene su posición sin 

moverse. Se puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturación y valor. Método para definir los 

colores en cuanto a matiz (tinte), saturación (sombra) y valor (tono o 

luminancia).

imagen en miniatura Imagen muy pequeña util izada como una referencia o indicador.

ink and paint El proceso ink and paint es la acción de pintar las zonas vacías y colorear las 

líneas en los dibujos de animación finales siguiendo un modelo de color.

intercalado Dibujos que existen entre las poses clave. Se dibujan para crear 

transiciones fluidas entre poses.

interpolación Movimiento generado por ordenador creado entre dos fotogramas clave. Se 

puede crear interpolación, o no, entre los fotogramas clave.

layout Paso de comunicación entre el storyboard y la animación. Es la acción de 

poner el storyboard en el modelo. Es decir, el personaje se dibuja siguiendo 

el diseño del paquete de modelo, de modo que el animador puede 

comenzar a trabajar.  El artista de layout dibuja el fondo y crea la cámara y la 

guía de campo, haciendo coincidir la escena y el movimiento de la cámara. 

Por último, el animador dibuja en el modelo las poses de acción principales.

layout y pose Acción que consiste en poner el storyboard en el modelo (a la escala 

adecuada) para que el animador comience a trabajar.

librería Zona de almacenamiento que contiene plantil las y recursos que se pueden 

reutil izar en un proyecto o escena.

línea de acción Línea central en una pose de acción. Cuando se pintan poses de acción sin 

tocar la línea de acción se garantiza que la pose sea dinámica y que su 

silueta se ajuste a la dirección de la acción.

línea de tiempo Representación horizontal de los elementos, el tiempo y los fotogramas 

clave de una escena.
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líneas vectoriales 

transparentes

Cuando no hacen referencia a trazos reales, las líneas vectoriales 

transparentes son contornos invisibles que se util izan para definir zonas de 

color o para cerrar zonas de color abiertas.

mapa de bits Imagen definida por una malla de píxeles, así como por el color individual 

de cada uno de sus píxeles.  Los gráficos de mapas de bits se caracterizan 

por ser preferibles a los gráficos vectoriales para ilustraciones muy 

detalladas o fotorrealistas. Sin embargo, los gráficos de mapas de bits no 

se pueden escalar, rotar o sesgar sin que la imagen pierda calidad.

mesa de disco Equivalente al disco/mesa de animación, es un dispositivo que permite rotar 

el espacio de trabajo para mayor comodidad mientras se dibuja.

mesa de luz Dispositivo que permite ver otras capas en transparencia mientras trabaja 

en una capa determinada.

modelo de color Diseño de color oficial que se debe util izar para pintar la animación. Un 

modelo es el diseño de personaje, prop o ubicación definitivo que cada 

artista debe seguir para la producción.

modelo/modelo de 

color

Diseño de personaje, prop o ubicación definitivo que cada artista debe 

seguir para una producción. Un modelo de color es el diseño de color oficial 

que se debe util izar para pintar la animación.

morphing Función que permite crear dibujos generados por ordenador entre un dibujo 

de origen y otro de destino. La animación creada con la función de morphing 

se puede reutil izar en distintos proyectos.

multiplano Efecto de pasar por diversos niveles de dibujos para crear una sensación de 

profundidad en un plano. Un multiplano es una escena en la que las capas 

están colocadas a distintas distancias de la cámara, de modo que, cuando la 

cámara se mueve, se produce una ilusión de profundidad. Con un 

multiplano, toda la perspectiva y la escala se calculan automáticamente.

NTSC Antiguo sistema de difusión televisiva analógico estándar util izado en 

Norteamérica.

PAL Resolución que funciona mejor con el formato europeo para pantallas de 

televisión y de ordenador, ya que los píxeles rectangulares se muestran con 
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una orientación distinta.

paleta maestra Grupo de colores atribuidos a un personaje o prop. La paleta se util iza 

durante toda la producción para mantener la coherencia en el aspecto y 

para garantizar que se util icen los mismos colores durante la producción. 

Conocida también como paleta.

paleta/paleta 

maestra

Una paleta o paleta maestra es un grupo de colores atribuidos a un 

personaje o prop. La paleta se util iza durante todo el proyecto para 

mantener la coherencia en el aspecto y para evitar cambios de color 

durante la animación. También se le denomina paleta maestra.

panear Mover la cámara atravesando la escena en cualquier dirección.

panel En un storyboard, un panel es un fotograma en un plano. Un plano puede 

estar compuesto por uno o varios paneles.

papel cebolla Función que permite ver los dibujos anterior y siguiente de una secuencia.

paso con doble bote En los fotogramas clave y las posiciones de paso de un paso con doble 

bote, el cuerpo es menor que una línea de referencia dibujada en posición 

vertical. Durante los intercalados, el cuerpo está situado sobre esta línea, 

ofreciendo así un aspecto de rebote.

peg En la animación tradicional, es una herramienta util izada para garantizar el 

registro preciso de la acción a medida que se mueven las capas de celdas. 

En la animación digital, en la que se realiza un rigging de marionetas más 

avanzado, se pueden usar capas de pegs. Las capas de pegs son capas de 

trayectoria que no contienen dibujos. Son rutas de movimiento que puede 

usar para agregar articulaciones de ruta. Para las últimas, también puede 

util izar una herramienta de cinemática inversa.

pivote Punto alrededor del cual un peg o dibujo rota.

píxel Elemento más pequeño de una imagen mostrado en un monitor o pantalla 

de televisión.  El píxel, abreviatura en inglés de elemento de imagen, es un 

punto único en una imagen gráfica. Es una pequeña muestra de una 

imagen, un punto, un cuadrado o una sección muy pequeña compuesta de 

filtrado suavizado. Si acerca el zoom lo suficiente en una imagen digital, 
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verá los píxeles, que parecen pequeños cuadrados de distintos colores e 

intensidad.

planificación de 

layout

Dibujo de las funciones principales de la escena que se util iza como 

referencia al planificar la animación y ejecutar sus etapas iniciales.

plano Escena en una película o programa. Una secuencia está compuesta por 

varios planos. Un plano cambia a otro mediante un corte simple o por 

transición.

plano de situación Escena en la cual el espectador puede ver toda el área en la que se está 

produciendo una secuencia. Por ejemplo, si un niño está jugando en el patio 

delantero de su casa, el plano de situación sería una escena en la que el 

espectador puede ver la casa, el patio, parte de la calle y los edificios 

situados alrededor del punto de acción central. Esto ayuda al espectador a 

entender la ubicación de la historia y la orientación de la escena.

plantilla Recurso almacenado en la librería que se puede reutil izar en cualquier 

proyecto. Una plantil la puede ser un dibujo, una serie de fotogramas clave, 

un archivo de sonido, un panel, un personaje cut-out, un efecto, una 

trayectoria, una animación o cualquier otra cosa que se util ice en la 

animación.

pose clave Posiciones importantes en la acción que definen los puntos inicial y final de 

cualquier transición suave. Las claves, o poses clave, son los dibujos 

principales de una secuencia de animación que describen el movimiento. 

Por ejemplo, si se agita un brazo, las claves corresponderán al brazo de una 

extremidad del movimiento de onda y a la otra extremidad. Al realizar un 

flipping de dichos dibujos, el animador puede ver el esqueleto del 

movimiento sin tener todos los dibujos.

posición de paso Al dibujar una secuencia en la que un personaje camina, la posición de paso 

es el punto en el que una pierna pasa a la otra.

proceso de layout Paso de comunicación entre el storyboard y la animación.

proporción Proporción entre las dimensiones de ancho y altura de una escena, 

fotograma o formato de película. Actualmente, la proporción más popular 

es 16:9. Las pantallas antiguas util izaban una proporción de 4:3.
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renderizado Paso final de la animación por ordenador. Durante el renderizado, el 

ordenador toma cada píxel que aparece en la pantalla y procesa todos los 

componentes. Además, agrega desenfoque de movimiento antes de que 

produzca una imagen final. Es el proceso de calcular las imágenes finales 

después del proceso de composición.

resolución Tamaño de una escena, calculado por lo general en píxeles. Por ejemplo, la 

resolución NTSC es de 720 x 480. La resolución debe coincidir con la salida 

final: HDTV, film-1.33, film-1.66, NTSC, PAL, baja.

RGB Siglas en inglés para rojo, verde y azul. Método que permite definir el color 

especificando las cantidades de estos tres componentes del color.

rigging Proceso de conectar las distintas partes de una marioneta cut-out.

rotoscopia Técnica de animación en la que los animadores trazan un movimiento de 

película de acción en vivo, fotograma a fotograma, para usarlo en películas 

animadas. Es el acto de esbozar sobre material de acción en vivo para crear 

una secuencia animada.

secuencia Serie de escenas o planos que forman una parte distinta de la historia o 

película, normalmente conectados por la unión de la ubicación o el tiempo.

símbolo Un icono combina animación, ilustración o capas en un único objeto que 

puede controlar en una capa. También puede crear iconos de cada parte del 

cuerpo en marionetas cut-out.  En un icono puede colocar lo que desee. 

Puede util izar símbolos para animar una marioneta o crear animaciones 

reutil izables, como un parpadeo.

sincronización de 

labios

Proceso que consiste en sincronizar la boca de un personaje con sonidos en 

la pista de sonido del diálogo. La boca se ajusta fotograma a fotograma 

para hacer coincidir el sonido del diálogo y aparentar que el personaje está 

hablando. La sincronización de labios se puede util izar para cualquier 

secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer que 

un pájaro píe o que un lobo aúlle a la luna.

slugging Indicación de los tiempos de inicio y detención de un diálogo y las acciones 

relevantes.
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storyboard Plan visual de todas las escenas y planos de una animación. El storyboard 

indica lo que sucederá, cuándo lo hará y cómo se distribuyen los objetos en 

una escena.

tableta/lápiz Dispositivo util izado junto con un ratón, o en lugar del mismo, para mover el 

puntero (en ocasiones denominado cursor) por la pantalla del ordenador.

Totales acumulados 

de columna

Campo de texto que contiene información de diálogo, efectos, sonido o 

slugging en un storyboard.

transición Efecto colocado entre dos escenas cuando se pasa de una a otra. Los 

efectos de transición comunes son el fundido encadenado y el barrido.

trayectoria Ruta o trayectoria generada por ordenador que pueden seguir los 

elementos. La trayectoria se puede controlar mediante puntos de control, 

fotogramas clave y velocidad.

trazar y pintar Una vez que los bocetos de las animaciones se han limpiado y se ha 

realizado una prueba de línea o de lápiz final, cada dibujo se traza y se pinta 

para la animación final. En el mundo digital actual, esto se puede realizar de 

maneras distintas a los métodos de celuloide o acetato tradicionales.

usar carta de rodaje Asignar un dibujo determinado a un rango de fotogramas.

vector Una imagen basada en vectores está compuesta por puntos y curvas Bézier. 

El ordenador lee los puntos y traza los segmentos, vinculándolos para 

reproducir la forma de imagen. Una imagen vectorial no contiene tamaño 

fijo ni resolución. El gráfico se puede ampliar y distorsionar según se desee 

y el sistema volverá a calcular los segmentos y reconstruirá las formas. Las 

imágenes vectoriales se trasladan y se muestran en píxeles una vez que el 

cálculo se ha realizado.

velocidad En animación, la velocidad es la aceleración o la desaceleración de un 

movimiento. Se puede alcanzar mediante una curva de función o una serie 

de dibujos animados. Otros términos comunes para aceleración gradual y 

desaceleración gradual son aceleración y desaceleración.

vibración de cámara La vibración de cámara se produce en una escena cuando la cámara se 

mueve ligeramente y rápidamente en varias direcciones. Este movimiento 
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da la impresión de impacto, vibración o, por ejemplo, baches en la carretera.

zona Área que se puede pintar con color.

zona segura Zona central del fotograma de una escena que no quedará recortada por el 

fotograma de TV. Como un fotograma de TV corta un margen del tamaño 

del fotograma original, al mantener una zona segura se garantiza que la 

acción principal de la escena siga siendo claramente visible una vez que la 

película se proyecte en televisión.
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